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Chapter 1. Simulation Basics
Cadence® Visual System Simulator™ (VSS) communications and radar systems design software is the system level
design component of the Cadence AWR Design Environment® platform. With VSS software you can analyze a complete
communications system, from data encoding, through transmission, reception and data decoding.

1.1. Additional Documentation
The AWR Design Environment platform includes the following additional documentation:
• What's New in AWR Design Environment v15? presents the new features, user interface, elements, system blocks, and
measurements for this release.
• The AWR Design Environment Installation Guide describes how to install the AWR Design Environment platform
and configure it for locked or floating licensing options. It also provides licensing configuration troubleshooting tips.
This document is downloadable from the Cadence AWR Knowledge Base.
• The AWR Design Environment Getting Started Guide familiarizes you with the AWR Design Environment platform
through Microwave Office software, VSS software, Cadence Analyst™ 3D FEM EM analysis software, and Monolithic
Microwave Integrated Circuit (MMIC) examples.
Microwave Office example projects show how to design and analyze simple linear, nonlinear, and EM circuits, and
how to create layouts. Visual System Simulator examples show how to design systems and perform simulations using
predefined or customized transmitters and receivers. Analyst software examples show how to create and simulate 3D
EM structures from Microwave Office, and MMIC examples show MMIC features and designs.
You can perform simulations using a number of simulators, and then display the output in a wide variety of graphical
forms based on your analysis needs. You can also tune or optimize the designs, and your changes are automatically
and immediately reflected in the layout.
• The AWR Design Environment User Guide provides an overview of the AWR Design Environment platform including
chapters on the user interface; using schematics/system diagrams, data files, netlists, graphs, measurements, and output
files; using variables and equations in projects, and more. In addition, an appendix providing guidelines for starting a
new design is included.
• The AWR Design Environment Simulation and Analysis Guide discusses simulation basics such as swept parameter
analysis, tuning/optimizing/yield, and simulation filters; and provides simulation details for DC, linear, AC, harmonic
balance, transient, and EM simulation/extraction theory and methods.
• The AWR Design Environment Dialog Box Reference provides a comprehensive reference of many AWR Design
Environment platform dialog boxes with dialog box graphics, overviews, option details, and information on how to
navigate to each dialog box.
• The AWR Microwave Office Layout Guide contains information on creating and viewing layouts for schematics and
EM structures, including use of the Layout Manager, Layout Process File, artwork cell creation/editing/properties,
Design Rule Checking, and other topics.
• The AWR Microwave Office Element Catalog provides complete reference information on the electrical element
model database that you use to build schematics.
• The AWR Visual System Simulator System Block Catalog provides complete reference information on all of the
system blocks that you use to build systems.
• The AWR Microwave Office Measurement Catalog provides complete reference information on the "measurements"
(computed data such as gain, noise, power, or voltage) that you can choose as output for your simulations.
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• The AWR Visual System Simulator Measurement Catalog provides complete reference information on the measurements
you can choose as output for your simulations.
• The AWR API Scripting Guide explains the basic concepts of AWR Design Environment platform scripting and
provides coding examples. It also provides information on the most useful objects, properties, and methods for creating
scripts in the AWR Script Development Environment (AWR SDE). In addition, this guide contains the AWR Design
Environment platform Component API list.
• The AWR Design Environment Quick Reference document lists keyboard shortcuts, mouse operations, and tips and
tricks to optimize your use of the AWR Design Environment platform. This document is available within the program
by choosing Help > Quick Reference.

1.2. Typographical Conventions
This guide uses the following typographical conventions.
Item

Convention

Anything that you select (or click on) in the AWR Design Shown in a bold alternate font. Nested menu selections are
Environment program, such as menus, nested submenus, shown with a ">" to indicate that you select the first menu
menu options, dialog box options, buttons, and tab names item and then select the submenu item:
Choose File > New Project.
Text that you enter using the keyboard

Shown in a bold within quotation marks:
Enter "my_project" in Project Name.

Keys or key combinations that you press

Shown in a bold alternate font with initial capitals. Key
combinations using a "+" indicate that you press and hold
the first key while pressing the second key:
Press Alt+F1.

File names and directory paths

Shown in italics:
See the DEFAULTS.LPF file.

Contents of a file, fields within a file, command names,
Shown in a mono-spaced font:
command switches/arguments, or output from a command
Define this parameter in the $DEFAULT_VALUES field.
at the command prompt

1.3. Basic Concepts
VSS software is a system level simulator. A system level simulation models designs at the component level, such as
amplifiers, mixers, or encoders.
VSS software models the effects of a system upon one or more signals which can be digital data, modulated analog
signals, continuous wave (CW) tones, or other types. VSS software designs start with a system diagram and are composed
of interconnected blocks representing individual components in a design. The connections between the blocks describe
the flow of data through the system.
Blocks typically have one or more ports, which serve as the connection points to other blocks. The connection point
between ports is called a node. For historical reasons, ports are also often referred to as nodes.
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There are two types of ports: input ports and output ports. Input ports are the entry point of data into a block, and receive
data from an output port of another block. When a simulation runs, data flows from the output port of one block to one
or more input ports of other blocks connected to the output port. When a block receives data it applies its behavior to
the data and generates any appropriate output.
At least one block must be a source block, which is a block that generates a signal without requiring input from another
block. Examples of source blocks are the modulated sources such as the QAM Modulated Signal block QAM_SRC, or
the RF Tone Source block TONE.
To perform most measurements there must also be at least one 'meter' block with an input port connected to the system.
Annotations, which are applied to an entire system diagram, are the exception.
The meter blocks are located in the Meters category of the Element Browser. The most commonly used meter is the Test
Point block TP which lets you monitor any signal.
VSS software supports three types of simulations: Time Domain simulations, RF Budget Analysis simulations, and RF
Inspector simulations.

1.3.1. RF Budget Analysis and RF Inspector Simulations
The RF Budget Analysis measurements, in the System > RF Budget Analysis measurement category, invoke the RF Budget
Analysis (RFB) simulator. These measurements include cascaded noise figure, gain, and IP3 measurements.
The RF Inspector measurements, in the System > RF Inspector measurement category, invoke the RF Inspector (RFI)
simulator.
Both RFB and RFI simulations are generally restricted to the RF components of a system design. Both simulators operate
in the frequency domain and assume steady state behavior. Whereas Time Domain simulations are started and then run
until stopped, RFB and RFI simulations occur in one step. This allows efficient use of the optimization and yield analysis
features of the AWR Design Environment software.
RFB and RFI simulations are run similar to Microwave Office simulations. They are run when the Analyze command is
chosen, and are only run if the system diagram has been modified. In addition, they are also run when the Run/Stop
System Simulators command is chosen if the system diagram has been modified.
See the RF Modeling in VSS chapter for a more detailed description of RF Budget Analysis and RF Inspector simulations.

1.3.2. Time Domain Simulations
NOTE: Time Domain simulations require a VSS-250 or greater license. The Run/Stop System Simulators command,
which is required to run Time Domain simulations, is not available without a VSS-250 license.
In a Time Domain simulation, data is represented as a stream of samples, with each sample representing the value of the
signal at a specific point in time. The time difference between each sequential sample in a signal is called the time step.
The inverse of the time step is the sampling frequency, commonly denoted as fs.
In VSS software the time step is fixed during the main simulation. However, different signals may have different time
steps. For many blocks the sampling frequencies of the output signals are the same as the sampling frequencies of the
input signals. Other blocks may modify the sampling frequency. For example, a digital-to-analog converter typically
generates several analog output samples for each digital value input. If, for example, it generates 8 output samples for
each digital value input, the output time step would have to be 1/8 of the input time step.
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The time step and sampling frequency can be viewed at each output port in a system diagram using the SMPFRQ and
TSTEP annotations.
When a simulation runs, the source blocks generate a sequence of data samples representing the time varying data. This
sequence of samples is passed on to any connected blocks. These connected blocks in turn 'read' each incoming sample,
processes each sample, and if necessary generates new samples for the blocks connected to their output ports.
Time Domain simulations typically require many thousands of samples be generated and processed before any significant
measurement can be made. Because it takes real time to process all these samples, Time Domain simulations are normally
started and then run in the background. While the simulation is running, the graphs update based on the samples available
to the individual measurements.
VSS Time Domain simulations are started by choosing Simulate > Run System Simulators. A simulation runs until you
pause or stop it, or it completes processing the required number of samples. Each time you choose Run System Simulators
new simulations are started and you lose all measurement results from previous simulations.

1.3.3. Sweeping Simulations
It is often desirable to obtain simulation results for several values of a design parameter. For example, bit error rate (BER)
measurements are typically made over several signal to noise ratio values, or adjacent channel power is measured for
several signal power levels.
When one or more design parameters are modified during a simulation, the simulation is a swept simulation. Each sweep
consists of running the simulation for a specific set of design parameter values. The design parameters are called the
swept variables.
All VSS software simulators support sweeping. Multiple swept variables are supported for performing multi-dimensional
sweeps.
Each sweep can be viewed as a separate simulation. When a new sweep begins, most blocks reset their state. The
exceptions are blocks that need to track inter-sweep information such as the BER block. For Time Domain simulations
the sweep runs until a control block determines that the simulation has run long enough for that sweep.
There are several elements to a simulation sweep:
• Design Parameters - Defining the design parameter(s) to sweep
• Controlling Sweeps - Defining the criteria for starting a new sweep (Time Domain simulations)
• Swept Measurements - Viewing the results
Design Parameters
Design parameters are the values that are varied from sweep to sweep. Having more than one design parameter results
in a multi-dimensional sweep.
VSS software supports two types of design parameters. The first is an equation variable that is assigned to one or more
block parameters. The second is a built-in CW power level generated by the Vector Network Analyzer (VNA).
In order for an equation variable to be a design parameter, the set of values to be assigned for each sweep must be defined.
This is normally done using one of the following blocks:
• BER, BER_EXT, FER_EXT, SER and SER_EXT - These are the BER meters found under Meters > BER.
• SWPVAR - The swept variable control block, found under Simulation Control.
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• VSA - The vector signal analyzer block, found under Meters > Network Analyzers.
These block have a VARNAME and a VALUES parameter. The VARNAME parameter is set to the name of the variable
to be swept, entered in double quotes. The VALUES parameter is set to a vector containing the value for each sweep.
The variable to be swept must be in the system diagram. It must also be assigned a constant as its value and not an
equation or other variable.
The following illustrates using SWPVAR to define FREQ_Hz as a design parameter with the sweep values of 10e9,
10.1e9, and 10.2e9:

FREQ_Hz=1e10

SWPVAR
ID=SWP1
VARNAME="FREQ_Hz"
VALUES={ 1e10,1.01e10,1.02e10 }

Xo

. . . Xn

Figure 1.1. Swept Variable Block
Note that the value for the VARNAME parameter, "FREQ_Hz", is enclosed in double-quotation marks as it is referring
to the name of the variable, not the values of the variable.
While the equation variable must be assigned a constant value, the VALUES parameter may contain an equation,
particularly equation functions. One of the more useful functions is stepped(). This function automatically creates a
vector starting from a given value and containing equally spaced values up to a given end value. For example:
stepped(5,10,1)

is equivalent to the vector:
{5,6,7,8,9,10}

VNA can also be used to define an equation variable as a design parameter. The VARNAME parameter is used as above.
The values for each sweep, however, are automatically set to the power levels generated by the block. For example, if
PSTART is 5, PSTOP is 10, and PSTEP is 1, and the variable "PWR_dBm" were assigned to the VARNAME parameter,
PWR_dBm would be a design parameter with the following values:
{5,6,7,8,9,10}

Although you can have more than one VNA in a system diagram, only the VNA block that has the largest number of
power steps defines a design parameter. This VNA is the master VNA. Any other VNA block in the system diagram still
generates a swept power signal. However once those blocks reach their PSTOP power level they stop participating in
the remaining sweeps of the master VNA.
Once a design parameter has been defined, it can be used just like any other equation variable. In order for the design
parameter to affect the simulation, however, at least one block's parameter must refer to that design parameter, either
directly or indirectly through other equations.
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NOTE: Previous versions of VSS software supported limited sweeping through the use of the sweep() equation
function. This functionality is still supported. However, it is strongly recommended that the new sweep mechanism be
used in place of the sweep() equation function. The new mechanism is required in order to use the generic swept
measurement capabilities.
The most common use of the sweep() function was to define the swept Es/N0, Eb/N0 or SNR values for a BER
simulation. As an example, suppose SNR were being swept. The following equation may have been defined:
SNR = sweep(stepped(0,4,1))

The variable might then have been assigned to the PWR parameter of the additive white Gaussian noise block AWGN.
To convert this to the current sweep mechanism, you do the following:
• Cut 'sweep(stepped(0,4,1))' from the equation and replace it with "0":
SNR = 0

• Paste 'sweep(stepped(0,4,1))' as the value of the VALUE parameter of the BER block and remove the sweep()
function:
stepped(0,4,1)

• Set the VARNAME parameter of the BER block to "SNR", including the double quotation marks.
Controlling Sweeps
When performing a swept Time Domain simulation, the simulator needs to be told when to start the next sweep. This is
done through a sweep control block. Frequency analysis simulations do not need a sweep control block.
The same blocks that define design parameters are also used to control sweeps: the BER meters, SWPVAR, VSA, and
VNA.
Only one block should control sweeping in any system diagram. The block should be located as far downstream from
the sources as possible. This is to give all other blocks a chance to process samples before a new sweep is started.
The BER meters by default start a new sweep after a specified number of errors have been detected. This can be disabled
by setting the DETACT secondary parameter of the BER block to "Do not sweep".
The SWPVAR, VSA and VNA blocks can be configured to start a new sweep by connecting the block's input to an
output port and entering a value for either the block's SWPDUR or SWPCNT secondary parameter. The SWPCNT
parameter specifies a minimum number of samples to receive before starting a new sweep. The SWPDUR parameter is
similar, except a simulation stop time is specified. A new sweep is started after a minimum of SWPDUR·fs samples have
been received, where fs is the sampling frequency of the input signal.
Swept Measurements
Most VSS software measurements support displaying results from one or more sweeps. They typically allow you to view
the results from either an individual sweep or to display the results of all the sweeps of a swept variable. When displaying
the results of an individual sweep, the sweep can be the active sweep, a specific pre-selected sweep, or selected on the
fly with the tuner.
When displaying the results of all the sweeps, the format depends upon the measurement. For measurements with a
pre-defined x-axis, such as the waveform measurement WVFM (time is the x-axis) or the power spectrum measurement
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PWR_SPEC (frequency is the x-axis), the results of each sweep are displayed as separate traces overlaid on the same
graph.

Swept Power Spectrum
50
DB(PWR_SPEC(TP.Amp Out,1000,0,10,0,-1,0,-1,1,0,0,0,1,0))[*] (dBm)
System Diagram 1

p1: PWR_dBm = -10

0
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Figure 1.2. PWR_SPEC displaying all sweeps
Measurements that inherently support sweeping, such as the adjacent channel power measurement ACPR or the AM to
AM measurement AMtoAM_PS, support using the values of one of the swept variables for the x-axis. For example, by
default S21_PS displays S21 versus measured input power. If the simulation swept frequency, S21_PS could be configured
to display S21 versus frequency.

S21 vs Freq vs PIn
13
DB(|S21_PS(VNA_LS.M1,1,0,1,0,1,0,0,1000,0,10,0)|)[*,x]
System Diagram 1
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Figure 1.3. S21_PS displaying S21 vs. frequency vs. inputpower
When a system diagram contains swept variables, the Add/Modify Measurement dialog box, opened by choosing Project
> Add Measurement or by right-clicking an existing measurement in the Project Browser and choosing Properties, displays
additional controls for configuring the sweeps to plot.
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Figure 1.4. Modify Measurement dialog box with drop-downs for two swept variables
If there is a VNA configured to sweep, a Power Sweep (VNA) drop-down list box displays. For other swept variables, a
drop-down list box displays with a title containing the name of the block defining the swept variable and the ID parameter
of the block, for example "SWPVAR.SWP1".
The drop-down list(s) contains a number of options, including a list of all the values for the swept variable represented
by the list, a "Plot all traces" option, and a "Select with tuner" option.
Measurements that have a pre-defined x-axis such as WVFM or PWR_SPEC also have a "Plot active sweep" option.
Measurements that directly support sweeping such as ACPR or AMtoAM_PS also have a "Use for x-axis" option.
Measurements that directly support sweeping typically have 'Swept' in their description. The BER measurements also
directly support sweeping.
If a specific swept variable value is selected, the measurement displays only the results for that sweep value. If Select
with tuner is selected, the measurement displays the results for one sweep value. The specific value can be changed by
opening the Tuner through Simulate > Tune.
If Plot all traces is selected, the measurement displays the results for all the sweeps of that swept variable. For measurements
with a pre-defined x-axis the results are overlaid as separate traces. Measurements that directly support sweeping plot
their measured values using their 'built-in' x-axis. For the swept power measurements such as ACPR or AMtoAM_PS
this is the measured input power from the VSA. For BER this is SNR, Es/N0 or Eb/N0.
If Plot active sweep is selected, only the results of the current sweep display. Note that for multi-dimensional sweeps,
only the first drop-down list contains this option. Selecting it overrides the settings for the remaining drop-down lists.
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1.4. Data Signals
Data signals form the means of passing simulation data from one block to another. There are several different types of
data signals, for the different types of processing supported. They include:
• Digital signals
• Analog signals
• Complex envelope signals
• Generic signals
• Fixed-point signals
Data signals have signal properties associated with them. Signal properties define static attributes of the signal, which
are used by various blocks and measurements to aid in the simulation. Examples of signal properties include sampling
frequency and data rate, estimated signal power, and estimated phase rotation.
Closely associated with signal properties is the concept of a primary data path. The primary data is important in blocks
that have multiple main inputs, such as adders and combiners. The primary data path determines which input signal's
properties are used for the output signal.

1.4.1. Digital Signals
Digital signals typically represent digital data to be transmitted or data that has been received.
Digital signals are signals with values that are restricted to a range of non-negative whole numbers. Every digital signal
has an alphabet size property, commonly referred to as M, which defines the range of values. A digital signal with an
alphabet size of M has values that fall within the following range:
{0,1,...,M-1}

(1.1)

Each digital sample is also called a digital symbol. If M=2 then each sample represents a bit. Normally, when a digital
signal is converted to an analog waveform such as in a digital-to-analog converter or a digital transmitter, the number
of analog samples representing each digital symbol is maintained as a property of the analog signal. This is the samples
per symbol property. It is also known as the oversampling rate. In the current release the samples per symbol property
is always a positive whole number.
The time step of a digital signal is called the symbol period. The inverse of the time step is the data rate. The data rate
and time step at every digital output port can be viewed on a system diagram using the DRATE and TSTEP annotations.
When working with digital sources, the data rate by default is automatically set. If the source is eventually connected to
a block downstream that defines the data rate or sampling frequency, such as a transmitter, the data rate of the source is
set to produce the proper data rate or sampling frequency downstream. The data rate automatically compensates for any
intermediate blocks that may adjust the data rate, such as encoders.
If the data rate cannot be determined from the downstream blocks, it is set to the data rate specified on the Options dialog
box Basic tab.

1.4.2. Analog Signals
Analog signals are used to represent analog waveforms such as voltage or current. In the current release almost all analog
signals represent instantaneous total voltage seen at an output port.
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Analog signals are usually oversampled, that is the sampling frequency is a multiple of the largest frequency of interest
in the signal. To satisfy the Nyquist criterion the signal must be oversampled by at least 2. However, for modeling analog
signals an oversampling rate of 8 or more should normally be used.
The oversampling rate is usually determined automatically. Blocks that specify the oversampling rate contain a SMPSYM
parameter to let you explicitly set the oversampling rate. SMPSYM can be found in analog signal source blocks such as
the TONE and SINE blocks, or in blocks that convert another signal to analog, such as a digital-to-analog converter or
a QAM transmitter. (The parameter is named SMPSYM because it originally represented the number of samples per
symbol used to represent a digital signal in a transmitter. To maintain consistency, the name was kept for pure analog
blocks. Samples per symbol and oversampling rate have the same meaning within the VSS program.)
If the oversampling rate is not explicitly specified at a block that generates an analog signal, it is normally determined
either automatically from the topology of the system diagram or from the Oversampling Rate specified on the Options
dialog box Basic tab.

1.4.3. Complex Envelope Signals
Often an analog signal is a narrowband signal, where the frequency content of interest is within a narrow frequency band
that is centered at a frequency (called the center frequency) much larger than the width of the narrow frequency band.
An example is a modulated RF signal. These signals can often benefit from complex envelope representation.
In complex envelope, or CE, representation, the signal is modeled relative to the center frequency, and the sampling
frequency only needs to accommodate the narrow frequency band. This can reduce simulation time significantly, especially
if the bandwidth of interest is much smaller than the center frequency.
Take for example a 1 GHz carrier modulated by a 10 MHz data signal. If you wanted to monitor the IM3 and IM5
characteristics of the modulated signal near to the carrier, the frequency band from 950 to 1050 MHz is more than
sufficient to represent those frequencies.
If that signal were represented as a real valued analog signal (or real signal), you would need a sampling frequency of
at least 2100 MHz (twice the maximum frequency of interest, 1050 MHz) to model the 950 to 1050 MHz band. Using
a complex envelope representation, however, the sampling frequency would only need to be 100 MHz with a center
frequency of 1 GHz.
Mathematically, the relationship between a real signal and its complex envelope representation is:

x(t) = Re{c(t) ⋅ e

j2π f ct

}

(1.2)

where x(t) is the real signal, c(t) is the complex envelope representation, fc is the center frequency, and Re{a} is the real
component of the complex value a. x(t) is also called the real passband signal.
As a practical interpretation of the above, consider a narrowband modulated signal centered about a high frequency
sinusoidal carrier with frequency fc. Such a signal can be mathematically expressed as:

x(t) = xc(t) ⋅ cos2π f ct − xs(t) ⋅ sin2π f ct

(1.3)

xc(t) and xs(t) are real valued lowpass or baseband signals representing the signal modulating the carrier. They have a
bandwidth much smaller than the center frequency. xc(t) and xs(t) are the in-phase and quadrature (I and Q) components,
respectively, of the real passband signal x(t).
If the complex envelope term of Equation 1.2 is represented as:
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c(t) = I(t) + j ⋅ Q(t)

(1.4)

and multiplied by the ej2πfct term, the argument of Re{ } in Equation 1.2 becomes:

I(t) ⋅ cos 2π f ct − Q(t) ⋅ sin 2π f ct + j ⋅ (I(t) ⋅ sin 2π f ct + Q(t) ⋅ cos 2π f ct)

(1.5)

and Equation 1.2 becomes:

x(t) = I(t) ⋅ cos2π f ct − Q(t) ⋅ sin2π f ct

(1.6)

Equation 1.6 shows that for a narrowband modulated signal, the complex envelope representation is the same as the
baseband modulating signal.
The following graph further illustrates the complex envelope representation of a modulated signal. In this graph, a QAM
signal with a 100 MHz data rate is modulating a 500 MHz carrier. The blue curve is the real passband signal. The red
and magenta curves are the real and imaginary components of the complex envelope signal. The green curve is the
magnitude of the imaginary signal. The graph illustrates that the envelope of the modulated carrier signal is the same as
the magnitude of the complex envelope signal at the carrier's center frequency.
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Figure 1.5. Real and complex envelope waveforms for a QAM modulated signal
Working with Complex Envelope Signals
Many VSS software blocks support complex envelope signals directly. For example, the circuit filters in the Filters
category, the transmitters, receivers, modulators and demodulators in the Modulation category, and many of the RF blocks
in the RF Blocks category support complex envelope signals directly. Many of the RF blocks also support real signals.
Other blocks, such as many of the math operators in the Math Tools category or many of the signal processing blocks in
Signal Processing, work with complex envelope signals, though they generally treat a complex envelope signal the same
as a generic complex signal.
Internally, the VSS program represents a complex envelope signal using a complex signal with an associated center
frequency tag. The value of the center frequency tag at all output ports with such a tag can be viewed on a system diagram
using the CTRFRQ annotation.
Complex envelope signals can only be generated by blocks that satisfy two conditions:
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• The output signal must be complex.
• A center frequency must be specified.
Blocks that generate complex envelope signals usually have a CTRFRQ parameter for specifying the center frequency.
Most of the modulators and transmitters in the Modulation category satisfy these conditions, as do the complex sources
in Sources. Several other source blocks provisionally satisfy these conditions. They provide a CTRFRQ parameter for
specifying a center frequency, but support real as well as complex signals. The TONE block in RF Blocks > Tones and
the SINE block in Sources > Waveforms are such blocks.
In most cases, working with complex envelope signals in the VSS program simply involves specifying the center frequency
at one or two blocks. After that, you can usually specify frequencies of interest using absolute frequency values. For
example, cutoff frequencies for circuit filters are specified in absolute frequencies.
Most measurements also automatically detect and handle complex envelope signals. For example, when entering
frequencies for the adjacent channel power measurement ACPR, the channel center is specified as an absolute frequency.
There may be cases, however, where you want to convert a complex envelope signal to the equivalent real passband
signal. For example, if you want to view the modulated carrier signal itself, you need the real passband signal.
This conversion can be accomplished using the CE2R block in Converters > Complex Envelope. This block allows you
to view and manipulate the modulated carrier signal rather than just the complex envelope. Of course, in order to properly
represent the complex envelope signal as a real signal the sampling frequency of the generated real signal may be very
large compared to the sampling frequency of the complex envelope signal.
A real passband signal can also be converted into a complex envelope signal. This is done using the R2CE block in
Converters > Complex Envelope. Note that while converting a complex envelope signal to its real signal equivalent is
fairly straightforward, generating a complex envelope representation of an arbitrary real signal is not. R2CE works by
essentially down converting the real signal to baseband using the specified center frequency, lowpass filtering that result,
and downsampling to reduce the sampling frequency.
Center Frequency Of Zero
The VSS software allows a complex signal with a center frequency of zero. However, when the center frequency is zero,
the signal may have special characteristics depending on what the signal represents.
For CW signals such as those generated by TONE or SINE, a center frequency of zero is treated simply as fc=0.
Modulated signals treat a center frequency of zero differently. In this case the complex signal is treated as representing
two separate real signals. The real component is the I channel of a baseband signal while the imaginary component is
the Q channel. The signal is called a baseband I/Q channel signal.
Several RF blocks implement different behaviors for baseband I/Q channel signals and complex envelope signals. These
blocks include the behavioral amplifiers such as AMP_B and the behavioral mixers such as MIXER_B. Figure 1.6
illustrates the equivalent diagram for an amplifier-mixer link.
There is one significant difference between the two layouts in Figure 1.6. The output of the mixer when using complex
baseband I/Q channels is a complex envelope signal, while the equivalent layout using real signals results in a real signal.
If the LO frequency is high relative to the data rate, a very large sampling frequency must be used for the real signal
equivalent. The sampling frequency for the baseband I/Q channel based layout only requires the sampling frequency be
adequate to represent the data rate.
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The default behavior of the spectrum-based measurements is to display the full spectrum when the signal is a baseband
I/Q channel signal. This is similar to what network analyzers do when displaying I/Q channel signals.
The circuit filter blocks also support baseband I/Q channel signals. The main difference between treating a complex
signal as complex envelope versus a baseband I/Q channel signal is that the coupling between the real and imaginary
components of the input signal.
In the complex envelope, complex math is applied directly, which results in coupling between the two components. For
baseband I/Q channel signals, the signals are treated as two separate signals, so there is no coupling between the two
components. Note that in many instances the coupling is minimal so no significant differences are observed.
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Figure 1.6. Equivalent baseband I/Q channel amplifier and mixer
Other Benefits and Limitations
One advantage of using complex envelope signals in a Time Domain simulation is the fact that phase information is
present in the complex signal. The phase information does not have to be extracted from the real signal.
One of the big disadvantages of complex envelope signals is the modeling of wideband signals, particularly noise, when
the center frequency is small enough that the complex envelope frequency band crosses DC. This occurs when the
following is true:
fc<fs/2

(1.7)
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For a complex envelope signal, any negative frequency content can be 'folded' across DC into an equivalent positive
frequency content. The problem with a wideband or noise signal is any negative frequency content already has positive
frequency content, and the net effect is that the signal is doubled over the overlapping frequency range. This topic is
covered in more detail in the Negative Complex Envelope Frequencies section of this chapter.
Another limitation of complex envelope signals involves the modeling of nonlinear operations. If the intent of a nonlinear
operation is to apply the nonlinearity to the equivalent real passband signal, the operation must take into account the
complex envelope nature of the signal.
Many of the RF nonlinear blocks do apply their nonlinearities to complex envelope signals with this adjustment. In
particular, the nonlinear amplifiers that incorporate the polynomial based nonlinearity found in AMP_B, which include
AMP_BV, AMP_F, and VGA_F, along with the behavioral mixers MIXER_B, MIXER_F and MIXER_S, all apply
their nonlinearities to the equivalent real passband signal. The AM/AM-AM/PM based amplifier models such as those
found in AMP_F and NL_S also operate properly with complex envelope signals.
Other RF nonlinear blocks, such as V_LIM, do not take into account the complex envelope nature of the signal, and must
be used with caution with complex envelope signals. For these blocks, the safest, though slowest simulation time-wise,
approach is to convert the complex envelope signal to the real passband equivalent using CE2R, apply the nonlinearities,
then, if desired, convert the signal back to complex envelope form using R2CE.
RF Budget Analysis Simulations
Complex envelope signals are primarily a Time Domain simulation concept. However, the frequencies at which RF
Budget Analysis simulations are typically performed are offsets from the center frequency. This is particularly true with
modulated signals.
Tone sources do have the option to use the tone frequencies rather than the center frequency. This is controlled using
the RFBSRC secondary parameter.

1.4.4. Sampling Frequencies, Data Rates and Oversampling
There are several key concepts related to sampling frequency in VSS Time Domain simulation signals. First and foremost
is the sampling frequency itself. Every time domain signal has a sampling frequency. The sampling frequency is the
inverse of the simulation time duration represented by each sample of the signal.
Signals also have a data rate, which represents the bandwidth of the 'interesting' portion of the signal. For digital signals
the data rate and the sampling frequency are the same. Digital signals that have been converted to analog signals such
as with an ADC or a transmitter usually have a sampling frequency that is a multiple of the data rate. This multiple is
the samples per symbol, as each digital symbol is represented by that many analog samples. It is also called the
oversampling rate.
For pure analog signals such as tones and other waveforms, the data rate does not have a direct interpretation. Instead,
it is used to indicate the interesting portion of the signal to the simulator, and is called the signal bandwidth. The sampling
frequency is the signal bandwidth multiplied by the oversampling rate. The use of the signal bandwidth in the VSS
program is described in the Signal Bandwidth section.
The following equations show the relationships between these values:

1
f s = Δt

(1.8)

f s = DRAT E ⋅ SM PSY M = DRAT E ⋅ OV RSM P = SIGBW ⋅ OV RSM P

(1.9)
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In the VSS software you can specify the data rate, oversampling rate, and sampling frequency in several ways. The
simplest method is to use the settings on the Basic tab of the Options or System Simulator Options dialog boxes, either
for all system diagrams or for a specific system diagram. The settings in the dialog box are used as the default settings
for the system diagram.
Source and transmitter blocks also allow you to specify these settings on an individual block level. Blocks that work
with digital signals such as the QAM transmitter QAM_TX have a DRATE parameter for setting the data rate and a
SMPSYM parameter for setting the samples per symbol/oversampling rate. More general purpose blocks such the RF
tone TONE have a SMPFRQ parameter for setting the sampling frequency. They also have a SMPSYM parameter for
setting the oversampling rate. (The parameter is SMPSYM for historical reasons and to illustrate that it has the same
effect as the SMPSYM parameter for the digital transmitters.)
Note that the default data rate, sampling frequency and samples per symbol/oversampling rate values specified in the
System Simulator Options dialog box are available as built-in variables in the system diagram. These variables are:
Sampling frequency

_SMPFRQ

Data rate

_DRATE

Samples per symbol/oversampling rate

_SMPSYM

The data rate and sampling frequency at all the output ports in a system diagram can be viewed using the DRATE and
SMPFRQ annotations. The FRQ_PROP measurement in the System > Tools category can be used to display the data rate,
sampling frequency and center frequency for specific ports in a graph table.
The proper selection of sampling frequency is important in Time Domain simulations. The sampling frequency, and for
complex envelope signals the center frequency as well, determines the range of frequencies that may successfully be
simulated.
Sampling Theory and Aliasing
Sampling theory states that the minimum sampling frequency required to represent a given frequency is twice that
frequency. For real signals the frequency range is:

− fs/2 ≤ f < fs/2

(1.10)

For complex envelope signals, the sampling frequency band is:

fc − fs/2 ≤ f < fc + fs/2

(1.11)

Note the use of ≤ at the lower limit and < at the upper limit. This is because the frequency at -fs/2(or fc-fs/2) has the same
value as fs/2 (or fc+fs/2)
Any frequency content outside these ranges is aliased into the sampling frequency band. The following diagram illustrates
the effect of aliasing.
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Figure 1.7. Aliasing of frequencies outside sampling frequency band
In this example, there are three tones: 7MHz, 12MHz and 33MHz. This analog signal is then represented as a complex
envelope signal with sampling frequency of 10MHz and center frequency of 15MHz. The sampling frequency band is
then 10MHz to 20MHz.
The 12MHz tone is sampled correctly since it is within the sampling frequency band. The 7MHz tone is outside the band,
so it gets aliased into the sampling frequency band. The aliasing results in the 7MHz tone appearing at 17MHz. The
33MHz tone is also aliased, it appears at 13MHz.
Selecting A Sampling Frequency
In practice, the sampling frequency for analog signals should generally be several times larger than the minimum sampling
frequency required. This is particularly important when using the circuit filters or RF blocks. The reason for this is many
of these blocks incorporate filters as part of internal upsampling and downsampling. This resampling is a key element
in the modeling performed by these blocks.
The filters are used to eliminate frequency content outside the original sampling frequency band when the input signal
is upsampled, and again prior to downsampling. Ideally, the filters are bandpass filters with a passband matching the
original sampling frequency band and infinitely sharp cutoffs at the edges of the band. However, ideal filters with infinitely
sharp cutoffs are not possible, and the filters must exhibit a transition region at the band edges.
The end result is some roll-off near the edges of the sampling frequency band. The following figure illustrates the roll-off
effect on a tone with white noise passed through the nonlinear behavioral amplifier AMP_B. The blue curve is the signal
going into the amplifier, the pink curve is the signal output by the amplifier, with slight attenuation of the noise near the
edges of the sampling frequency band.
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Figure 1.8. Roll-off near sampling frequency band edges due to internal resampling
Signal Bandwidth
The signal bandwidth, signal band, and oversampling rate for analog signals are used several different ways in the VSS
program.
The circuit filter blocks such as BPFB or LIN_S use the signal bandwidth when in IIR mode to determine the frequency
alignment points for the bilinear transform. The bilinear transform maps s-domain frequencies to the z-domain in a
nonlinear fashion. The frequency alignment point is where the s-domain frequency exactly matches the z-domain
frequency. The Filter Issues section in the RF Modeling in VSS chapter covers circuit filters in detail.
The RF behavioral amplifiers and mixers may also use the signal bandwidth. The RF blocks that support internal
resampling can be configured to use the signal bandwidth in their determination of the amount of upsampling required.
Consider a very simplified example: suppose the sampling frequency band is 10GHz to 20GHz (sampling frequency of
10GHz and center frequency of 15GHz). If the signal were passed through a 5th order polynomial (which is what the
behavioral amplifiers use if both P1dB and IP3 are specified), the maximum frequency that may be generated is 5 · 20
= 100GHz. The upsampling rate that is required for a given frequency is found from:

(

U PRAT E = roundu p

f max − f c
fs

)

(1.12)

For this example, the upsampling rate required is 9. However, if the signal can be presumed to be entirely contained
within the signal band, then the maximum frequency that needs to be accommodated is the maximum signal band
frequency rather than the maximum sampling frequency band signal. If, for this example the sampling frequency band
were only 1GHz, then the maximum frequency that may be generated is 5 · 15.5 = 77.5GHz, and the upsampling rate
would only have to be 7.
Note that the default behavior for the amplifiers and mixers is to use the sampling frequency band. The SIGBW parameter
must be cleared to use the signal frequency band. Also note that this is only of value when the center frequency is near
the sampling frequency, where the ratio of the maximum signal band frequency to the maximum sampling frequency
band frequency is largest.
Mixers can also use the signal frequency band to limit the spurs to be synthesized. In these cases the SIGBW parameter
is also used to limit the frequency band used to determine which spurs to generate.
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Many of the VSS software measurements use the oversampling rate to determine the base number of samples to 'slide'
their snapshot of the time domain samples. For example, the WVFM measurement advances the window of time displayed
by oversampling rate samples. If the time step is 0.1 ns and the oversampling rate is 10, the WVFM measurement lines
up the start of the time axis on 1 ns boundaries.
The spectrum measurements also use the oversampling rate in a similar manner. The point at which samples for the FFTs
are taken starts on a multiple of the oversampling rate. This is one reason why a spectrum of a CW signal may appear
to jump as the simulation runs. If the frequency of the CW signal relative to the sampling frequency and the oversampling
rate are not related by a whole number, they may become out of sync, affecting the display of the spectrum.

1.4.5. Generic Signals
The term generic signals is used to classify signals that do not represent digital nor analog signals directly. For example,
control signals are generic signals. The complex valued input to the I/Q Modulator block IQ_MOD is also a generic
signal, as is the output of the QAM Mapper block QAM_MAP.

1.4.6. Fixed-Point Signals
Fixed-point signals are a special case of generic signals. Fixed-point signals are used to model the limited floating point
precision commonly found in DSP applications. The resolution available for representing floating point values in DSP
applications is generally much less than that available in the general purpose CPUs used in personal computers. The
fixed-point library allows the modeling of those limitations.
The "Fixed-Point Simulations" chapter of the Getting Started Guide covers fixed-point simulations in detail.

1.4.7. Signal Properties
All signals in the VSS program have one or more properties associated with them. A signal property describes a particular
characteristic of the signal during a simulation sweep. All signals have a time step property, which defines the time
duration between each sample. The following table lists some of the more common properties:
Property

Data Types

Description

Time Step/Sampling
Frequency

All

The time span between samples. The inverse of the time step is the
sampling frequency.

Samples per
All
Symbol/Oversampling
Rate

The ratio of the data rate to the sampling frequency. The data rate is the
sampling frequency divided by the samples per symbol.

Alphabet Size

Digital

The range of allowed values in a digital signal.

Center Frequency

Complex Envelope

The center frequency of a complex envelope signal.

Signal Power

Analog

The average power of the transmitted signal. This defines the operating
point and is used for automatic gain control in receivers.

Generated Noise PSD Analog

The average noise power spectral density in a time domain signal. This
is used by the BER meters to automatically determine Eb/N0, Es/N0 or
SNR.

Phase Rotation

Analog

The average phase rotation that has been applied. This is used to perform
automatic phase rotation compensation.

Signal Delay

All

The amount of delay that has been imparted on the signal since its
generation.
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Many of the properties are used for automatic compensation. For example, most receivers and demodulators use the
signal power, phase rotation and signal delay properties to scale and align the signal prior to demodulation and detection.
The signal properties are referred to as 'static' properties. They are static because they do not change during a simulation
sweep. They are determined before any samples are generated, and are used to describe the expected state of the signal.
Most of these properties can be viewed using either annotations or measurements found in the System > Tools category.

1.4.8. Primary Data Path
Signal properties are normally assigned starting from source blocks. Blocks connected to those blocks then assign
properties to their output signals, and the process repeats until all blocks have assigned properties to their signals.
Most blocks in the VSS program have one input port and one output port for the main signal. Other input or output ports
are generally secondary in nature. For these one input-one output main signal blocks, the signal properties from the input
port are normally assigned to the output port unless the block changes a particular property.
However, blocks that combine multiple input signals, such as the adder block ADD or the combiner block COMBINER,
have multiple main signals to choose from. To determine the signal properties for their output port, these blocks must
select one of the input ports as the primary input port and use that port's signal properties as the basis for the output port.
The signal path formed by this primary input port and the output port is called the primary data path.
The primary input port of blocks such as ADD or COMBINER can either be determined automatically or selected through
a PRIMINP parameter. When automatic selection is used, the block chooses the primary input port based on the following
rules:
• Modulated signals have the highest priority.
• With all else equal, the input port with the smallest node number is chosen.
There is no corresponding primary output port. A block with multiple output ports defines multiple primary data paths,
one for each input port - output port path.

1.5. Automatic Configuration
The VSS software has the ability to configure many of its settings automatically. For example, when using a QAM
transmitter block such as QAM_TX, you can use the general purpose receiver block RCVR to receive and detect the
signal. The RCVR block automatically selects the appropriate demodulation based on the received signal's properties.
You can change the number of symbol levels in the transmitter and RCVR is automatically reconfigured to use the new
symbol levels. You can even change the transmitter to MPSK_TX and RCVR automatically reconfigures itself for PSK
rather than QAM modulation.
At the same time, blocks that support automatic configuration normally have parameters that can be used to override the
automatic configuration. These parameters are often secondary parameters since they are not frequently used. They also
typically have no value assigned, which the blocks interpret as use automatic configuration.
Another example of automatic configuration is the ability to automatically set sampling and center frequencies at source
blocks whose signals are eventually combined. In this case one block determines its sampling frequency and the other
sources automatically set their sampling frequencies to be compatible. For example, if the LO input to a mixer does not
have its sampling frequency explicitly set, it is assigned the sampling frequency of the input or output signal of the mixer.
The block setting the sampling frequency does not necessarily have to be a source block. For example, most of the
transmitters contain a DRATE parameter that lets you define the data rate at the output of the transmitter. The input
signal to the transmitter has its sampling frequency set to this data rate if it is specified, while the output signal has its
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sampling frequency set to the data rate times the samples per symbol/oversampling rate. If the input to the transmitter
consisted of a digital source followed by a rate 1/3 convolutional encoder, the digital source is automatically configured
to generate data at 1/3 the data rate of the transmitter.
When there are multiple data paths all set for automatic sampling frequency determination connected to a single block
such as a combiner, the primary data path is used to determine which blocks define the sampling frequency.

1.6. Spectral Analysis in Time Domain Simulations
Performing spectral analysis in sampled Time Domain simulations requires taking into account several factors that may
affect the results. These are primarily related to the limitations imposed by the need to represent continuous signals as a
sampled data stream.
This section points out some of these factors without going into depth with the mathematical theory behind them. For
more in-depth details, refer to general digital signal processing texts such as Proakis [1].

1.6.1. Fourier Transforms
Spectral analysis in Time Domain simulations is performed using the discrete Fourier transform (DFT), windowing and
averaging.
The DFT converts N equally spaced time domain samples into N frequency domain samples at equally spaced frequencies.
The general equation is:
N−1

X (n) =

∑x(k) ⋅ ex p( − j ⋅N2πkn ) n = 0,1,2,...,N-1

(1.13)

k=0

The inverse DFT converts N equally spaced frequency domain samples into N equally spaced time domain samples
according to:
N−1

1
x(k) = N

∑ X (n) ⋅ ex p( j ⋅ N2πkn ) k = 0,1,2,...,N-1

(1.14)

n=0

The relationship between n and frequency is:

n ⋅ f + f − fs
f = N
for N even
s
c
2
n ⋅ f + f − fs + fs
f = N
for N odd
s
c
2 2⋅N

(1.15)

The two different equations result in one of the N frequencies always being at the center frequency.
These equations make a big assumption: that the signal is periodic over N samples. However, unless the signal is composed
only of tones that fall exactly on one of the equally spaced frequencies, the frequency content is 'smeared', or leaked into
nearby frequencies. This is most apparent when working with pure tone signals. When N results in the frequencies of
the tones falling exactly on one of the N frequencies, the frequency spectrum is exact. However, increasing or decreasing
N by 1 causes the spectrum to leak.
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Figure 1.9. Voltage spectrum of an 11 GHz tone at center frequency 10 GHz
Figure 1.9 illustrates the leaking effect. The signal from both plots is the same: a single tone complex envelope signal
at 11 GHz with center frequency of 10 GHz and sampling frequency of 10 GHz. The tone's amplitude is 1V, and the
y-axis displays linear voltage.
The blue curve has N set to 10. This results in the following sampled frequencies:
5, 6, 7, 8, 9, 10, 11, 12, 13, 14 GHz
The pink curve has N set to 11. This results in the following sampled frequencies:
5.45, 6.36, 7.27, 8.18, 9.09, 10.00, 10.91, 11.82, 12.73, 13.64, 14.55 GHz
For N=1, 11 GHz is not one of the sampled frequencies. Therefore, the tone is spread into the available sampled frequencies.

1.6.2. Averaging, Windowing and Power Spectrum Estimation
An estimate of the power density spectrum called a periodogram can be made using Equation 1.13 by applying the
following:

| X ( f )|2
1
⋅
P xx( f ) = N
2⋅Z

(1.16)

Unfortunately, the periodogram is not a consistent estimate of the true power density spectrum, particularly when working
with non-periodic signals such as modulated signals.
One of the most common and simplest methods of improving the power spectrum estimate, and the approach taken by
the VSS program, is the Welch method. This method involves computing the average of several overlapping periodograms
with windowing applied to the time domain samples.
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Figure 1.10. Effect of averaging and windowing on power spectrum estimates
Figure 1.10 illustrates the smoothing effect of averaging and windowing on a QAM signal. The QAM signal is not pulse
shaped, so the theoretical power spectrum is the sinc function squared. The black markers indicate the theoretical spectrum.
The pink curve is windowed and averaged 10 times with 50% overlap. The blue curve is not windowed and is averaged
10 times with 50% overlap. The gray curve is not windowed, has no averaging and uses a DFT with 1000 points. The
averaged spectrums use DFTs with 100 points, resulting in a total of 1000 time domain samples being used for all three
cases.
Note that with windowing and averaging, the spectrum matches the theoretical spectrum closely in the main lobe -1 GHz
to +1 GHz. However, it deviates towards the ends of the sampling frequency band.
In general, windowing and averaging should be used when working with non-CW signals, such as modulated signals,
but not with CW signals. The automatic configuration feature of the VSS program attempts to select the proper settings
for performing power spectrums based on the signal properties. If the signal is a modulated signal, it uses windowing
and averaging and a fairly large N (1024 in the current release) for the DFT.
If the signal is CW and the tone spacing is a sub-multiple of the sampling frequency, it attempts to find an N that results
in all tones in the signal falling on frequency sample points. If an N with a reasonable value is found, averaging and
windowing is disabled.
The automatic configuration settings can be overridden. The measurements that rely on power spectrum computations
include settings for selecting N, the number of averages, and the windowing settings. These settings are generally
secondary settings in the measurements. The various test points and meters also include similar settings. By default the
measurement settings use the settings from the test point/meter.
The default settings when averaging and windowing are applied are:
• Number of FFT bins: 1024
• Number of averages: Cumulative
• Window type: Taylor
• Windowing parameter: 4.5 for "Kaiser-Bessel" windowing, 0.0 for all others.
• Sliding ratio: 0.5
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1.6.3. Frequency Resolution and Video Bandwidth
Spectrum analyzer settings are normally in the form of frequency resolution and video bandwidth. There are equivalent
settings for the DFT based spectrum measurements.
Frequency resolution is directly related to the number of samples used to compute the DFT:

f
f Res = Ns

(1.17)

Video bandwidth does not have such a direct equivalent. However, an effect similar to that of video bandwidth is produced
by averaging. In a spectrum analyzer decreasing the video bandwidth has the effect of smoothing the spectrum. A similar
behavior can be accomplished with DFTs by applying averaging.
VSS software uses the following relationship to convert from video bandwidth to number of averages:

f
N Avg = ceil N ⋅ fs
V BW

(

)

(1.18)

Note that Equation 1.18 is only used to approximate the effects of changing the video bandwidth. It does not necessarily
shape the spectrum to what you would see in a spectrum analyzer for the given video bandwidth.

1.6.4. Negative Complex Envelope Frequencies
One of the more confusing aspects of working with complex envelope signals is how to interpret negative frequencies.
When possible, you should avoid working with complex envelope signals that contain negative frequencies. This is
accomplished by ensuring Equation 1.19 is true:

f
f c ≥ ss

(1.19)

However, this is not always possible.
There are three scenarios when a complex signal contains negative frequency content:
• Complex baseband signal representing I and Q channels.
• Complex envelope signal with center frequency of 0.
• Complex envelope signal with center frequency other than 0.
The first two cases both have a center frequency of 0. The difference between the two is the interpretation of the complex
values. In general, a signal is treated as separate I and Q channels when it represents the output of an I/Q modulator. CW
signals are treated as complex envelope signals.
The second and third cases both treat the signal as complex envelope signals and result in the same behavior.
Complex baseband signals representing I and Q channels are covered in the Center Frequency Of Zero sub-section of
the Complex Envelope Signals section.
For complex envelope signals, negative frequency content has an equivalent positive frequency content. The equivalent
positive frequency content is the complex conjugate of the negative frequency content. This is derived from the complex
envelope equation:
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*
⋅
S( f ) = 1
2 (S CE( f − f c) + S CE( − f − f c))

(1.20)

where S(f) is the spectrum of the real signal, SCE(f) is the complex envelope spectrum and a* indicates the complex
conjugate of a.
Figure 1.11 illustrates this interpretation further. The upper diagram shows the complex envelope and the conjugate of
the complex envelope when fc>fs/2. The lower diagram shows that as fc becomes less than fs/2, the complex envelope
and its conjugate begin to overlap. The cross-hatched area is the negative frequency content of the complex envelope.
Complex Envelope

fc>fs/2

-fc-fs/2

-fc

-fc+fs/2

DC

fc-fs/2

fc

fc+fs/2

fc<fs/2
Complex Envelope

-fc-fs/2

-fc

DC

fc

fc+fs/2

Negative frequency content

Figure 1.11. Negative frequencies in complex envelope signals
In most cases, when interpreting a spectrum any negative frequency content should be 'folded' into the equivalent positive
frequencies. This results in a spectrum containing only non-negative frequencies, which is what is normally expected
when working with real signals.
The default behavior of the spectrum-based measurements is to display negative frequencies folded into their equivalent
positive frequencies. This presents the spectrum as you would see it on a spectrum analyzer.
One case where negative frequency folding does not work is the modeling of white noise or any other broad spectrum
signal where the signal crosses DC. What happens in these cases is there is overlapping frequency content from both the
positive and negative frequencies, and folding results in a doubling of the spectrum over the portion of the spectrum
where the overlap occurs.
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Figure 1.12. Negative frequency folding and broad spectrum signals
As Figure 1.12 illustrates, the resulting folded spectrum shows a sharp drop where the negative frequency overlap ends.
This is most apparent when the signal contains white noise, since the white noise extends across the full sampling
frequency band. Theoretically, the white noise should end at DC - there should not be any negative frequency content.
However, in the current release white noise is always generated across the full sampling frequency band.
The Noise Modeling in VSS chapter of this guide contains more information on noise modeling within the VSS program.

1.6.5. Measuring Channel Power
Many VSS software measurements use channel power in their computations. These include the power meter measurement
PWR_MTR, the adjacent channel power measurement ACPR, and the swept AM to AM measurement AMtoAM_PS.
Channels are normally defined using a center frequency and a bandwidth. The channel center frequency should not be
confused with the signal center frequency. The channel center frequency defines the center of the channel and the
bandwidth defines the width. The channel frequencies are the frequencies that satisfy:

f
f
f c,Ch − 2BW ≤ f < f c,Ch + 2BW

(1.21)

Channel power is computed by first obtaining a power spectrum. The use of the DFT divides the frequency spectrum
into N frequency bins, where the value of each bin represents the power within the frequency range:

f
f
f
f
f c − 2s + Ns ⋅ n ≤ f < f c + 2s + Ns ⋅ (n + 1) for even N
f
f
f
f
f
f
f c − 2s + 2Ns + Ns ⋅ n ≤ f < f c − 2s + 2Ns + Ns ⋅ (n + 1) for odd N

(1.22)

for n=0,1,...,N-1. Note that for n=0 the lower frequency bound is the lower edge of the sampling frequency band and for
n=N-1 the upper frequency bound is the upper edge of the sampling frequency band.
Channel power is obtained by first summing the power spectrum values for the bins that fall entirely within the channel
frequency band. If one of the edge frequencies does not fall exactly on a edge of a frequency bin, power proportional to
the amount of the bin occupied by the edge frequency is added to the channel power. For example, if the lower frequency
edge were 3.75 Hz and it fell in the frequency bin bounded by 4 Hz and 5 Hz, 25% of the power in that bin is included
in the channel power.
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When specifying channel bandwidth, the VSS program also supports using a single frequency bin. The "1 RBW (bin)"
option for the channel bandwidth type, when available, does this.

1.7. Microwave Office Schematics: Parameterized Subcircuits and Sweeping
You can access parameterized Microwave Office subcircuits in the VSS program and use them in swept simulations.
The RF blocks that support parameterized subcircuits are LIN_S, NL_S, OSC_S, and MIXER_S.

1.7.1. Passing Parameters from Microwave Office Circuits
In a circuit schematic you can define the parameters you want to pass to an VSS software system diagram by using the
x<<5 syntax, where x is the parameter to pass. The circuit schematic shown in the following figure has a passed parameter
for DC voltage.

When the circuit is used in VSS software system diagrams using the Simulation Based RF blocks (such as NL_S in this
example), the passed parameter from the circuit schematic is also listed as one of the parameters inside the RF Block,
as shown in the following figure. This parameter can be treated like any other parameter and used for swept simulation.
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1.7.2. Using a Microwave Office Circuit Swept Parameter in a System Diagram
Parameters that are swept in a circuit schematic can also be used in VSS software simulation. A sweep performed using
the SWPVAR block or swept sources works the same when used in the VSS program. In the following figure notice that
the circuit parameter "Vbias" is swept using the SWPVAR block.

When the circuit is used in VSS software system diagrams using the Simulation Based RF Blocks (such as NL_S in this
example), the swept parameter from the circuit schematic is also listed as one of the parameters inside the RF Block, as
shown in the following figure. Note that the parameter name begins with 'SWP_'. This parameter can be treated like any
other parameter and used for simulation.

The parameters passed to the VSS program in this manner can take on two sets of values.
• Select one of the sweep values from the circuit schematic: In the corresponding RF block Element Options dialog box
click Show Secondary. Notice the parameter IVARTYP as shown in the following figure. Set this parameter to Select
from list and the passed parameter lists the sweep values in the drop-down list as shown in the following figure.
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• Enter any value and pin it to the nearest sweep value: Set the IVARTYP parameter to Allow any value for numeric, pin
to nearest as shown in the following figure. The value entered is pinned to the nearest sweep value from the schematic.

1.8. References
[1] Proakis, J. and Manolakis, D., Digital Signal Processing
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Chapter 2. RF Modeling in VSS
This chapter details the RF modeling capabilities of the Cadence® Visual System Simulator™ (VSS) communications
and radar systems design software. These capabilities include:
• RF Budget Analysis
• RF Inspector
• Impedance mismatch modeling
• Behavioral amplifier, mixer and circuit filter blocks
• Blocks for modeling Cadence Microwave Office® software linear and nonlinear circuits within the VSS program
RF modeling applies to the portions of a system design that represent analog voltage signals, usually at RF frequencies
but not always. These are the portions of the design that include behavioral amplifiers, mixers, and circuit based filters
as well as blocks for incorporating Microwave Office circuit designs within a system simulation.
RF modeling typically only applies when using the RF blocks. These blocks include all the blocks within the RF Blocks
category. They also include the circuit based filters, which are found in the Bandpass, Bandstop, Highpass and Lowpass
sub-categories of the Filters category.
The RF Blocks In VSS section outlines the available blocks and offers suggestions on when to use various blocks. It
also includes information on incorporating signals from non-RF blocks into RF modeling by using the RF_START,
RF_START_NS, and RF_END blocks.
RF modeling lets you perform quick frequency based cascaded measurements such as cascaded noise figure or operating
gain using the RF Budget Analysis simulator. The RF Budget Analysis simulator is one part of the frequency analysis
capability of the VSS program. The RF Budget Analysis section explains RF Budget Analysis simulations.
RF modeling lets you identify the makeup of frequency content at any point in an RF link using the RF Inspector simulator
(RFI). With RFI you can identify sources of distortion and interference, such as what aspect of a nonlinear RF component
is causing a particular IM product. The RF Inspector simulator is the other part of the frequency analysis capability of
the VSS program. The RF Inspector section covers RFI in detail.
RF modeling allows you to take into account the effects of impedance mismatches, particularly when working with
filters. The Impedance Mismatch Modeling section details these capabilities.
Modeling frequency dependent behavior in Time Domain simulations is not a trivial task. The Time Domain Filter Issues
section covers some of the more important considerations to keep in mind.
A key component of RF modeling is the support for nonlinear behavior. The VSS program includes several RF blocks
for modeling nonlinear behavior. They include the behavioral amplifier blocks AMP_B, AMP_BV, AMP_F, VGA_F,
the behavioral mixer blocks MIXER_B and MIXER_F, and the nonlinear Microwave Office simulation based amplifier
and mixer blocks, NL_S and MIXER_S. As with any RF model, they have limitations.
The Time Domain simulation limitations are described in the "Nonlinear Modeling Issues section. Issues affecting RF
Budget Analysis simulations are in the RF Budget Analysis Nonlinear Modeling section. The RF Inspector section covers
the various aspects of nonlinear models within RF Inspector simulations.

2.1. RF Blocks In VSS
The VSS software RF blocks can be grouped into four main groups: linear filters, nonlinear amplifiers, mixers, and
miscellaneous.
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The linear filters consist of purely linear blocks that can be modeled using S and Y parameters. These include LIN_F,
LIN_F2, LIN_S, RFATTEN, and QHYB_12, as well as the circuit filter blocks such as BPFB or LPFC.
The nonlinear amplifiers are blocks that apply a nonlinearity to the signal without shifting the frequency. These include
AMP_B, AMP_BV, AMP_F, VGA_F, and NL_S.
The mixers are three port blocks that multiply two signals to obtain a third frequency shifted signal. These include
MIXER_B, MIXER_F and MIXER_S.
The miscellaneous group includes blocks such as TONE and LOAD, and the network analyzer blocks VNA and VSA.
Three miscellaneous blocks, RF_START, RF_START_NS, and RF_END, let you incorporate signals from non-RF
sources into RF modeling.
There are also several other specialized blocks such as the PLL blocks and V_LIM. Because of the nature of these blocks,
they generally do not fully incorporate the RF modeling features described here and are not discussed further in this
chapter.
Finally, non-RF block generated signals such as modulated signals can be used in Time Domain RF and RF Budget
Analysis simulations through the use of the RF_START, RF_START_NS, and RF_END blocks.

2.1.1. Linear Filters
The linear filters group consists of RF blocks that have linear behavior. Their behavior can be represented as S or Y
matrices. This group consists of the following RF blocks:
Block

Description

ANTENNA

RF Antenna

APHSHFT_VAR

Variable Analog RF Phase Shifter

a

Bandpass Butterworth Filter

a

Bandpass Chebyshev (type I) Filter

a

Bandpass Bessel Filter

a

Bandpass Elliptic Filter

a

Bandstop Butterworth Filter

a

Bandstop Chebyshev (type I) Filter

a

Bandstop Bessel Filter

a

BSFE

Bandstop Elliptic Filter

BUS_SPLITTER

RF Bus Splitter/Combiner

CIRC_12

Circulator (1-Input, 2-Output)

CIRC_21

Circulator (2-Input, 1-Output)

COMBINER

RF Combiner

DCOUPLER_3

Directional Coupler, 3-port Internal Termination

DCOUPLER_4

Directional Coupler, 4-port External Termination

DHYB_22

180-Degree Hybrid (2-Input, 2-Output)

DPHSHFT

Digital RF Phase Shifter

BPFB
BPFC

BPFD
BPFE

BSFB
BSFC

BSFD
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Block

Description

DPHSHFT_VAR

Variable Digital RF Phase Shifter

DSATTEN_VAR

Variable Digital Step Attenuator

a

Highpass Butterworth Filter

a

Highpass Chebyshev (type I) Filter

a

Highpass Bessel Filter

a

HPFE

Highpass Elliptic Filter

ISOLATOR

Isolator

LIN_F

Linear Behavioral Model (File-Based)

LIN_F2

Linear Behavioral Model, 2nd Generation (File-Based)

LIN_MDIF

MDIF File Based Linear Behavioral Model

LIN_S

Linear Behavioral Model (Simulation-Based)

LINAMP

Linear Amplifier

HPFB
HPFC

HPFD

a

Lowpass Butterworth Filter

a

Lowpass Chebyshev (type I) Filter

a

Lowpass Bessel Filter

a

LPFE

Lowpass Elliptic Filter

LTUNER

Lossless Tuner

LVGA

Linear Variable Gain Amplifier

PHARRAY_ANT

Phased Array Antenna

PHARRAY_RXSIG

Phased Array Signal Splitter for Receivers

LPFB
LPFC

LPFD

PHARRAY_RXSIG_BUS Phased Array Signal Splitter for Receivers, Bus Based
QHYB_12

Quadrature Hybrid (1-Input, 2-Output)

QHYB_21

Quadrature Hybrid (2-Input, 1-Output)

QHYB_22

Quadrature Hybrid (2-Input, 2-Output)

RF_START

Start RF Signal

RF_START_NS

Start RF Signal (Noise Source)

RFATTEN

RF Attenuator

RFDELAY

RF Delay

RFDELAY_VAR

Variable Digital RF Delay

RFDPDT_24ST

RF Double Pole Double Throw Switch (static 2 input 4 output)

RFDPDT_42ST

RF Double Pole Double Throw Switch (static 4 input 2 output)

RFSW_1nDYN

RF Single Pole n-Throw Switch (dynamic 1 input n-output)

RFSW_1nST

RF Single Pole n-Throw Switch (static 1 input n-output)

RFSW_BASEBALL

RF Baseball Switch

RFSW_CROSSOVER RF Crossover Switch
RFSW_DIR

RF Directional Switch

RFSW_n1DYN

RF Single Pole n-Throw Switch (dynamic n-input 1 output)
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Block

Description

RFSW_n1ST

RF Single Pole n-Throw Switch (dynamic n-input 1 output)

S2P_BLK

Two Port S Parameter Block

SBLK_2STATE

Two State S Parameter Block

SCOUPLING

Signal Coupling

SnP_BLK

n Port S Parameter Block

SPLITTER

RF Splitter

VVA

Voltage Variable RF Attenuator

Y2P_BLK

Two Port Y Parameter Block

YnP_BLK

n Port Y Parameter Block

Z2P_BLK

Two Port Z Parameter Block

ZnP_BLK

n Port Z Parameter Block

a

This block can be found under the Filters category, not RF Blocks.

NOTE: RF_START/RF_START_NS are included in the previous table because they are implemented as linear filters.
Their use, however, is described in the Working with Non-RF Blocks section.
The linear filters all utilize the same core implementation, which internally represents the filters in Y matrix form. The
Y matrices are used to compute the various frequency dependent properties for frequency analysis simulations. These
include linear gain, available gain, and noise generation. When impedance mismatch modeling is enabled, the Y matrices
are used by the simulator to determine the impedances looking into the ports of the block.
For Time Domain simulations, the linear filters rely on either IIR, FIR or a combination of both IIR and FIR digital
filters. Each type has its advantages and limitations. In general, IIR filters provide a better overall response for arbitrary
signals, though this is not guaranteed. The FIR filters on the other hand can provide much better frequency responses
provided the signal is composed of tones that fall exactly on the frequencies corresponding to the FIR taps. The FIR filter
is also generally much faster for large filter orders. The combination FIR and IIR filter provides a last-ditch model, with
a typically good match for the magnitude response and a rough approximation of the group delay response.
A more comprehensive discussion of issues related to time domain filtering is found in the Filter Issues section.
The blocks in the linear filters group support both frequency analysis simulations and impedance mismatch modeling.
See the RF Budget Analysis, RF Inspector and Impedance Mismatch Modeling sections for details.
LIN_F/LIN_F2 Versus LIN_S
The LIN_F,LIN_F2 and LIN_S blocks are all used to model frequency-dependent S-parameter based linearities. The
difference between the blocks depends on where the S-parameter data comes from.
The following summarizes when to use which block:
If the S parameter data is:

Use:

S parameters from a Microwave Office schematic

LIN_S - You can drag Microwave Office circuits from the
Subcircuits > LIN_S category of the Elements Browser.

Touchstone format

LIN_S - import the data as S-parameter data into the Data
Files node of the Project Browser. You can drag the
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If the S parameter data is:

Use:
Touchstone circuit from the Subcircuits > LIN_S category
of the Elements Browser.

Frequency response data corresponding to S, Y or Z
parameters.

LIN_F or LIN_F2 - convert the data to Text Data File format
and import it into the Project Browser Data Files node.

2.1.2. Amplifiers
The amplifiers group consists of the following one-input one-output nonlinear amplifiers:
Block

Description

AMP_B

Behavioral Amplifier

AMP_B2

Behavioral Amplifier, 2nd Generation

AMP_BV

Behavioral Amplifier, Voltage Based

AMP_EQN

Equation-based Nonlinear Amplifier

AMP_F

Frequency Dependent Behavioral Amplifier, File-based

NL_MDIF

MDIF File Based Nonlinear Behavioral Model

NL_S

Nonlinear Behavioral Model (Simulation-Based)

VGA_F

Nonlinear Variable Gain Amplifier, File-based

These blocks are all found within the RF Blocks > Amplifiers category. There are other blocks within that category, such
as LOGAMP and VGA_L. However, those blocks are currently not part of the amplifiers group.
The blocks in the amplifiers group support both frequency analysis simulations and impedance mismatch modeling. See
the RF Budget Analysis, RF Inspector and Impedance Mismatch Modeling sections for details.
The following summarizes when to use which block:
If you have:

Use:

General amplifier characteristics such as P1dB and IP3

AMP_B2, or AMP_B if characteristics are power based,
AMP_BV if characteristics are voltage based. AMP_B2
contains temperature-dependent support.

Frequency dependent amplifier characteristics such as P1dB AMP_F - AMP_ F is a very flexible form of AMP_B and
and IP3, or a combination of voltage and power based
AMP_BV, with a variety of ways to enter the characteristics.
characteristics
A Microwave Office nonlinear circuit

NL_S - Allowed Microwave Office schematics can be
dragged from the Subcircuits > NL_S category of the
Elements Browser.

Measured nonlinear characterization data such as
AM/AM-AM/PM or IM products from measurements or
other simulators

AMP_F - Create a Text Data File node in the Data Files node
of the Project Browser and enter the characteristics. See
AMP_F for format details.

2.1.3. Mixers
The mixer group consists of the following mixer blocks:
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Block

Description

MIXER_B

Behavioral Mixer

MIXER_B2

Behavioral Mixer, 2nd Generation

MIXER_F

File-based Behavioral Mixer

MIXER_S

Simulation-based Behavioral Mixer

The blocks in the mixers group support both frequency analysis simulations and impedance mismatch modeling. See the
RF Budget Analysis, RF Inspector and Impedance Mismatch Modeling sections for details.
The following summarizes when to use which block:
If you:

Use:

Do not have spur information, but may have gain conversion MIXER_B2 or MIXER_B - A spur table for a double
and IP3
balanced diode mixer is generated. MIXER_B2 contains
temperature-dependent support.
Have spur table information for the mixer

MIXER_F - Create a Text Data File node in the Data Files
node of the Project Browser and enter the spur table. See
the online help for MIXER_F for format details.

Have a Microwave Office mixer design you wish to include MIXER_S - Allowed Microwave Office schematics can be
in an VSS software simulation (the Microwave Office
dragged from the Subcircuits > MIXER_S category of the
schematic must contain at least one power sweep with a Elements Browser.
minimum of 3 values)

2.1.4. Miscellaneous Blocks
The miscellaneous group includes the following blocks:
Block

Description

FMULT_B

Behavioral Frequency Multiplier

FMULT_B2

Behavioral Frequency Multiplier, 2nd Generation

LOAD

Grounded Resistor

OSC_S

Oscillator with Optional Phase Noise Effects
(Simulation-Based)

RF_END

End of RF Signal

RFBPATH

RF Budget Path Cost

RN

Resistor Noise Source

TONE

Tone(s) Source

TP

Test Point

VN

Voltage Noise Source

VNA

Vector Network Analyzer

VSA

Vector Signal Analyzer (Complex Envelope)

NOTE: The TP block is found in the Meters category, while the VNA and VSA blocks are found in the Meters > Network
Analyzers category. The other blocks are in sub-categories of the RF Blocks category.
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For impedance mismatch purposes, TP, VNA, and VSA can all be configured as either a voltage probe with infinite
impedance or as a termination.

2.1.5. Working with Non-RF Blocks
In many instances you can incorporate signals that are not generated by RF blocks within Time Domain RF and RF
Budget Analysis simulations. You can also use the IQ and OFDM based modulated signal sources and transmitters in
RF Inspector simulations. The modulated signal support in RF Inspector is described fully in the Modulated Signals
section.
To use non-RF signals within a Time Domain RF or RF Budget Analysis simulation add either an RF_START block or
a RF_START_NS block between the non-RF signal and the first RF block. The signal must be either complex or real.
If further processing is required after the RF link add an RF_END block after the last RF block. RF_START,
RF_START_NS, and RF_END are found in the RF Blocks > Impedance Mismatch category.
RF_START/RF_START_NS can be considered as representing the port of a signal generator, with any block before
RF_START/RF_START_NS internal to the signal generator and the signal coming out of RF_START/RF_START_NS
the generated analog RF signal. Likewise, RF_END can be considered as representing the port of a network analyzer or
other measurement device. Any block after RF_END is internal to the measuring device.
RF_START primarily provides impedance mismatch support. This includes the ability to specify S22 and the characteristic
impedance of the output.
RF_START_NS is similar to RF_START except that it includes an internal noise source. This is useful for adding thermal
noise to the signal, such as noise at 290 K. Non-RF signals typically do not have noise unless noise is added with a
channel block.
RF_END lets you specify a frequency dependent load to be seen by the preceding RF block. The output of RF_END is
the total voltage seen at its input.

2.2. RF Budget Analysis
The RF Budget Analysis (RFB) simulator is an VSS frequency domain simulator typically used to perform cascaded
measurements such as cascaded gain and noise figure. RFB is invoked by the RF Budget Analysis measurements in the
System > RF Budget Analysis measurement category. These measurements include Cascaded Noise Factor/Figure C_NF,
Cascaded IP3 C_IP3, and Cascaded Headroom C_HDRM.
RFB simulations are performed on a per frequency basis and can be thought of as measuring the response of the RF link
to a CW signal at each frequency of interest. The CW signal has the same power as the source. For a multi-tone source,
the total power is used. Each frequency yields a separate simulation solution.
NOTE: Only CW RF sources directly support RFB simulations. These sources are the TONE, OSC_S, and VNA blocks.
Non-RF analog signals may also be used provided an RF_START or RF_START_NS block is inserted between the
non-RF signal and the first RF block. The starting point of the measurement must be after the RF_START/RF_START_NS
block. The RF_START/RF_START_NS block appears to the RFB simulation as a CW RF source whose frequency is
the center frequency of the input signal and whose power is the propagated signal power of the input signal.

2.2.1. Simulation Frequencies
The simulation frequencies are determined using a set of frequency offsets. These offsets are added to a base frequency,
which is in most cases the center frequency. For single frequency TONE blocks, the center frequency is often the frequency
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of the tone. The TONE blocks can also be configured to explicitly use the frequency of the tone for cases where the
center frequency cannot be set to the tone's frequency.
By default there is a single offset frequency whose value is 0, so the RFB simulations are typically performed at the
center frequency. When there is only one frequency, the default measurement behavior is to plot the measurement value
at each block's output along the y-axis and the block itself along the x-axis.
Gain and NF
30

20

DB(C_GP(TP.Input,TP.Output,1,0,0))[1]
SystemDiagram1
DB(C_NF(TP.Input,TP.Output,0,1,0,0))[1]
SystemDiagram1

10

0

-10

AMP_B (A2)

BPFC (F1)

MIXER_B (A3)

BPFC (F2)

AMP_B (A5)

Figure 2.1. Cascaded measurements.
To configure swept frequency simulations, which are used when plotting frequency along the x-axis, you must add
additional frequency offsets using the Basic tab on the System Simulator Options dialog box. When there is more than
one frequency offset, the default measurement behavior is to plot the measurement value at the end test point along the
y-axis and the simulation frequencies along the x-axis.
If there are multiple RFB sources (for example, TONE or RF_START/RF_START_NS blocks), separate simulation
solutions are computed for each source using the set of frequency offsets applied to the base frequency for the source.
When a solution is being computed for a particular source, the signals from the other sources are used as-is, without
frequency offsets applied.
Simulation solutions follow the signal from the active source as it progresses through the RF link. The simulation
frequency shifts as the signal passes through RF mixers and RF frequency multipliers. Note that the frequency is always
maintained to be non-negative. This may result in a graph that folds over at DC when the signal passes through a
downconverting mixer.
For example, supposed you have a TONE source as the RF input to a downconverting mixer. The LO of the mixer is 10
GHz. If the TONE source's FREQ parameter is set to 9.1 GHz and the frequency offsets are set to 0, 0.5, 1, 1.5, 2, 2.5,
and 3 GHz, the simulation frequencies are:
RF
9.1
9.6
10.1
10.6

IF
0.9
0.4
0.1
0.6

GHz
GHz
GHz
GHz
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11.1
11.6
12.1

1.1 GHz
1.6 GHz
2.1 GHz

If you plot Gain versus IF frequency, the graph displays similar to the following (with appropriate gain values for your
simulation):
Gain vs IF Freq

p1

4
3.5
3
2.5

DB(C_GP(TP.Input,TP.Output,1,0,0))
System Diagram 1

2
1.5

p1: Power Gain, Cumulative, dB
1
0.1

0.6

1.1
Frequency (GHz)

1.6

2.1

Figure 2.2. Folded frequencies of signal passing through downconverting mixer.

2.2.2. Computed Values
RF Budget Analysis simulations are frequency domain circuit simulations. Linear RF blocks are characterized by Y
matrices. Nonlinear RF blocks utilize 5th order polynomial transfer functions. The primary results of the circuit simulations
are voltages and currents at each RF node for the given input and load conditions.
Each simulation solution consists of several circuit simulations. The different circuit simulations are used to obtain
different responses. The following table summarizes the different types:
Response

Description
a

1 Tone Signal

Stimulus is a single tone at the simulation frequency. The output of a nonlinear block is
the fundamental.

2 Tone Signal for IM 3a

Stimulus is an ideal two-tone signal, with the power of each tone 1/2 the total power of
the signal at the source. The two tones are ideal in that they are infinitely close together
in frequency. This is used by nonlinear blocks to generate the IM3 products.

2 Tone Signal for IM 2a

Stimulus is a two-tone signal. If the source is a two-tone signal, then the two-tone stimulus
is the same as the two-tone signal. If the source is not a two-tone signal, the two-tone
stimulus consists of two tones separated by 1/2 the data rate (sampling frequency /
oversampling rate), and each tone has power 1/2 the total signal power. This is used by
nonlinear blocks to generate the IM2 products.
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Response

Description
a

IM 2 Response

The (1,-1) IM 2 level at each node. The IM 2 is computed at an absolute frequency of
either 1/2 the data rate (sampling frequency / oversampling rate) or, if the source is a
two-tone source, the difference between the two frequencies.

IM 3 Responsea

The (2,-1) IM 3 level at each node.
a

Linear Response

Stimulus is a single tone at the simulation frequency. The output of a nonlinear block is
the input with only the linear gain applied.

1 Tone ± 10 Hz Signal

Used for group delay measurements to compute the phase derivative. Two single tone
circuit simulations are performed, one 10 Hz below the simulation frequency, the other
10 Hz above the simulation frequency.

Impedances

A single tone stimulus is generated at sources and terminations as necessary to compute
the impedances looking into the RF ports of blocks.

RMS Thermal Noise Voltage This simulation uses noise correlation matrices to solve for the RMS thermal noise voltages
over 1 Hz at the output of each RF node.
Phase Noise dBc

Values for phase noise in dBc are computed at each phase noise frequency offset from
the simulation frequency. Phase noise modeling is covered in the Phase Noise in RF
Budget Analysis section of Chapter 3.

a

The voltage, current and power values for these responses can be viewed directly using the Node Voltage (V_node), Node Current (I_node) and Node
Power (P_node) measurements.

2.2.3. Measurement Output
Most of the RF Budget Analysis measurements are capable of displaying their output values in either cascaded format
or frequency format.
In cascaded format the measurement values at each block from the start test point to the end test point are displayed,
with the blocks displayed at the bottom of graphs or in the left column of tables. Many measurements also support
displaying the values as measured between the start test point and the output of the current block, or as the contribution
of the block, which is measured from the input port to the output port of the block. The Block Output setting controls
this.
Frequency format displays the overall output of the measurement along the y-axis and the simulation frequencies along
the x-axis. Frequency format is selected by setting the Sweep Freq setting to "Use for x-axis". Cascaded format is used
when any other setting is chosen for Sweep Freq.
Once a measurement displays output, you can click and hold a data point of a measurement in a graph to view details
about the data point. For example, for the Cascaded Noise Figure measurement C_NF the input noise temperature, power
gain, input noise PSD and output noise PSD are displayed. Similar information is also available for measurements
displayed in a table. In this case select the row in the table then hold the cursor over the item in the row.

2.2.4. Nonlinear Modeling
RF Budget Analysis treats nonlinear RF blocks as internal sources that are dependent upon the inputs to the blocks. The
source voltages are computed using 5th order polynomial approximations of the nonlinear block. A small signal polynomial
is obtained from each nonlinear RF block for the simulation frequency and the signal level at the input port.
For the one-tone response, the output is the output fundamental for a single tone input, which is given by:

V 1Tone, Out = a1 · V 1Tone, In + 34 · a3 · V 1Tone, In3 +
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· a5 · V 1Tone, In5

(2.1)
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For the two-tone response, the available outputs are the two output fundamentals, the (1,-1) IM 2 product, and the (2,-1)
IM 3 product.
The two-tone output fundamental is given by:

V 2tone,Out = a1 · V 2tone,In + 94 · a3 · V 2tone,In2 · V 2tone,In* +

100
16

· a5 · V 2tone,In3 · (V 2tone,In*)

2

(2.2)

where V2tone, In and V2tone, Out are the input and output voltages of one of the fundamentals for the two-tone signal (the
fundamentals have the same amplitude).
The (1,-1) IM 2 product is given by:

V IM2,Out = a2 · V 2tone,In · V 2tone,In* +

24
8

2

· a4 · V 2tone,In2 · (V 2tone,In*) + Amp(V IM2,In)

(2.3)

The (2,-1) IM 3 product is given by:

V IM3,Out = 34 · a3 · V 2tone,In2 · V 2tone,In* +

50
16

2

· a5 · V 2tone,In3 · (V 2tone,In*) + Amp(V IM3,In)

(2.4)

The Amp() function represents the IM product at the input passing through the nonlinearity, and is Equation 2.1. When
the IM product at the input is very small, which is usually the case, the Amp() function simply applies the linear gain of
the amplifier to the IM product.
Because only a limited number of output products are tracked, cascaded nonlinearities do not include all intermodulation
effects. For example, suppose the input signal is two tones at 1 MHz and 1.1 MHz. If the signal passes through an
amplifier with 2nd and 3rd order nonlinearities, the output consists of the following frequencies:
Frequency, MHz

Source Frequencies

0

1.0 - 1.0 and 1.1-1.1

0.1

|1.1 - 1.0|

0.9

2*1.0 - 1.1

1.0

1.0

1.1

1.1

1.2

2*1.1 - 1.0

3.0

3*1.0

3.1

2*1.0 + 1.1

3.2

1.0 + 2*1.1

3.3

3*1.1

If the output then passes through another amplifier with 2nd and 3rd order nonlinearities, the various frequencies interact
with each other. Some of these interactions affect the fundamental, IM 2 and IM 3 outputs. For example, the 2nd order
interaction between the 0.1 MHz output from the first amplifier (the result of the (1,-1) IM 2 product) and the 1.0 MHz
fundamental generate output at 0.9 MHz (1,-1) and 1.1 MHz (1,1), affecting the IM 3 and fundamental output of the
second amplifier.
In an RF Budget Analysis simulation, the amplifiers only consider the two-tone fundamental, IM 2 and IM 3 inputs. In
addition, the amplifiers do not account for any interactions between the IM 2, IM 3 and two-tone fundamental inputs
when computing the output IM 2 and IM 3.
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However, in most cases the fundamentals at the input to a cascaded amplifier are much larger than all the other products.
In these situations the interactions between the two fundamentals is much larger than any other interactions, and ignoring
those other interactions has a negligible effect on the final measurements.
Saturation Effects
Similar limitations apply when saturation effects are modeled above P1dB. The shaping of the input signal towards a
square wave generates odd order products. These products are for the most part accounted for within the amplifier, but
the products at the output of amplifier are not passed on to the next block.
Details on the saturation model itself may be found in the documentation of the Behavioral Amplifier AMP_B.
NOTE: The RF Budget Analysis measurements that utilize power, such as P_node and SPWR_node, display fundamental
power, not total power. Fundamental power is used because RF Budget Analysis simulations only model the one and
two-tone fundamentals, and the IM 2 and IM 3 products. The fundamental power of a one-tone input at saturation is
about 0.87 dB less than the total power when the saturated output is a square wave.
S12 Limitations
The voltage and current at the input port of a nonlinear block with S12 specified may not be accurate if there is impedance
mismatch at the input port. This is due to how nonlinear blocks must synthesize the S12 voltage contribution. If the
impedances at the input port are matched, the S12 contribution is accounted for properly. However, if the impedances
at the input port are not matched, then the S12 contribution may not properly reflect the mismatch.

2.2.5. Thermal Noise Modeling
RF Budget Analysis simulations model thermal noise by computing the RMS thermal noise voltage over 1 Hz (Vn) at
each output port of the RF link. The computed Vn at a node only represents the noise from the output port, it does not
include noise contributions from the input ports connected to the node.
The simulation relies upon noise correlation matrix techniques as discussed in 1
Because the simulation is interested in the total noise at the output ports, noise sources are added at all RF sources and
resistive terminations upstream from a given output port.
For mixers, the noise generated by the mixer is composed of several components: the noise from the RF and image
frequencies at the mixer's RF input, feed-through noise at the RF and LO inputs, and internally generated noise. To model
all these sources, the simulation treats the mixer's output port as a noise source and its input ports as terminations. The
simulation performs noise computations at the RF, image, IF and LO frequencies in order to obtain the various contributions
at the input ports. The mixer then uses these noise voltages along with internally generated noise to compute a noise
correlation matrix representing the noise at the IF or output frequency.
More information on VSS noise modeling may be found in the Noise Modeling chapter.

2.2.6. Phase Noise Modeling
RF Budget Analysis simulations model phase noise at the frequency offsets specified in the phase noise sources. Phase
noise is modeled as dBc values at each frequency offset for each simulation frequency. The phase noise values for a
simulation frequency remain fixed until they reach a block that performs a frequency translation on the simulation
frequency, such as mixers or frequency multipliers, or they encounter a phase noise source.

1

S. A. Maas, Noise in Linear and Nonlinear Circuits, Norwood, MA: Artech House, 2005.
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More information on VSS noise modeling may be found in the Noise Modeling chapter.

2.2.7. Additional Information
See VSS Modeling Hints and Tips for useful tips for RF Budget Analysis simulations.

2.3. RF Inspector
RF Inspector is an VSS software frequency domain tool that lets you inspect frequency content anywhere along an RF
link. With RF Inspector you can:
• Determine the various contributors to the frequency content.
• Identify the path of the contributors.
• Examine the voltage, current and power of each contributor.
• Classify the contributors as signal of interest, distortion or interference.
RF Inspector uses the RF Inspector simulator (RFI) invoked by using any of the measurements in the System > RF Inspector
measurement category.
The most commonly used measurements are the power and voltage spectrum measurements:
• RFI Power Spectrum (RFI_PWR_SPEC)
• RFI Voltage Spectrum (RFI_V_SPEC)
These measurements display the power and voltage spectrum graphs, respectively. With these graphs you can select
individual spectral components for further inspection. By pressing and holding the mouse button down on a spectral
component, you can view summary information about the selected component:

Figure 2.3. Summary Information in RF Inspector
This figure shows the summary information presented when the 3.1 GHz tone in the Chain Spectrum graph of the VSS
software example project RFI_Chain.emp is selected. The information indicates that the tone has a power level of -3.19
dBm, of which -3.06 dBm is from a 3.1 GHz tone passing linearly through AMP_B.A2, and -39.4 dBm is from IM
products falling at 3.1 GHz generated by AMP_B.A2. The "IM n(x,y)" items indicate some of the types of IM products,
in this case a second-order, several third-order, and several fifth-order IM products contributed.

2.3.1. Indicating IM Products
RF Inspector indicates individual IM products using the form "IM n(x, y)". The 'n' indicates the overall order of the IM
product, while the 'x' and 'y' terms indicate the order of the individual tones of the IM product. For example, take a two
tone signal composed of the two sinusoids A·cos(2π·fa·t) and B·cos(2π·fb·t). If that two tone signal is raised to the 3rd
power, it will result in a signal of the following form:
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3 ⋅ A3 + 6 ⋅ A ⋅ B2
4

⋅ cos(2π ⋅ f a ⋅ t) +

6 ⋅ A2 ⋅ B + 3 ⋅ B3
4

3

+ A4 ⋅ cos(2π ⋅ 3 ⋅ f a ⋅ t) +
+3
+3

⋅ A2 ⋅ B
4

⋅ A2 ⋅ B
4

⋅ cos(2π ⋅ (2 ⋅ f a + f b) ⋅ t) +

⋅ cos(2π ⋅ (2 ⋅ f a − f b) ⋅ t) +

B3
4

⋅ cos(2π ⋅ f b ⋅ t)

⋅ cos(2π ⋅ 3 ⋅ f b ⋅ t)

3 ⋅ A ⋅ B2
4

3 ⋅ A ⋅ B2
4

⋅ cos(2π ⋅ ( f a + 2 ⋅ f b) ⋅ t)

(2.5)

⋅ cos(2π ⋅ ( − f a + 2 ⋅ f b) ⋅ t)

There are a total of 8 tones, with frequencies fa, fb, 3·fa, 3·fb, 2·fa + fb, fa + 2·fb, 2·fa - fb, and - fa + 2·fb.
RF Inspector would then indicate each of the tones using:
Tone

Indicator

fa

IM 3(1, 0)

fb

IM 3(0, 1)

3·fa

IM 3(3, 0)

3·fb

IM 3(0, 3)

2·fa + fb

IM 3(2, 1)

fa + 2·fb

IM 3(1, 2)

2·fa - fb

IM 3(2, -1)

-fa + 2·fb

IM 3(-1, 2)

2.3.2. RF Inspector Dialog Box
Double-clicking a tone in an RF Inspector spectrum measurement displays the RF Inspector dialog box for the measurement
data. The dialog box contains detailed information about the content of the selected spectrum component:
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Figure 2.4. RF Inspector Signal Heritage Tab
The RF Inspector dialog box contains several sections. At the very top are controls for selecting different spectral
components and for filtering the results shown in the Heritage window.
lists the different spectral components available for inspection in the window. Selecting a different
component updates the Details section and Heritage window appropriately.
Content to Inspect

Display Floor lets you set a minimum threshold for the contributors displayed in the Heritage window. This is useful when

the signal passes through several nonlinearities, as often there are a large number of contributors with very small values
compared to the overall signal and these contributors can be ignored.
Details Section

Figure 2.5. Details Section with an IM Product of a Tone Selected
The Details section provides detailed information on the item selected in the Heritage window. In Figure 2.5, the -42.6
dBm IM 3 (1,0) product is selected. The upper portion of the section displays component details such as power, voltage
and current information for the contribution.
The lower portion identifies (when the information is available) the equation responsible for the contribution.
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In this case two tones are raised to the 3rd order. Raising two tones A·cos(a) and B·cos(b), where a = 2π·fa·t and b =
2π·fb·t, to the 3rd order (A·cos(a) + B·cos(b))3 results in the following:

( A ⋅ cos(a))3 + 3 ⋅ ( A ⋅ cos(a)2 ⋅ (B ⋅ cos(b)) + 3 ⋅ ( A ⋅ cos(a)) ⋅ (B ⋅ cos(b))2 + (B ⋅ cos(b))3(2.6)
The lower portion of the Details section indicates that this contribution is due to the (A·cos(a))·(B·cos(b))2 product, which
expands to:

3 ⋅ A ⋅ B2 ⋅ cos(a) + 3 ⋅ A ⋅ B2 ⋅ cos(a + 2 ⋅ b) + 3 ⋅ A ⋅ B2 ⋅ cos(a − 2 ⋅ b)
2
4
4

(2.7)

This particular contribution is from the 3/2·A·B2·cos(a) term of (Equation 2.7).
The two tones for this particular contribution can be viewed by opening the -42.6 dBm IM 3 (1,0) item in the Heritage
window:

Figure 2.6. Tones contributing to -42.6 dBm IM 3(1,0)
Here the two tones are from four sources: -63.5 dBm and -13 dBm tones at 3 GHz and -63.2 dBm and -12.8 dBm tones
at 3.1 GHz.
You can copy to the Clipboard the contents of each portion of the Details section. You can right-click the text in the
section and choose Select All, and then right-click again and choose Copy. You can also directly select the text, then
right-click and choose Copy. The third method is to right-click in the Heritage window and choose Copy > Component
Details or Coefficient Details.
Heritage Window
The lower section of the RF Inspector dialog box is used to browse the heritage of the selected spectral component. You
can trace the various contributors all the way back to their sources.
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Figure 2.7. Tracing contributions back to source
Figure 2.7 illustrates the path back to several of the sources contributing to the -116 dBm 400 MHz tone. Figure 2.8
shows the system diagram used to generate the signal. Note that this diagram is not intended to necessarily represent the
layout of an actual receiver, but is designed to illustrates features of the Heritage window.
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TONE
ID=A1
FRQ=10 GHz
PWR=-100 dBm
PHS=0 Deg
TN=_TAMB DegK

TP
ID=Input

1

TONE
ID=A3
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PWR=-40 dBm
PHS=0 Deg
TN=_TAMB DegK

AMP_B
ID=A6
GAIN=20 dB
P1DB=10 dBm
IP3=
IP2=
OPSAT=
NF=3 dB

AMP_B
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IP3=
IP2=
OPSAT=
NF=1.2 dB

BPFB
ID=F1
LOSS=0.5 dB
N=5
FP1=9.5 GHz
FP2=10.5 GHz
AP=3.01 dB
NOISE=Auto

CIRCULATOR
ID=S1
LOSS=3 dB
ISOL=30 dB
VSWR=1
NOISE=Auto
Z=_Z0 Ohm

IN

2

3

BPFC
ID=F2
LOSS=0.5 dB
N=5
FP1=3.5 GHz
FP2=4.5 GHz
AP=0.1 dB
NOISE=Auto

TONE
ID=A5
FRQ=14 GHz
PWR=10 dBm
PHS=0 Deg
TN=_TAMB DegK

MIXER_ B
ID=A7
MODE=DIFF
GCONV=-10 dB
P1DB=10 dBm
IP3=30 dBm
LO2OUT=-25 dB
IN2OUT=-20 dB
LO2IN=-25 dB
OUT2IN=-25 dB
NF=10 dB

IN

TONE
ID=A8
FRQ=4.4 GHz
PWR=10 dBm
PHS=0 Deg
TN=_TAMB DegK

MIXER_ B
ID=A4
MODE=DIFF
GCONV=-10 dB
P1DB=10 dBm
IP3=30 dBm
LO2OUT=-25 dB
IN2OUT=-20 dBM_PROBE
LO2IN=-25 dB ID=MP1
OUT2IN=-25 dB
NF=10 dB

LPFB
ID=F3
LOSS=0.5 dB
N=5
FP=0.6 GHz
NOISE=Auto

OUT

LO

TP
ID=Output
LOAD
ID=S2
Z=_Z0 Ohm

OUT

LO

Figure 2.8. Example double-down conversion receiver with interferer
In Figure 2.7 the highlighted item "-116 dBm LPFB.F3@2 [MIXER_B.A7@2: RF2IF 400 MHz]" refers to a
-116 dBm tone coming from port 2 of block LPFB.F3, which is the last filter in the system diagram. Since we are
examining the 400 MHz tone, this tone is at 400 MHz.
The text in brackets, "[MIXER_B.A7@2: RF2IF 400 MHz]", indicates the source of that signal relative to LPFB.F3.
In this case, it is a 400 MHz tone generated at port 2 of the mixer MIXER_B.A7. This tone is part of the (1,-1) RF to IF
downconversion, as indicated by "RF2IF".
The next item, "-115 dBm MIXER_B.A7@2: RF2IF 400 MHz", tells you that the contribution at the output of
the mixer is -115 dBm.
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The next two items identify how the mixer generated this particular -115 dBm tone at 400 MHz. The first item identifies
the LO, which is a 10 dBm tone at 4.4 GHz generated by TONE.A8. The second item identifies the RF input, which is
a -103 dBm tone at 4 GHz coming from port 2 of BPFC.F2.
Each nested level of items represents the contributors to the item above.
Skipping to the item "-103 dBm AMP_B.A6@2: IM 4 GHz" we see contributions from the nonlinear amplifier
AMP_B.A6. This line indicates that this amplifier is generating a -103 dBm tone at 4 GHz that is due to IM products.
The items at the next nested level, such as "-109 dBm IM 3 (1,0)", "-115 dBm IM 3 (1,-2)" and "-119
dBm IM 2 (1,-1)", identify the individual IM products generated by the amplifier for this particular contribution.
The item "-109 dBm IM 3 (1,0)" indicates a -109 dBm 3rd order IM product for two tones with the frequency
multipliers 1 and 0. The term from the 2 tone 3rd order equation is displayed in the Details section when the item is
selected. In this case the following text is displayed:
3*(1/2)*A*B^2*cos(a) term of the 3rd order product: (A*cos(a))*(B*cos(a))^2
If you continue proceeding through the nested items of "-109 dBm IM 3 (1,0)" you see that this particular
contribution comes from TONE.A5 and TONE.A1, where the LO TONE.A5 contributes two ways:
• More strongly as LO to output feed-through at MIXER_B.A4.
• Less strongly as the LO for a mixing product in MIXER_B.A4.
Signal Classification
If you look once again at Figure 2.7, notice that each contributor item has a small icon to its left. The icons indicate the
classification assigned to the contribution by RFI. There are four classifications:
•

Signal: The signal of interest, which is indicated by the Test Point Identifying Signal setting of the measurement.

•

Distortion: IM products, spurs, or any other unwanted contributions that is in any part generated by the Signal.

•

Interference: Any contribution that is not Signal, Distortion or LO.

•

LO: The LO input to a mixer.

Each RF Inspector measurement lets you select which classifications are to be included in the measurement's output. For
the spectrum measurements, selecting multiple classifications displays a separate trace for each classification.
The Signal (signal of interest) consists of all the spectral components found at the point indicated by the Test Point
Identifying Signal setting of the measurement that have only been through linear transformations. For example, if the
setting points to a location after a combiner, the Signal includes signals from all the inputs of the combiner.
When considering Signals, the spectral components passing through mixers are further restricted to only those products
that match the conversion indicated by the MODE parameter of the mixer. For example, if the MODE parameter is set
to "SUM", then only the spectral components generated by the (1,1) conversion may be considered a Signal. Likewise,
if MODE is set to "DIFF" then only the spectral components generated by the (1,-1) conversion may be considered a
Signal.
Note that any potential Signal that is not classified as a Signal is classified as Interference. Using a combiner as any
example once again, if the Test Point Identifying Signal setting points to a location on one of the inputs of a combiner, the
spectral components on the other inputs that could potentially be classified as Signals are considered Interference.
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RF Inspector tracks spectral components as they pass through the various blocks of the RF link. Spectral components
that pass through linear blocks, the linear portion of nonlinear amplifiers, or the conversion indicated by the MODE
parameter of mixers retain their classification.
The IM products generated by nonlinear amplifiers and the spurs and feed-throughs generated by mixers are classified
as either Distortion or Interference. Spectral components are classified as Distortion if any of the contributions responsible
for the product is classified as Signal or Distortion. All other spectral components are classified as Interference.
Simply put, if the Signal is turned off, the Signal and Distortion disappear, while the Interference remains.
The LO classification is used to quickly distinguish the LO item from the input item when viewing the contributors of
a mixer.
Other Features
At each level of nesting the items are listed in order of decreasing value for the measurements. For RFI_PWR_SPEC it
is decreasing power, for RFI_V_SPEC it is decreasing voltage magnitude.
Selecting items in the Heritage window highlights and centers the item's block in the corresponding system diagram.
Selecting an item in the Heritage window then right-clicking it displays a menu with the following options:
Next Frequency, Previous Frequency:

Advance to the next or previous frequency in the Content to Inspect control at the

top of the inspector page.
Copy > Item:

Copies the text of the selected item to the clipboard.

Copy > Branch:

Copies the text of the selected item and all items nested within it to the clipboard.

Copy > All Items:

Copies all the items to the clipboard.

Copy > Component Details:

Copies the text of the Component Details portion of the Details section to the clipboard.

Copy > Coefficient Details:

Copies the text of the Coefficient Details portion of the Details section to the clipboard. This
is grayed out if nothing is displayed in that portion.
Expand Branch:
Collapse:

Opens up all the nested items within the selected item, including items nested within those items.

Collapses the nested items of the selected item, hiding them from view.

Note that the Copy > Branch, Copy > All Items, and Expand Branch commands may take a significant amount of time
depending on the number of nested items. If it takes more than approximately 10 seconds to complete the command a
dialog box displays to allow you to cancel the command. The dialog box redisplays every 10 seconds to give you the
opportunity to cancel once again.
When an item is copied to the clipboard, the classification is included as prefix text: SIG for Signal, DIS for Distortion,
INT for Interference and LO for LO.

2.3.3. Modulated Signals
RF Inspector supports modulated signals that are based on the I/Q Modulator block IQ_MOD and the OFDM Modulator
block OFDM_MOD. The following are the supported blocks:
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Block

Description

BPSK_SRC

BPSK Modulated Signal

BPSK_TX

BPSK Transmitter

IQ_MOD

I/Q Modulator

MPSK_SRC

MPSK Modulated Signal

MPSK_TX

MPSK Transmitter

MSK_SRC

MSK Modulated Signal

MSK_TX

MSK Transmitter

OFDM_MOD

OFDM Modulator

OQPSK_SRC

Offset QPSK Modulated Signal

OQPSK_TX

Offset QPSK Transmitter

PAM_SRC

PAM Modulated Signal

PAM_TX

PAM Transmitter

PQPSK_SRC

Pi/4 Modulated Signal

PQPSK_TX

Pi/4 Transmitter

QAM_SRC

QAM Modulated Signal

QAM_TX

QAM Transmitter

QPSK_SRC

QPSK Modulated Signal

QPSK_TX

QPSK Transmitter

These blocks are all found within the Modulation category. There are other source and transmitter blocks within that
category, such as AM_MOD, FM_MOD and FSK_SRC. However, those blocks do not currently support RF modeling.
Because RF Inspector utilizes a frequency domain simulator, only an approximation of the spectral shape of the modulated
signal is possible. Since RF Inspector's primary task is to be able to identify contributors to spectral content throughout
an RF link, the modeled signal is band limited - the side lobes are not modeled. This can be seen in Figure 2.9 and
Figure 2.10.
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QAM Signal
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Figure 2.9. Time Domain versus RF Inspector measurements of a QAM Signal
In Figure 2.9 the red curve shows a QAM signal modeled by RFI. The blue curve is the signal measured in the time
domain with the PWR_SPEC measurement. The QAM signal was generated by the QAM Modulated Source block
QAM_SRC with a data rate of 0.1 GHz, center frequency of 10 GHz, and root raised cosine pulse shaping with alpha of
0.35. Both measurements are displaying power spectral density (PSD) in dBm/Hz.
In Figure 2.10 the red curve shows an OFDM signal modeled by RFI while the blue curve is the Time Domain
measurement. The OFDM signal was generated using 256 subcarriers, subcarrier spacing of 0.1/256 GHz, and a guard
interval of 1/8. No windowing was applied.
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Figure 2.10. Time Domain versus RF Inspector measurements of an OFDM signal
For IQ based modulated signals, RFI uses six frequency points to represent the power distribution within the main lobe.
In Figure 2.11 f1 through f6 represent the six frequency points. PSD1 through PSD6 are the power spectral density values
assigned to the six frequency points. The profile is symmetric, so PSD4=PSD3, PSD5=PSD2, PSD6=PSD1, f6-f5=f2-f1
and f5-f4=f3-f2.
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The PSD values are computed such that the total power in the profile:
5

PT =

∑ PSD[i] + 2PSD[i + 1] ⋅ ( f [i + 2] − f [i])

(2.8)

i=1

is the total power of the modulated signal. This includes power in the sidelobes.
To simplify the simulation, the same profile is used for all IQ based modulated signals, regardless of the symbol mapping
(such as PAM, QPSK or QAM) and the pulse shaping. The profile used is based on a QAM signal with root raised cosine
pulse shaping and an alpha of 0.35.
For OFDM based modulated signals, RFI uses a flat two point profile, which is clearly visible in Figure 2.10.
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Figure 2.11. Profile of IQ modulated signals in RF Inspector
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Figure 2.12. QAM signal after 5th order nonlinear amplifier
The IQ and OFDM profiles are maintained as long as the modulated signal remains linear. Once the signal undergoes a
nonlinearity, the profile is reduced to a set of overlapping 'brick wall' segments. This can be seen in Figure 2.12, where
a QAM signal has been passed through a 5th order nonlinear amplifier.
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The segments are stacked, as illustrated in Figure 2.13. The total power of the stacked segments roughly approximates
the total power in the modulated signal at the given harmonic or IM product. This power can give you an idea of the
magnitude of the IM product, but should not be used as an exact measurement of the power, particularly if the signal has
passed through several nonlinearities.

Modulated Signal

‘Brick wall’ segments

Figure 2.13. 'Brick wall' segments
CW and Modulated Signal Display
The RFI_PWR_SPEC measurement displays its values as power spectral density (PSD), or power per Hertz. For CW
signals it simply uses 1 Hz so the power displayed is the same as the power for the signal. For modulated signals the
total power in a brick wall segment is divided by the bandwidth of the segment to obtain the PSD value. The net effect
is RFI_PWR_SPEC measures PSD using an equivalent resolution bandwidth of 1 Hz.
This must be taken into account when comparing RFI and Time Domain power spectrum results for signals that contain
both CW and modulated components. In most cases, the bandwidth of the signal is large enough that a 1Hz RBW is not
practical for the Time Domain measurement.
When measuring the modulated signal components, this is not an issue if the Time Domain measurement is configured
with the Y-Axis Output setting set to "PSD (Pwr/Hz)". The scaling is similar to the RFI measurement.
When measuring CW signals, this is not an issue if the Time Domain measurement is configured with the Y-Axis Output
setting set to "Spectrum Analyzer Spectrum".
However, when displaying a combination of modulated and CW signals (a modulated signal passed through a 2nd or
4th order nonlinearity generates a DC term) this becomes a problem. In this situation either the modulated signals or the
CW signals display with the correct scaling, but not both.
When the Time Domain measurement is set to "PSD (Pwr/Hz)" the CW portion of the signal is usually displayed with
a much lower power level than seen in the RFI measurement. This is because the measurement must use its RBW to
convert power per FFT bin to power per Hertz. The RBW is typically much larger than 1 Hz and CW signals appear
with a much lower power level since the power of the CW signal is divided by the RBW and not 1 Hz.
When the Time Domain measurement is set to "Spectrum Analyzer Spectrum" the modulated signal portion displays
with a much higher power level than seen in the RFI measurement. This is because the power level is not displayed as
PSD, which is the scaling used by the RFI measurement.
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2.3.4. Performance Considerations
To determine the heritage of spectral components, each component generated, whether by a source or a nonlinearity,
must be tracked as it passes through the RF link. For the linear portions of the RF link this is typically not a problem
since for each source component no new components are generated.
Nonlinearities, however, can pose a significant problem, especially if the signal passes through several nonlinearities.
The problem is due to the rapid growth of the number of spectral components generated by a nonlinearity as the number
of input components increases.
Take for example a simple 3rd order nonlinearity with no 2nd order term:

y = a1 ⋅ x + a3 ⋅ x3

(2.9)

A single tone passed into the nonlinearity generates three components for tracking: the linear component, the 3rd order
harmonic, and the IM product that falls on the fundamental:

y = a1 · A · cos(ωt) + a3 · (A · cos(ωt))3

(2.10)

1 3
3
(A · cos(ωt))3 = 3
4 · A · cos(ωt) + 4 · A · cos(ωt)

(2.11)

Two tones passed into the nonlinearity generate nine components for tracking: the linear component and 8 nonlinear
components. The nonlinear components fall on the following frequencies:
(1,0), (0,1), (3,0), (0,3), (2,1), (1,2), (2,-1),
(1,-2)

where each pair of values (m,n) produces the frequency f=|m·fA+n·fB|.
Three tones passing into the 3rd order nonlinearity generate 28 nonlinear components at 14 different frequencies (assuming
the three tones are spaced such that none of their nonlinear products overlap).
The situation is much worse with five tones passing into a 5th order nonlinearity even with no 2nd, 3rd or 4th order
terms: over 75 different frequencies are generated, of which most of those frequencies have multiple components. Add
in the 2nd and 3rd order terms and the number of frequencies quickly expands.
To put the order of the nonlinearities into perspective, a 5th order nonlinearity is required in order to model a nonlinear
amplifier with an |IP3-P1dB|not approximately 10 dB.
RF Inspector supports several techniques for reducing the number of components to be processed. These include ignoring
components below a specified level, ignoring components outside specified frequency ranges, and limiting the total
number of components generated at any given port.
These settings are all configured on the RFI/RFB Settings tab of the System Simulator Options dialog box.
Frequency Settings
These settings set frequency limits on the components.
The Harmonic Band setting is useful for restricting components to only those around the fundamental frequencies. This
is particularly useful in narrowband designs, where frequencies far outside the fundamental are assumed to be severely
attenuated. The default setting is "DC to 2nd harmonic band", which works well for most cases.
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Note that mixers apply the Harmonic Band setting to the input signal prior to frequency shifting by the LO. For example,
in an up-converting mixer, if the input frequency is 1 GHz, the LO frequency is 10 GHz, and "DC to 2nd harmonic band"
is selected, then the input frequency range is DC to 2 GHz, which is then upconverted to the frequency range 10 to 12
GHz.
The Frequency Above Fc and Frequency Below Fc settings provide more control over the frequency band. These settings
are useful when working with mixers as the frequency band shifts as the center frequency shifts passing through the
mixers. By default these settings are disabled.
The Minimum Frequency and Maximum Frequency settings set absolute frequency limits. These set absolute limits on the
frequencies generated - components beyond these limits are ignored. By default these settings are disabled.
The frequency settings are cumulative. Only components that satisfy all the enabled constraints are generated.
Noise Floor
The noise floor settings set a minimum power or voltage level required for components to be generated. Components
that do not satisfy these levels are ignored.
The dB Below Noise setting specifies a level below the ambient noise floor. Note that negative values set the level above
the ambient noise floor. The ambient noise floor is determined by the ambient system temperature, and is approximately
-174 dBm/Hz for the default temperature of 290 K. The default setting is 10 dB.
The Absolute dBm/Hz and Absolute dBVpk/sqrt(Hz) settings let you specify the noise floor in terms of absolute power and
voltage spectral density. These settings are disabled by default.
The noise floor settings are cumulative. The smallest noise floor value computed is used. Note that when determining
the noise floor RFI converts power levels to voltage levels using the characteristic impedance of the output port of the
block.
The noise floor constraint is applied at both at the input and the output ports. Input signals that do not satisfy the input
noise floor are not further processed. Output components that do not satisfy the output noise floor are not generated at
the output port.
Component Limits
The Maximum Harmonic Generated setting lets you globally restrict the orders of the nonlinearity. Nonlinearity orders can
usually be restricted on a block by block basis. For the behavioral amplifiers this can be done by leaving either the P1dB
or IP3 setting blank. For mixers the secondary IMPROD, LOHMAX and INHMAX parameters control the nonlinearity
orders. This setting is disabled by default.
The Maximum Node Components setting allows you to limit the total number of components generated at any output port.
If more components than this limit are generated by the nonlinearity, only the components with the largest voltage levels
are output. This setting is disabled by default.
Simulation Convergence
RF Inspector utilizes an iterative algorithm to handle nonlinearities as explained the How RFI Works section.
The Maximum Iterations setting limits the number of iterations allowed. If the simulation exceeds this number of iterations
the simulation halts and a warning message is reported.
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The Minimum Change in dB setting defines the tolerance used for determining convergence. If the change in voltage levels
for individual components between iterations falls below this level for all components, the simulation is considered
converged and the simulation is completed. This setting replaces the Change in dB in previous versions.

2.3.5. How RFI Works
RF Inspector can be thought of as a system level frequency domain circuit simulator. It solves for voltages and currents
at each RF node for each generated spectral component. For independent CW sources such as the TONE block and for
the supported modulated signal sources, this is a fairly straightforward solution.
For each solution, Y matrices are obtained from all the RF blocks in an RF link and assembled into a global Y matrix
according to the node connectivity. Appropriate terminations are added. The matrix is then solved using the source current
for the particular solution. Voltages at each node and the current flowing into the ports of each block are obtained.
NOTE: In RF Inspector, the distinction between input and output port depends on the direction of the signals being
processed. For example, for an amplifier the nonlinearity is applied in the forward direction. Therefore, when describing
the ports for the nonlinearity, the input port is port 1 of the block while the output port is port 2. On the other hand, when
computing reverse leakage, the input port is port 2 while the output port is port 1.
Nonlinearities are treated as voltage sources that are dependent upon the incident voltage at the input port of the
nonlinearity. Each individual component generated by the nonlinearity is a separate source. The nonlinear dependency
requires the use of an iterative algorithm.
In simplified form the algorithm is:
1. Compute voltages and currents due to independent sources.
2. Compute nonlinear sources based on the components at the corresponding input ports.
3. Compute voltages and currents due to the nonlinear sources.
4. If the change in the voltages and currents satisfy the convergence criteria, stop. Otherwise repeat from step 2.
NOTE: When solving for the node voltages and port currents, the voltage sources are applied in series with an impedance
equal to the characteristic impedance of the output port.

2.3.6. Feedback Loops in RFI
RF Inspector only supports linear feedback loops. All components in the loop must be linear RF blocks, with the exception
of the Negate block NEG, the Phase block PHASE, and the delay blocks DLY_SMP, DLY_SYM and DELAY. Note
that delay blocks are ignored in RFI.
Nonlinear feedback loops, such as feedback control for a VGA_F block are not supported.
Because RFI uses a frequency domain simulator, feedback loop results may differ from Time Domain simulations. This
is most apparent with issues of stability. Consider the linear feedback loop in Figure 2.14. The closed loop gain is
expressed as:

G = 1 +A
A·B

(2.12)
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Figure 2.14. Example Frequency Domain Linear Feedback Loop
In the VSS Time Domain simulator, which is essentially a discrete time simulator and operates in the z-domain, a
minimum of one sample delay must be introduced. The closed loop gain in the z-domain is:

G(z) = z +AA· z· B

(2.13)

In order for the loop to be stable in the z-domain the following must be true:

A·B ≤ 1

(2.14)

However, there is no such restriction in the frequency domain.
Another difference to note when working with feedback loops in Time Domain simulations is the extra delay introduced
by filters due to their implementation as FIR and/or IIR filters.

2.3.7. Additional Notes
Mixers
The mixer model used in RF Inspector differs from the model used in the Time Domain simulator. In Time Domain
simulations mixers are modeled using a nonlinear amplifier followed by a spur generator. The spur generator synthesizes
the spurs that fall within the output sampling frequency band.
In RFI simulations, mixers use a polynomial model to generate the input products. The corresponding LO products are
then applied to obtain the output spurs. There is no nonlinear amplifier to generate the IP3 and P1dB effects. Instead,
these effects are handled by the polynomial applied to the input signal.
The net effect is in RFI simulations IP3 and P1dB directly affect the levels of spurs with 3rd and 5th order input terms,
whereas in Time Domain simulations those spurs are independent of IP3 and P1dB.
Saturation Effects
The modeling of saturation effects in nonlinear amplifiers and mixers in RF Inspector differs from the modeling used in
the Time Domain simulator.
In Time Domain simulations saturation shaping is applied directly to the instantaneous voltage and is a function of that
voltage. The shaping of the input signal is a nonlinear operation, generating additional nonlinear products at the input to
the polynomial model. The Saturation Effects sub-section of the Nonlinear Modeling Issues section describes the Time
Domain saturation model.
RF Inspector does not model the nonlinear products generated by the saturation shaping operation, as the quantity of
generated products would quickly overwhelm the simulator. Instead, RF Inspector applies a saturation scaling to the
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voltage levels of the individual input components. The effect is a decrease in the gains for both the fundamental and
nonlinear products as the signal saturates.
The signal levels therefore tend to differ significantly once saturation effects are applied to the signal. The RFI signal
levels tend to be below the Time Domain levels. Note that saturation effects are only applied after the input signal reaches
the P1dB point.
Details on the saturation model itself may be found in the documentation of the Behavioral Amplifier AMP_B.
S12 Limitations
The voltage and current at the input port of a nonlinear block with S12 specified may not be accurate if there is impedance
mismatch at the input port. This is due to how nonlinear blocks must synthesize the S12 voltage contribution. If the
impedances at the input port are matched, the S12 contribution is accounted for properly. However, if the impedances
at the input port are not matched, then the S12 contribution may not properly reflect the mismatch.
Additional Hints and Tips
See VSS Modeling Hints and Tips for useful tips for RF Inspector simulations.

2.4. Bi-directional RF Blocks
Many of the linear RF blocks, such as antennas, attenuators, splitters, and couplers support bi-directional ports.
Bi-directional ports are ports that may be connected to either input or output ports. This is particularly useful when
working with T/R modules. The following is a simple example of a T/R module subcircuit that can be used in both the
transmit and receive modes.
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Figure 2.15. Simple T/R Module
On the left side PORT_SRC.P1 is connected to the signal to be transmitted. PORT.P2 on the right side is connected to
the antenna. PORT.P3 on the bottom is the received signal. In this example the important bi-directional blocks are the
Circulator CIRCULATOR and PORT.P2. The ports of the circulator may serve as either an input port or an output port,
depending upon what it is connected to. Similarly, PORT.P2 may serve as either a subcircuit input port or a subcircuit
output port when the system diagram is used as a subcircuit, as PORT and PORT_SRC blocks in a system diagram
become bi-directional subcircuit ports of the subcircuit.
The following illustrates the above T/R module subcircuit being used in a full link.
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Figure 2.16. T/R Module in a Full Link
In this system diagram the areas marked Radio Device A and Radio Device B represent two separate but similar radio
devices. Radio Device A has been configured to transmit via the MODE parameter of its TR Module subcircuit,
SUBCKT.S1, while Radio Device B has been configured to receive via the MODE parameter of its TR Module subcircuit,
SUBCKT.S4.
Because the circulator block within the T/R module subcircuit has bi-directional ports, the T/R module subcircuit's
antenna port can be connected to an antenna that is transmitting, as in Radio Device A, or to an antenna that is receiving,
as in Radio Device B. Note that the ANTENNA block also has bi-directional ports.
Without bi-directional ports, to create something equivalent to the above you would need to create separate T/R modules
for the transmit and receive modes. Bi-directional ports allow you to use the same subcircuit for both signal directions.
You can determine whether a bi-directional port is being treated as an input port or an output port by using the BPORT_DIR
annotation.
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In most cases, blocks that support 2 and only bi-directional ports automatically (for example the RF Attenuator RFATTEN)
will automatically ensure the bi-directional ports have opposite signs. For example, if port 2 of an RFATTEN block is
connected to an output port, port 2 is treated as an input port and port 1 is treated as an output port.
The RF switches that support bi-directional ports also have restrictions. The switched ports all have the same port direction,
while the common port has the opposite direction.
It is possible to run into a situation where the VSS program is unable to resolve the direction of all bi-directional ports.
If this occurs, use the Signal Direction block SIGDIR or the RF Directional Switch block RFSW_DIR to explicitly set
port-directions. SIGDIR is useful when direction along a single path is to be determined. RFSW_DIR is useful when
switching between a path that can be either input or output, such as an antenna, and two paths going in opposite direction,
such as a transmit path and a receive path.

2.5. Impedance Mismatch Modeling
Many RF blocks support the modeling of impedance mismatch effects. By default, impedance mismatch modeling is
disabled. It must be explicitly enabled through the RF Options tab of the Options dialog box of individual system diagrams
or of the System Simulator Options dialog box.
When impedance mismatch modeling is enabled, the impedances seen at each RF node are taken into account when
computing signal voltages. In Time Domain simulations the data samples at each RF node represent total instantaneous
voltage and are transformed to incident voltage on input and back to total voltage on output. This means that a waveform
measurement displays the total instantaneous voltage.
For RF Budget Analysis and RF Inspector simulations, enabling impedance mismatch modeling allows the circuit
solutions to behave normally. The Y matrices of the individual RF blocks automatically take into account the different
impedances of the blocks.
NOTE: There are limitations in both RF Budget Analysis and RF Inspector simulations to the modeling of S12 effects
in nonlinear blocks. In particular, when there is impedance mismatch at the input port, the voltage and current contributions
due to S12 may not be properly accounted for. This is due to the way the simulators must account for S12 in nonlinear
blocks.
When impedance mismatch modeling is disabled, the impedances seen looking out of each RF port is the system
characteristic impedance _Z0, which is specified on the RF Options tab of the System Simulator Options dialog box. In
Time Domain simulations, the data samples are not transformed between total voltage and incident voltage on input and
reflected and total voltage on output.
Disabling impedance mismatch modeling in RF Budget Analysis and RF Inspector simulations requires internal
modifications to the circuit solution process. First, block Y matrices must be modified so the impedances looking into
the block are the system characteristic impedance _Z0. This is done by first converting the Y matrix to S matrix form
using the characteristic impedances of the block's RF ports. Once in Y matrix form the Snn parameters corresponding
to the reflection coefficients at the input and output ports are set to 0. The S matrix is then converted back to a Y matrix,
except this time the system characteristic impedance is used.
The second internal modification involves replacing any RF nodes that have more than two ports with a special block.
The special block prevents the voltage at the node from being divided by the impedances of the multiple ports. Each port
originally connected to the node is connected to a separate port of the block. The block is such that gain between the
input port (which is connected to the output port from the original node) and any of the output ports is 1. The output
ports of the special block are isolated from each other.

2–32 AWR Design Environment

Impedance Mismatch Modeling

2.5.1. VSWR Parameters
Many of the RF blocks include parameters for specifying VSWR, S11, S22, or return isolation. These parameters are
intended to simplify configuring a block to match characteristics listed in a manufacturer's data sheet. For example, the
RF Isolator block (ISOLATOR) contains parameters for insertion loss, isolation, input port VSWR, return loss or S11,
and output port VSWR, return loss or S22, along with the input port and output port characteristic impedances. A typical
manufacturer data sheet for an isolator would contain the insertion loss, isolation, input and output VSWR, and input
and output impedances under which those values held. To model an isolator with the same characteristics as specified
in the data sheet you enter those settings under the corresponding parameters.
The VSWR parameter is only intended to specify the VSWR as part of the physical description of the block when it is
loaded with the characteristic impedances. For example, suppose the VSWR_INP and VSWR_OUT parameters of the
ISOLATOR block are set to 1.4, the LOSS parameter is set to 1 dB, the ISOL parameter is set to 30 dB, and the ZINP
and ZOUTP parameters are set to 50 Ohms. If this block is then loaded with 50 Ohms at its input and output ports, the
measured VSWR at the input and output ports is 1.4, S21 is -1 dB, and S12 is -30 dB. If you change VSWR_INP to 1.6
and keep all the other parameters and loadings the same, the measured VSWR at the input port is 1.6, while the VSWR
at the output port is 1.4, S21 is still -1 dB, and S21 is still -30 dB. This is because changing the VSWR_INP parameter
changes the physical characteristics of the block in such a way that the other settings hold when the block is loaded with
the characteristic impedances.
The VSWR parameter is a design parameter of the block. Changing the value of the VSWR parameter changes the
physical characteristics of the circuit represented by the block, but not the loading of the block.
If you are interested in the effect of different VSWR loadings on a circuit, you can use the Lossless Tuner block (LTUNER)
to vary the VSWR loading. LTUNER is typically placed in front of the input port of the DUT, with port 2 of the LTUNER
block connected to the DUT. LTUNER can then be used to vary the impedance seen by the source looking into port 1
of the LTUNER block. This variation may be specified as VSWR or reflection coefficient.

2.5.2. Block Support for Impedance Mismatch Modeling
Because impedance mismatch modeling applies to circuits, only a limited set of VSS software blocks directly support
impedance mismatch modeling. The RF blocks listed in the RF Blocks In VSS section support impedance mismatch
modelling unless otherwise noted.
Several utility blocks are transparent to impedance - the impedance seen looking into a port is the same as the impedance
looking out the opposite port. The following blocks are transparent to impedance mismatch modeling:
Block

Description

ABS

Absolute Value

ACOS

Arc cosine

ACOSH

Inverse Hyperbolic Cosine

ALIGN

Align Signal (Gain, Phase and Delay Compensate)

ARG

Calculates phase angle

ASIN

Arc sine

ASINH

Inverse Hyperbolic Sine

ATAN

Arctangent

ATANH

Inverse Hyperbolic Tangent

ATTEN

Attenuator
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Block

Description

CE2R

Complex Envelope to Real Converter

CONJ

Complex Conjugate

COS

Cosine

COSH

Hyperbolic Cosine

DIV

Divider

EXP

Exponential

EXPJ

Complex Exponential

FRQSHFT

Carrier Frequency Shifter

LN

Natural Logarithm

LOG

Logarithm

NOP

No Operation

NORM

Complex Magnitude Squared

POW

Raise to the Power

R2CE

Real to Complex Envelope Converter

RECIP

Reciprocal (1/x)

RESAMPLER

Rational Resampler

SCALE

Scale and Offset

SIGN

Signum Function

SIN

Sine

SINH

Hyperbolic Sine

SQR

Square

SQRT

Square root

TAN

Tangent

TANH

Hyperbolic Tangent

NOTES: The above blocks do not in general support RF Inspector simulations.
In VSS software v7.0.x the NEG and PHASE blocks were transparent to impedance mismatch modeling. They now
appear as terminations and can be used in RF Inspector simulations.

2.5.3. Time Domain Modeling Basics
There are two main steps involved in Time Domain impedance mismatch modeling within the VSS program:
• Determining Impedances
• Applying Voltage Corrections
Determining Impedances
The first step in Time Domain impedance mismatch modeling is to determine the impedances throughout the system
diagram. Impedances need to be determined only at ports for blocks that support impedance mismatching and at ports
connected to those ports, either directly or through impedance transparent blocks.
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Blocks model impedances in one of three ways:
• Ports appear as terminations.
• Blocks are represented as frequency dependent Y parameters.
• Blocks are transparent to impedances.
Blocks that do not support impedance mismatch and are not transparent automatically appear as terminations. The
termination impedance is the system characteristic impedance _Z0, which is set on the RF Options tab of the >Options
dialog box of system diagrams or the System Simulator Options dialog box.
Some of the blocks that support impedance mismatch also appear as terminations. Examples are the mixers, the AM/PM
based nonlinear amplifiers AMP_F and NL_S, and the TONE source.
The linear RF blocks present themselves as frequency dependent Y parameters. In many cases the Y parameters are
obtained from S parameters using the system characteristic impedance _Z0. Other blocks, such as the circuit filters, have
parameters specifying the characteristic impedances. LIN_S obtains the Y parameters directly from the Microwave Office
circuit.
The behavioral amplifier AMP_B also presents itself in Y parameter form. It does this by linearizing its response at the
input signal's operating point.
Once all the blocks have presented their impedance models to the simulator, the simulator resolves the impedances seen
looking out of and into every port where impedances are needed. The following diagram illustrates the impedances
available to block B and the other impedances used in computing those impedances.
ZB,Inp,Out ZB,Inp,In

ZA,Out,In

A

ZA,Out,Out

ZB,Out,In ZB,Out,Out

B
ZD,Inp,In

D

ZC,Inp,In

C
ZE,Inp,In

E

Figure 2.17. Impedances available to a block
The impedance ZB,Inp,Out is computed from ZA,Out,In and ZD,Inp,In. ZB,Out,Out is computed from ZC,Inp,In and ZE,Inp,In. For
Y parameter based blocks ZB,Inp,In and ZB,Out,In are computed from:

Z B,Inp,In = Y1 + Z B,Out,Out
B

(2.15)

Z B,Out,In = Y1 + Z B,Inp,Out
B

(2.16)

For termination blocks, ZB,Inp,In and ZB,Out,In are the termination impedance.
The impedance looking into or out of any port can be displayed using the Z_node RF Budget Analysis measurement.
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Voltage Corrections
Once the various impedances are available to a block, the block uses the impedances to compute any necessary voltage
corrections for its inputs and outputs. The corrections are required to convert from total voltage to incident voltage at
the inputs and from reflected voltage to total voltage at the outputs.
The input correction is:

CorrInp =

1
∣ 1 + Γ In ∣

(2.17)

where:

Z Inp,In − Z O
Γ In = Z
Inp,In + Z O

(2.18)

1+Γ
CorrOut = 1 − S22 ·LΓ
L

(2.19)

Z Out,Out − Z O
ΓL = Z
Out,Out + Z O

(2.20)

The output correction is:

where:

ZO is the characteristic impedance of the block, which in many cases is the system characteristic impedance _Z0. Blocks
that support specifying characteristic impedances usually do so through ZINP and ZOUTP parameters.

2.5.4. Source and Load Impedances
When performing impedance mismatch modeling, it is important to properly terminate outputs. When impedance mismatch
modeling is not being performed, a block's output always sees the system characteristic impedance _Z0 at its output,
regardless of how many blocks are connected to the output. When impedance mismatch modeling is enabled, the impedance
seen at the outputs of RF blocks (as well as the inputs) depends on what is connected to the block. If the output is left
unconnected, it is treated as an open circuit. The same holds true if the output is connected only to a test point with default
settings.
The Grounded Resistor block LOAD and the End of RF Signal block RF_END, both found in RF Blocks > Impedance
Mismatch, can be used to explicitly terminate an RF output. Both LOAD and RF_END let you define a frequency dependent
complex impedance for the load. RF_END also provides the voltage seen at the load as a non-RF signal output.
The test point blocks TP, VNA, and VSA can all be configured as a load. By default they are configured as probes, with
infinite impedance. The ZL parameter can be used to specify the desired frequency independent complex load impedance.
NOTE: Experience has shown that LOAD blocks be used rather than the ZL parameter of the test point blocks TP and
VSA when specifying terminations. Using a LOAD block makes it clear when a termination has been set. Using the test
point blocks, on the other hand, can lead to unintentionally specifying multiple loads at a node.
The RF source blocks also allow you to specify a frequency independent source impedance. The TONE, OSC_S, and
VNA blocks all have a ZS parameter for specifying the source impedance.
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2.5.5. Interfacing to Non-RF Blocks
Blocks that do not directly support impedance mismatch modeling can still be connected to RF blocks. For example, the
transmitter blocks do not directly support impedance mismatch modeling, yet you can still connect an amplifier to their
output. However, if the impedance seen looking into the amplifier's input port is not the system characteristic impedance
then the signal voltage must be corrected to properly reflect the effect of the impedance mismatch at the input to the
amplifier.
The Start RF Signal block RF_START and Start RF Signal (Noise Source) block RF_START_NS found in the RF Blocks
> Impedance Mismatch category are used to apply the necessary mismatch correction. The blocks support an S22 parameter
and an output characteristic impedance parameter ZOUT. RF_START/RF_START_NS's input port appears as a termination
with impedance _Z0.
When the load impedance at the output port of RF_START/RF_START_NS is conjugate matched to ZOUT, the power
delivered to the load is the power delivered to RF_START/RF_START_NS's input port.

2.5.6. Additional Notes
There are several additional items to be aware of when interpreting the results of an impedance mismatch modeled
simulation.
In Time Domain simulations transmittance in the reverse direction through a block (such as S12) cannot be modeled due
to the fact that data samples only flow in the forward direction.
In Time Domain simulations frequency dependent voltage corrections must be implemented with filters. Unfortunately,
due to digital filter design constraints the time domain response of the filter may not represent the desired corrections
accurately. The Filter Issues section has more information on some of these design issues. Frequency independent voltage
corrections do not normally have these problems as they are a simple complex scaling.
Feedback Loops
Also related to the filter problem is the handling of impedance mismatch in feedback loops. In general, frequency
dependent impedance mismatch modeling is not supported in Time Domain feedback loops because of the need to use
filters to perform the voltage corrections in the time domain. These filters typically introduce a filter delay which may
affect the overall response of the feedback loop. The exception to this is the linear filter based RF blocks. These blocks,
since they already utilize a filter when impedance mismatch modeling is not enabled, can implement the voltage corrections
by modifying the frequency response of their filter.

2.6. Temperature Dependent Parameters of RF Blocks
Most VSS software RF Blocks support the specification of temperature-dependent parameters. For example, in the RF
Attenuator Block (RFATTEN), you can specify the attenuation level at a reference temperature, the rate of change of
the attenuation with change in temperature, and the actual temperature for the simulation. For RFATTEN, the attenuation
level is specified through the LOSS parameter, the reference temperature is specified through the T_REF parameter, the
rate of change through the LOSS_TDEP parameter, and the simulation temperature through the T_PHY parameter.

2.6.1. RF Blocks that Support Temperature Dependence
You can determine if an RF block supports temperature dependence by checking to see if the block contains parameters
that end in "_TDEP", or if it has a T_REF and a T_PHY parameter. These parameters are typically secondary parameters,
so you may need to select the Show Secondary check box in the Element Options dialog box to view them. The following
blocks include temperature dependence support:
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Block

Description

AMP_B2

Behavioral Amplifier, 2nd Generation

ANTENNA

RF Antenna

APHSHFT_VAR

Variable Analog RF Phase Shifter

CIRC_12

Circulator (1-Input, 2-Output)

CIRC_21

Circulator (2-Input, 1-Output)

COMBINER

RF Combiner

DCOUPLER_3

Directional Coupler, 3-port Internal Termination

DCOUPLER_4

Directional Coupler, 4-port External Termination

DPHSHFT

Digital RF Phase Shifter

DPHSHFT_VAR

Variable Digital RF Phase Shifter

DSATTEN_VAR

Variable Digital Step Attenuator

ISOLATOR

Isolator

FMULT_B2

Behavioral Frequency Multiplier, 2nd Generation

LINAMP

Linear Amplifier

LOAD

Grounded Resistor

LVGA

Linear Variable Gain Amplifier

MIXER_B2

Behavioral Mixer, 2nd Generation

QHYB_12

Quadrature Hybrid (1-Input, 2-Output)

QHYB_21

Quadrature Hybrid (2-Input, 1-Output)

QHYB_22

Quadrature Hybrid (2-Input, 2-Output)

RF_END

End of RF Signal

RF_START

Start of RF Signal

RF_START_NS

Start of RF Signal (Noise Source)

RFDELAY

RF Delay

RFDELAY_VAR

Variable Digital RF Delay

RFDPDT_24ST

RF Double Pole Double Throw Switch (static 2 input 4 output)

RFDPDT_42ST

RF Double Pole Double Throw Switch (static 4 input 2 output)

RFSW_1nDYN

RF Single Pole n-Throw Switch (dynamic 1-input n-output)

RFSW_1nST

RF Single Pole n-Throw Switch (static 1-input n-output)

RFSW_n1DYN

RF Single Pole n-Throw Switch (dynamic n-input 1-output)

RFSW_n1ST

RF Single Pole n-Throw Switch (static n-input 1-output)

S2P_BLK

Two Port S Parameter Block

SnP_BLK

n Port S Parameter Block

SBLK_2STATE

Two State S Parameter Block

SPLITTER

RF Splitter

TONE

Tone(s) Source

VVA

Voltage Variable RF Attenuator
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Block

Description

Y2P_BLK

Two Port Y Parameter Block

YnP_BLK

n Port Y Parameter Block

Z2P_BLK

Two Port Z Parameter Block

ZnP_BLK

n Port Z Parameter Block

For example, if the attenuation is set to 5 dB at 290 K and 8 dB at 390 K, you can specify the following parameter values:
• LOSS = 5 dB
• LOSS_TDEP = (8-5)/100 dB/K (RFATTEN LOSS_TDEP is dB/degree K)
• T_REF = 290 K
The loss of the attenuator for different values of T_PHY is then:
• 290 => 5 dB Loss
• 300 => 5.3 dB Loss
• 390 => 8 dB Loss
• 490 => 11 dB Loss
A single value entered for the _TDEP parameter is interpreted as change per degree K, where the units of change is the
same as the base value. For example, for the LOSS parameter of the RFATTEN block, LOSS is in dB, so LOSS_TDEP
is interpreted as change in dB per degree K. A straight linear interpolation is performed. Using the LOSS parameter of
the RFATTEN block as an example, the LOSS is evaluated according to the following:
LOSS@T_PHY = LOSS + (T_PHY - T_REF) * LOSS_TDEP

Note that limits are not placed on the evaluated value. The parameter is simply treated as having been assigned the
evaluated value. For example, in the previous example, for the LOSS parameter of the RFATTEN block, if T_PHY is
set to 90 K, the value for the loss is evaluated as:
5 - (90 - 290)*(8 - 5)/100 = -1 dB

The RFATTEN block uses the absolute value of the value assigned to the LOSS parameter as the attenuator's loss, so
the loss is 1 dB. Also note that when evaluating the value, T_PHY and T_REF are converted to degrees K. For example,
if the global unit of temperature is set to C, and you specify the following parameter values:
• LOSS = 5 dB
• LOSS_TDEP = (8-5)/100 dB/K
• T_REF = 10 C
• T_PHY = 50 C
the attenuator loss is evaluated as:
LOSS@T_PHY = 5 + (323.15 - 283.15) * (8-5)/100 = 6.2 dB

2.6.2. Piecewise Interpolation Support
You can also specify the temperature dependence using piecewise linear interpolation. To do so, enter a vector of values
consisting of pairs of values, where the first value represents the temperature in degrees K and the second value represents
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the value of the parameter at that temperature. For example, if an RF attenuator has a loss of 1 dB at 290 K, 8 dB at 390
K, and 15 dB at 490 K, you would specify the following parameter values for the RFATTEN block:
• LOSS = 1 dB
• LOSS_TDEP = {390, 8, 490, 15}
• TREF = 290 K
The loss at different values for T_PHY is then:
• 290 K => 1 dB
• 300 K => 1.7 dB
• 390 K => 8 dB
• 450 K => 12.2 dB
• 490 K => 15 dB
Note: When piecewise interpolation is used to specify the temperature dependence of the parameters, the value of that
parameter does not take the base parameter into account. Instead, all valued are based on the points provided in the _TDEP
parameter for each base parameter.

2.6.3. Frequency Dependency Support
The temperature dependence mechanism also supports specifying frequency-dependent values for parameters that support
frequency dependency. Without temperature dependence, you specify frequency dependency for parameters by entering
a vector of values for the parameter value, and then enter the frequencies associated with those values in the FREQS
parameter. For example, to specify an attenuator with an attenuation of 5 dB at 1 GHz, 6 dB at 2 GHz, and 8 dB at 3
GHz, you specify the following parameter values for the RFATTEN block:
• LOSS = {5,6,8}
• FREQS = {1,2,3}
To specify a temperature dependence along with a frequency dependence, you specify the base frequency-dependent
values for the base parameter (LOSS for the RFATTEN block), and then enter either a single value or a vector with the
same number of elements as the base parameter for the \_TDEP parameter. Using this example, if the attenuation is 2
dB across all frequencies, and the reference temperature is 290 K, you would specify the following parameter values:
• LOSS = {5,6,8}
• LOSS_TDEP = 2/100
• T_REF = 290 K
If, however, the temperature dependence is 2 dB per 100 K at 1 GHz, 3 dB per 100 K at 2 GHz, and 4 dB per 100 K at
3 GHz, then you would specify the following parameter values:
• LOSS = {5,6,8} dB
• LOSS_TDEP = {2,3,4}/100
• T_REF = 290 K
Note that when resolving the actual frequency dependency values, the frequency-dependent values for the parameters
are first computed from the temperature dependence parameters. These frequency-dependent values are then used as if
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the parameter value is specified with these values. In the previous example, if T_PHY is 390 K, the attenuator behaves
as if the LOSS is specified as:
• LOSS = { 7,9,12} dB
Piecewise interpolated temperature dependence is also supported for frequency-dependent parameters. The specification
is similar to the frequency-independent case except that instead of a single value being specified for each temperature
value in the \_TDEP parameter, there must be the same number of values as there are in the base parameter for each
temperature value. For example, if at 290 K the frequency-dependent loss is 5 dB at 1 GHz, 6 dB at 2 GHz, and 8 dB at
3 GHz; at 390 K the frequency-dependent loss is 7 dB at 1 GHz, 9 dB at 2 GHz, and 12 dB at 3 GHz; at 490 K the
frequency-dependent loss is 10 dB at 1 GHz, 15 dB at 2 GHz, and 14 dB at 3 GHz, then the parameter values are specified
as:
• LOSS = {5,6,8}
• LOSS_TDEP = {290, 5, 6, 8, 390, 7, 9, 12, 490, 10, 15, 14}
• T_REF = 290
NOTE: When piecewise interpolation is used to specify the temperature dependence of the parameters, the value of that
parameter does not take the base parameter into account. Instead, all valued are based on the points provided in the _TDEP
parameter for each base parameter.

2.7. Time Domain Filter Considerations
The VSS software relies upon Infinite Impulse Response (IIR) and Finite Impulse Response (FIR) digital filters to
implement frequency dependent behavior in Time Domain simulations. Unfortunately, there are limitations and trade-offs
as to how well these digital filters can apply a desired frequency response to a time domain signal.
FIR filters are the simpler of the two filters in terms of implementation. An FIR filter has M filter coefficients, or taps,
and has order M-1. When implemented using FFTs, they are significantly faster than IIR filters of much smaller order.
The primary drawback of the FIR filter is its introduction of ripple in the frequency response. The ripple is due to the
finite length of the impulse response.
The IIR filter implementation the VSS program uses typically provides a better overall approximation than the FIR filter,
particularly when working with modulated signals or arbitrary tones. However, the IIR filter implementation has its own
shortcomings, including sensitivity to numerical limitations such as truncation and round-off errors. The IIR filter design
also utilizes the bilinear transform, which introduces a nonlinear mapping of analog frequencies to discrete frequencies.
Upsampling and downsampling of the signal is required to reduce some of the effects of the bilinear transform, which
introduces signal distortion as well as excessive signal delay in feedback loops due to the non-ideal lowpass anti-aliasing
filter required before downsampling. The IIR filter design also requires a pole-residue approximation of the desired
frequency response, which has its own limitations.
Figure 2.18 illustrates the ripple in the stopband of an FIR implementation of a notch filter. It also shows the response
of an IIR filter implementation that provides a much better response.
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Figure 2.18. Comparison of FIR and IIR filters for a notch filter
Figure 2.19 illustrates some of the distortion introduced by the IIR filter implementation.
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Figure 2.19. IIR filter distortion

2.7.1. FIR Filters
Finite Impulse Response, or FIR, filters are fairly simple filters to implement. The time-domain equation for the n'th
output sample is:
M−1

y(n) =

∑ bk · x(n − k)

(2.21)

k=0

The filter response in z-domain is:
M−1

H(z) =

∑ bk · z−k

(2.22)

k=0

FIR filters can be efficiently implemented using fast Fourier transforms (FFT) provided the filter is not part of a feedback
loop. When implemented using an FFT, an FIR filter with M=1000 normally processes samples faster than an FIR filter
using Equation 2.21 directly with M=100.
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The primary drawback of the FIR filters is ripple in the frequency response. Figure 2.20 illustrates ripple in a fairly simple
lowpass filter.
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Figure 2.20. Ripple in an FIR filter implementation of a 7th order Butterworth filter, M=20
In the figure, the blue curve represents the ideal response of a 7th order Butterworth filter with a 1 GHz cutoff frequency
and a maximum passband attenuation of 3.0103 dB. The pink curve shows the response of an FIR filter implementation
of the same filter with M=20. The frequency response curve was generated by passing 1000 samples of an impulse
through the filter and then applying the discrete Fourier transform (DFT) to obtain the frequency response. Note that in
this case the sampling frequency fs is 10 GHz centered at 0 GHz. The frequency response is symmetric about DC.
This filter was designed using the frequency sampling design procedure. The VSS program supports two other FIR filter
implementations: a windowed FIR filter and a combination windowed FIR filter and an allpass IIR filter.
Frequency Sampling
Frequency sampling is a fairly simple procedure. The FIR filter coefficients bk are obtained by applying the inverse DFT
to the desired frequency response sampled at frequencies:

f
i· f
f i = f c − 2s + M s
for M even
f
(i + 1 / 2) · f s
f i = f c − 2s +
for M odd
M

(2.23)

The number of frequencies M is determined by the NFREQFIR parameter. If NFREQFIR is empty, the number is
automatically determined.
Frequency sampling results in a filter design that matches the desired frequency response at the sampled frequencies fi.
However, between those frequencies the response deviates from the desired frequency response, which appears as the
bumps, or ripple, in Figure Figure 2.20.
Increasing M may improve the response as illustrated in Figure 2.20.
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Figure 2.21. Ripple in an FIR filter implementation of a 7th order Butterworth filter, M=50
There is always some amount of ripple, particularly in the stopband. Depending on the requirements of your design, the
ripple may be acceptable. However, when working with notch filters, the attenuation in the notch typically falls short of
the desired attenuation.
Windowed FIR Filters
Windowed FIR filter design is a design technique that typically (though not always) provides an overall magnitude
response that is superior to that of the frequency sampling technique, particularly between frequency sample points. The
trade-offs are the filter has a linear phase response and there is a smoothing of the magnitude response.
This technique involves creating a frequency response with the desired magnitudes at the frequencies given by
Equation 2.23. The phase response is set to a linear phase response of the form:

θi = − π · (i − M / 2)
for M even
θi = − π · (i − (M − 1) / 2)
for M odd

(2.24)

The inverse DFT is then applied to this response to obtain the time-domain impulse response.
A windowing function is applied to the impulse response. The windowing function has the effect of smoothing the ends
of the impulse response, reducing ripple due to the truncated nature of the FIR filter. The VSS program uses a
Blackman-Harris window function.
The windowed impulse response becomes the coefficients of the FIR filter.
Figure 2.22 shows the magnitude response of a windowed FIR design for the filter response in Figures Figure 2.20 and
Figure 2.21. Figure 2.23 shows the constant group delay imparted by the windowed FIR design compared to the group
delay of the ideal filter.
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Figure 2.22. Magnitude response of windowed FIR filter design
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Figure 2.23. Group delay response of windowed FIR filter design
Windowed FIR + Allpass IIR Filter
The windowed FIR + allpass IIR filter design attempts to obtain a frequency response with the same magnitude response
as the windowed FIR filter design, but with a better group delay response. This is done by combining a windowed FIR
filter with an allpass IIR filter. The allpass IIR filter is used to add a non-constant group delay response to the windowed
FIR filter's constant group delay response.
The allpass IIR filter is implemented with the following z-domain transfer function:
M−1 1

H(z) = Π

i=0

+ c1i · z + c0i · z2
c*0i + c*1i · z + z2

(2.25)

Because of the nonlinear nature of Equation 2.25, the allpass IIR filter is designed using an iterative algorithm that
attempts to minimize the error between the IIR filter's group delay response and the desired group delay response. Because
of the difficulty inherent in designing an IIR filter to an arbitrary frequency response, the group delay of the IIR filter
rarely closely matches the desired response. However, it often has the same general shape.
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Figure 2.24 shows the group delay response of the windowed FIR + allpass IIR filter design for the ideal group delay
response in Figure 2.23.
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Figure 2.24. Group delay response of the windowed FIR + allpass IIR design
Other FIR Design Techniques
There are other techniques for designing FIR filters. Most of these techniques are based on minimizing the overall
frequency response error or minimizing the amount of ripple. The most effective design techniques partition the desired
frequency response into three types of regions: passband, stopband, and transition. They then attempt to reduce the ripple
in the passbands and stopbands while not restricting the ripple in the transition regions.
Unfortunately, when attempting to match a general frequency response such as the frequency responses for applying
impedance mismatch voltage corrections or the frequency response for an analog filter such as the Butterworth filter,
the partitioning techniques often cannot be applied since transition regions cannot be specified.

2.7.2. IIR Filters
Infinite impulse response, or IIR filters, are more complex and generally slower than equivalent FIR filters. However,
they do typically provide a better overall frequency response match than a frequency sampled FIR filter.
The general time-domain equation for the n'th output sample of an IIR filter is:
N

M

k=1

k=0

y(n) = − ∑ ak · y(n − k) + ∑ bk · x(n − k)

(2.26)

or in z-domain form:
M
bk ⋅ z−k
∑k=0
H(z) =
N
1 + ∑k=1ak ⋅ z−k

Note that these relations can be expressed in other ways.

2–46 AWR Design Environment

(2.27)

Time Domain Filter Considerations
Many of the difficulties of working with IIR filters arise from the feedback terms, those with coefficients αk. On the
design side, the feedback terms introduce poles into the frequency response, which may result in an unstable filter.
Determining the coefficients is a complex problem in itself, particularly when arbitrary frequency responses are desired.
On the implementation side, the feedback terms make IIR filters much more sensitive than FIR filters to numerical issues
such as quantization and round-off due to the finite resolution of floating point values in digital computers. Fortunately,
by choosing the proper structure and order of application these numerical issues can be minimized.
The following briefly summarizes the steps involved in the IIR filter implementation:
An s-domain transfer function approximation of the desired frequency response is made. The transfer function is in
pole-residue form.
1. The s-domain transfer function is mapped into the z-domain using the bilinear transform. The transfer function is also
frequency-shifted prior to the application of the bilinear transform to align the center frequency with z = 0.
2. At simulation time, each sample input is fed into the IIR filter. If UPRATE is greater than 1, UPRATE-1 zeros are
then input into the IIR filter, effectively upsampling the filtered signal.
3. If UPRATE is greater than 1, the output of the IIR filter is passed through a lowpass filter (relative to the center
frequency). The output of the lowpass filter is then decimated by UPRATE-1, effectively downsampling the previously
upsampled filtered signal.
UPRATE is a control parameter that determines the upsampling rate used by the IIR filter implementation. If a block
does not have this parameter available a value of 4 is used.
The s-domain transfer function approximation results in a transfer function of the form:
N

H(s) = C 0 + C 1 · s +

∑(
i=1

Ri
R*i
+
s − Pi s − P*
i

)

N ≤ MAXNPOLE

(2.28)

where (x)* indicates the complex conjugate of x. Analog frequencies fa are related to s by:

s = jΩ = j · 2π · f a

(2.29)

MAXNPOLE is a control parameter that is provided to allow you to limit the number of poles in the transfer function.
The default value for MAXNPOLE varies depending on the number of frequencies supplied, but the maximum default
value is 40.
By applying the bilinear transform:
−1
s = T2 · 1 − z−1
1+z

(2.30)

an IIR filter can be designed that approximates H(s) in the z-domain. T is a design parameter.
The bilinear transform maps the analog frequencies Ω to the z-domain frequencies ω according to the following equation:

ω = 2 · atan ΩT
2

(2.31)
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If the signal representation is complex envelope, the frequencies must be shifted so the z-domain frequency band is
centered at the center frequency, or ω=0 when Ω=2πfc. This is easily accomplished by adding -j·2π·fc to s prior to applying
the bilinear transform.
The bilinear transform maps the entire analog frequency range -∞≤Ω≤∞ into the z-domain frequency range -π≤ω≤π. The
result is that all frequencies, including unwanted frequencies, appear within the z-domain response. Additionally, severe
frequency compression occurs as ω approaches ±π due to the arctangent relation in Equation 2.31. The following illustrates
the mapping process:
Analog Frequency Response
fs

-f

DC

fc

+f

Shift to fc in s-domain

–

s=0

Bilinear Transform to z-domain

s=–

z = –

–

z=0

s=

z =

Original negative analog
frequencies, compressed

Figure 2.25. Frequency mapping from analog to Z-domain
The effects of the bilinear transform can be controlled to a certain extent by upsampling the signal prior to passing it
through the IIR filter. By properly designing the IIR filter, the frequencies outside the desired analog frequency band
can be made to fall outside of the original pre-upsampled z-domain frequency band fs. The signal is then passed through
a lowpass z-domain filter with bandwidth fs, attenuating the unwanted frequencies. The signal is then decimated back
to the original sampling frequency.
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IIR Filter Frequency Response

–

z=0

Lowpass Filter

–

z=0

cutoff =

UPRATE

Decimate by UPRATE

Attenuated negative
response aliased into
decimated response

–

z=0

Figure 2.26. Upsampling to shift unwanted frequencies out of sampling frequency band
The variable T in Equation 2.31 and Equation 2.31 is determined by both UPRATE and FRQALIGN. FRQALIGN
defines the frequency at which analog frequency and z-domain frequency match:

f
f = 2s · FRQALIGN

(2.32)

FRQALIGN is a control parameter like UPRATE. If a block does not have FRQALIGN available, it is generally set to
the inverse of the oversampling rate of the input signal.
Substituting equation Equation 2.31 into equation Equation 2.31 and solving for T we obtain:
π · FRQALIGN

2 · tan( 2 · UPRATE )
T = π · f · FREQALIGN
s

(2.33)

After transformation into the z-domain, the transfer function has the following form:
2N

−1

H(z) = G + C · 1 − z−1 +
1+z

∑(
i=1

βi · (1 + z−1)
1 + αi · z−1

)

(2.34)
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This form is readily implemented by a parallel IIR filter structure.

2.7.3. Working With Circuit Filter Based Blocks
The linear RF blocks all share the same core implementation. There may be some differences with the default configurations
used, but they all support the same core features.
The four digital filter implementations described in the previous sections are available:
• Frequency sampled FIR filter
• Windowed FIR filter
• Windowed FIR + allpass IIR filters
• S-domain derived IIR filter
By default the circuit filter blocks are configured to automatically select a filter implementation. The IMPL parameter
is used to select a specific implementation.
The selection algorithm can be described as:
1. If the filter is in a feedback loop, select frequency sampled FIR filter.
2. Design a frequency sampled FIR filter and an s-domain derived IIR filter. Compute error metrics for both designs. If
one of the filters has a sufficiently small error metric, select that filter. If the block is one of the blocks in the Filters
category, select the filter with the smallest error metric.
3. If step 2 did not result in a selected filter implementation, design a windowed FIR + allpass IIR filter. Select the filter
implementation from the three designs with the smallest error metric.
Note that the blocks in the Filters category do not attempt a windowed FIR + allpass IIR design. This is because they are
based on s-domain filter responses and the s-domain IIR design most often provides a better response than the windowed
FIR + allpass IIR design.
In most cases either the frequency sampled FIR or the s-domain derived IIR designs are sufficient. The windowed FIR
+ allpass IIR design is only attempted if neither of the other designs is satisfactory. This is because the windowed FIR
+ allpass IIR design algorithm takes significantly longer than the other design processes.
NFREQ and NFREQFIR
The number of frequencies used in the different filter designs depends on the NFREQ or NFREQFIR parameters. The
NFREQ parameter is used primarily for the s-domain derived IIR filter design, though if NFREQFIR is left empty it
may also be used for the FIR filter designs. The NFREQFIR parameter is used only for the FIR filter designs.
The effect of the number of frequencies used in a filter design is dependent upon the filter design algorithm. The s-domain
derived IIR filter design algorithm is quite sensitive to the number of frequencies used. Changing the number of frequencies
by 1 or 2 may sometimes produce significantly different responses. Too many frequencies or too few frequencies may
produce a response that does not resemble the desired response at all.
Experience has shown that between 50 and 200 frequency points tends to work best for the s-domain derived IIR filter
design. You can easily experiment with the circuit filters in the Filters category using the Filter Design tab of the Element
Options dialog box.
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When working with LIN_S, LIN_F, or LIN_F2 with 50 or more frequency points in the Microwave Office circuit or
data file that fall within the sampling frequency band, NFREQ should be left alone. This lets the blocks use the actual
frequency points from the Microwave Office circuit simulation or the text data file as the design response. Doing so
avoids interpolating frequency response information, which may yield an undesirable response.
For the FIR filter based designs, including the windowed FIR + allpass IIR design, the number of frequencies used
directly affects the resolution of the filter. Unless the filter is used in a feedback loop, using between 1000 and 10,000
frequency points generally yields satisfactory results in both response resolution and simulation speed. When used in a
feedback loop, the number of frequencies should be much lower, since the FIR filter is implemented in convolutional
mode, which is much slower than the FFT mode.

2.8. Time Domain Nonlinear Modeling Issues
There are several items that need to be kept in mind when modeling nonlinearities in Time Domain simulations.

2.8.1. Aliasing
Aliasing is a result of the fact that Time Domain simulations have a bandwidth limited to the sampling frequency. Center
frequency also contributes to the problem when working with complex envelope signals.
Aliasing problems can arise because of the frequency bandwidth expansion that occurs when a signal passes through a
nonlinearity. Any generated components that fall outside the sampling frequency band are aliased back into the sampling
frequency band. Figure 2.27 illustrates the bandwidth expansion for a 3rd-order nonlinearity due to harmonics.
Intermodulation products would further expand the signal at each harmonic.
When aliasing occurs, signal content that is generated outside of the sampling frequency band is 'folded' back into the
sampling frequency band, or aliased. Figure 2.28 illustrates aliasing for the example 3rd order nonlinearity. Note that
intermodulation products are not illustrated in the figure.
Input Signal

DC

fsig

Apply Nonlinearity

2nd Harmonic

DC

fsig

2fsig

3rd Harmonic

3fsig

*IM products not illustrated

Figure 2.27. Frequency expansion due to 3rd order nonlinearity
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fs
fc-fs/2

fs

fc

fs

fc+fs/2

2nd Harmonic

DC

fs

fsig

3rd Harmonic

2fsig

3fsig

Aliased 2nd Order

fc-fs/2

fc

fc+fs/2

Aliased 3rd Order

Figure 2.28. Aliasing of a 3rd order nonlinearity
If the largest signal frequency is sufficiently small, the expanded signal bandwidth falls entirely within the sampling
frequency band and all is well. If that is not the case, however, special accommodations may have to be made if the input
signal level is sufficiently high to generate significant harmonics. This is usually the case when working with complex
envelope signals with non-zero center frequencies.
One approach to reducing the effects of the aliased harmonics is to temporarily expand the sampling frequency bandwidth,
apply the nonlinearity, filter out the content outside the original sampling frequency bandwidth, then downsample back
to the original sampling frequency bandwidth. The VSS program calls this process anti-aliasing resampling. Figure 2.29
illustrates these steps.
One limitation of anti-aliasing resampling is that the maximum harmonic generated must be known to determine the
upsampling rate. Because of this, only the nonlinear blocks that use polynomials to model their nonlinearity currently
use anti-aliasing resampling. The behavioral amplifiers AMP_B, AMP_BV, AMP_F and VGA_F, and the mixers
MIXER_B, MIXER_F and MIXER_S support this behavior.
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fs

fc-fs/2
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Figure 2.29. Anti-aliasing resampling
The biggest limitation in using anti-aliasing resampling is the amount of resampling that may be needed. This amount
is related to the ratio of the largest signal frequency to the sampling frequency bandwidth. The larger the ratio, the more
resampling is required.
This problem is most apparent when working with narrowband signals at high center frequencies. Take for example a 2
MHz bandwidth signal centered at 2 GHz. With a oversampling rate of 10, this signal can be efficiently modeled as a
complex envelope signal with a sampling frequency of 20 MHz and a center frequency at 2 GHz. If this signal were to
pass through a 3rd-order nonlinearity, the largest signal component generated by the nonlinearity would be 3·2.001 GHz
or 6.003 GHz.
To expand the sampling frequency so the sampling frequency band includes 6.003 GHz, we need to upsample by:

UPRATE =

( f max − f c) · 2
fs

(2.35)
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or 4003!
The VSS program uses two approaches to avoid this problem. The first approach uses a proprietary algorithm to limit
the upsampling rate needed for a given polynomial order. This algorithm results in a maximum upsampling rate of 7 for
3rd order nonlinearities and 18 for 5th order nonlinearities. The upsampling rate for 5th order nonlinearities can often
be reduced to 9.
The second approach is to use a different nonlinearity implementation when the signal is narrowband. The behavioral
amplifiers AMP_B and AMP_BV, and the mixers MIXER_B, MIXER_F and MIXER_S support this approach. In this
case the block replaces the polynomial based nonlinearity with an AM/PM conversion table based nonlinearity that is
derived from passing a single tone signal near the center frequency through the original polynomial based nonlinearity.

2.8.2. Saturation Effects
NOTE: This section applies to Time Domain simulations. The Saturation Effects sub-section of the RF Budget Analysis
section describes the saturation effects in RF Budget Analysis simulations. The Saturation Effects sub-section of the RF
Inspector section describes the saturation effects in RF Inspector simulations.
The behavioral amplifiers AMP_B, AMP_BV, AMP_F and VGA_F, and the mixers MIXER_B, MIXER_F and MIXER_S
use as their primary nonlinearity a 3rd- or 5th-order polynomial. This polynomial allows gain, P1dB, IP2 and IP3 to be
modeled up to the P1dB point. To model saturation effects, however, the instantaneous voltage must be modified
differently. For these blocks a second polynomial is used to taper the input voltage to the saturation voltage once the
input voltage exceeds a threshold value. See the “Compression/Saturation”AMP_B documentation for more information.
The tapering of the input voltage is in itself a nonlinear operation, and results in additional harmonic and intermodulation
products being generated. These products typically do not conform to any predictable pattern, so cannot be relied upon
to determine IM product behavior near the saturation point.
Saturation Modelling Side Effects
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Figure 2.30. Side effects of saturation modeling
Figure 2.30 illustrates the generated IM products. The input signals are two tones, 10 and 10.1 GHz, fed into AMP_B.
The blue plot is the output of the amplifier when the tone power is -5.2 dBm. For this case the instantaneous voltages of
the input signal fall within the tolerance so the output is based solely on the base polynomial. In the pink plot, the tone
power has been increased to -5 dBm, which results in some instantaneous voltages exceeding the threshold. This is
evident from the appearance of the frequency content above 10.2 GHz and below 9.8 GHz. For the brown plot, the tone
power has been increased to -4.8 dBm. Note the large increase in frequency content outside 9.8 to 10.2 GHz.
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Figure 2.31. Side effects of saturation modeling in an AM-AM plot
Figure 2.30 is another view of the effects. The brown curve is the 9.5 GHz AM-AM plot, which should be negligible (<
--300). When the saturation polynomial begins to take effect, however, that frequency suddenly appears.

2.9. NI Technical Data Management Streaming (TDMS) File Format
The National Instruments Technical Data Management Streaming (TDMS) file format is a binary file format used by
National Instruments® (NI) test and measurement equipment to transfer measurement data to and from disk. TDMS files
are supported by many NI software products including LabVIEW and DIAdem.
A TDMS file is hierarchical. The file contains zero or more channel groups, each of which contain zero or more channels.
Each channel contains an array of numeric values. You can assign properties to the file, channel groups, and channels
to provide descriptive information about them. A property consists of a name (text) and a value (numeric value or text).
For example, you can use a property as a description property, where the name is 'description' and the value is the text
of the description. Another example is a time step property, defining the time between data values. The name might be
'dt', with the value being the time step in seconds. The TDMS file format does not define specific properties, nor does it
define how channel groups and channels are used; these are defined by specific applications.
The VSS software TDMS blocks follow the NI convention of using single channels to store analog waveforms and
channel groups to store digital waveforms.

2.9.1. Analog Waveforms
For analog waveforms the channel data is the sample data. The channels have a time step property defining the time
between samples in seconds. This property is named either 'dt' or 'wf_increment'. The channels also have a property
containing the number of values in the channel. This property is named either 'NI_ChannelLength' or 'wf_samples'. The
channel does not have properties named either 'NI_DigitalNumberOfLines' or 'NI_DigitalLine', which identify channels
of digital data.
IQ data is differentiated from the other analog waveforms by the presence of a 'NI_RF_WaveformType' property with
the value 'InterleavedIQCluster'. If this property is present the channel data consists of the interleaved I and Q values for
each sample. The number of whole IQ samples is 1/2 the value of the 'NI_ChannelLength' or 'wf_samples' property.
Complex waveforms are identified by the data type of the channel. Complex single precision or complex double precision
data types are supported by the VSS TDMS blocks: TDMS_IVARSRC, TDMS_SRC, and TDMS_SNK. These blocks
treat IQ data and complex waveforms the same.
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2.9.2. Digital Waveforms
Digital waveforms are stored differently from analog waveforms. Each bit, or digital line, is stored as a separate channel
within a single channel group. In addition, the waveform data may optionally be compressed.
Each digital line channel has an 'NI_DigitalLine' property whose value is an integer between 0 and N-1, inclusive, where
N is the total number of digital lines. This property identifies the digital line represented by the channel. The channel
with digital line 0 contains the values of the most significant bit while the channel with the digital line N-1 contains the
values of the least significant bit. The data type of the digital line channels is typically an 8-bit integer, though the VSS
blocks support other integer data types. The VSS TDMS blocks treat a data value of 0 as a binary '0' any other value as
a binary '1'.
If the digital waveform data is compressed there is also an index channel within the channel group. The index channel
is identified by the 'NI_DigitalNumberOfLines' property with its value being the number of digital lines in the channel
group. The index channel contains the time index represented by a data value at a given data index within the channel.
For a given channel data index, the value in each digital line channel at that data index is repeated until the time index
of the next value in the index channel. For example, if the channels have the following data values,
Index

Line 0

Line 1

Line 2

0

1

0

1

3

0

1

1

5

1

0

0

this table would expand to the following sequence of bits, presuming a time step of 1 ms:
Time (ms)

Line 0

Line 1

Line 2

0

1

0

1

1

1

0

1

2

1

0

1

3

0

1

1

4

0

1

1

5

1

0

0

Both the digital line and the index channels contain a 'wf_increment' property whose value is the time step in seconds,
and a 'wf_samples' property whose value is the number of samples in the channel.
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Chapter 3. Noise Modeling in VSS
This chapter describes the noise modeling capabilities of Cadence® Visual System Simulator™ (VSS) communications
and radar systems design software.

3.1. Modeling Noise in VSS
The three main forms of noise modeled in the VSS program are thermal circuit noise (which is called circuit noise in
the VSS program), channel noise, and phase noise. Circuit noise and channel noise are both based on white Gaussian
noise. Circuit noise is primarily specified as a noise temperature, a noise figure, or equivalent noise voltage or current
sources. Channel noise is typically specified in noise power spectral density (noise PSD) which are typically in units of
dBm/Hz.
RF Budget Analysis simulations primarily work with circuit noise, which is frequency dependent, although they also
provide limited support for channel noise. Time Domain simulations are most effective when modeling white channel
noise.
Both Time Domain and RF Budget Analysis simulations also support phase noise. VSS software phase noise modeling
is covered in the Phase Noise section.
Related to noise are the signal to noise and energy to noise ratios used in the VSS program. These are discussed in the
SNR, Eb/N0 and Es/N0 section.
A limitation to modeling noise in Time Domain simulations occurs when working with complex envelope signals whose
sampling frequency band crosses into negative frequencies. This is discussed in the Noise and Negative Frequency
Folding section.

3.2. Circuit Noise
The RF blocks that support thermal noise generation have a NOISE parameter which allows you to control which
simulations include noise. The NOISE parameter has four options:
• RF Budget only
• RF Budget + Time Domain
• Noiseless
• Auto
The default setting is "Auto". With this setting, the noise modeling setting is taken from the RF Noise Modeling setting
on the RF Options tab of the Options dialog box for the system diagram. This allows you to change the RF noise modeling
settings for all RF blocks in a system diagram at one time. You still have the option of changing settings for individual
blocks using the NOISE parameter.
In RF Budget Analysis simulations, noise is modeled by a block when either "RF Budget only" or "RF Budget + Time
Domain" is selected. In Time Domain simulations, noise is modeled by a block when "RF Budget + Time Domain" is
selected.
The different RF blocks determine how much noise is to be added. Noise is added only to the output signal. Because of
this, the noise added represents the noise that is seen by the load. The noise is computed on a frequency dependent basis.
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3.2.1. Linear RF Blocks
The linear RF blocks, which include the circuit filter blocks in the Bandpass, Bandstop, Highpass and Lowpass
sub-categories of the Filters category, determine the noise to be added using noise correlation matrices. LIN_S obtains
a normalized noise correlation matrix Ci directly from the Cadence Microwave Office® software simulation. The other
blocks obtain Ci from their Y matrix using the following:
*
C i(i, j) = 1
2 · (Y (i, j) + Y ( j, i) )

(3.1)

If impedance mismatch modeling is enabled, Ci is adjusted for any voltage divisions on the inputs due to branches.
For a 2-port with port 2 the output port, the noise PSD added at the output, NN, is:

NN =

4 · k · T · [VV]
ROut

VV = [z(2, 1) z(2, 2)]

[CC (1,(2, 1)1)
i
i

z=

[

(3.2)

C i(1, 2) z(2, 1) *
C i(2, 2) z(2, 2) *

][

Y (1, 1) + Z1
S

Y (1, 2)

Y (2, 1)

Y (2, 2) + Z1
L

]

]

(3.3)

−1

(3.4)

The noise VSD added at the output is computed directly from NN:

VN = NN · ROut

(3.5)

ZS is the impedance seen looking into the source's output port.
For the matched load case, ZL is the conjugate of ZS. ROut is obtained from:

{

ROut = Re 1ZOUTP
− Γ Out

}

(3.6)

ZOUTP is the characteristic impedance of the output port.
For computing noise VSD, ZL is the load impedance and ROut is the real component of ZOUTP.
The temperature T in Equation 3.2 is the temperature parameter T_PHY from the block if the block has a temperature,
or is the ambient system temperature setting from the RF Options tab of the Options dialog box for the system diagram.

3.2.2. Amplifiers
There are several ways of specifying noise added by amplifier blocks. These include noise figure NF, equivalent input
referred noise voltage, and equivalent input referred noise current. The voltage and current are RMS spectral densities
and are normally specified in units of nV/sqrt(Hz) and pA/sqrt(Hz), respectively.
The amplifiers AMP_B, AMP_BV, AMP_F, and VGA_F support all three methods. AMP_F supports the specification
of frequency dependent noise values. NL_S obtains its noise information from the Microwave Office nonlinear noise
simulation.
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If noise figure is specified, it is converted to an equivalent input referred noise current using the following:

(10NF/10 − 1) · 4 · k · T 0
Re{ZINP}

In =

(3.7)

where ZINP is the characteristic impedance of the amplifier's input port.
The amplifiers interpret input referred noise voltage and current using the following model:

Noiseless Amplifier

Vn
Input

Output
1

2
1

In

ZINP

ZOUTP

2

Figure 3.1. Interpretation of Vn and In in VSS software amplifiers
Note that the voltage and current sources are correlated.
Noise PSD and noise VSD are computed using noise correlation matrices as for the linear RF filters. A normalized noise
correlation matrix Ci is first computed as:

C i = 4 · k1· T · (C i,Vn + C i,In)
0
C i, Vn =

[

V 2n · Y (1, 1) · Y (1, 1) *

(3.8)

V 2n · Y (1, 1) · Y (2, 1) *

]

V 2n · Y (2, 1) · Y (1, 1) * V 2n · Y (2, 1) · Y (2, 1) * + Y (2, 2) · Y (2, 2) *
2
C i,In = In 0
0 0

[

]

(3.9)

(3.10)

The Y matrix is obtained from the linear voltage gain, S11 and S22 parameters of the amplifier.
By default the actual noise correlation matrix used is generated from a single output referred voltage source whose voltage
is equivalent to the output noise voltage generated by the initial noise correlation matrix. Using an output referred noise
voltage source prevents the noise generated by the amplifier from dropping when the amplifier is in compression (the
gain applied to the noise seen at the amplifier's input does still drop with compression).
For RF Budget Analysis simulations, input referred noise sources can be forced by setting the NOISEPORT parameter
to "Input Port". The original noise correlation matrix will then be used for the simulation.
Input referred noise sources will also be used if for some reason the impedance seen looking out either the input or output
port cannot be determined.
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3.2.3. Mixers
The VSS software behavioral mixers MIXER_B and MIXER_F use single sided noise figure to specify noise. The noise
figure is converted to an equivalent input referred noise current similar to the amplifiers. However, because the noise
figure is single sided the conversion is:

In =

/
(10N F 10 − 2) ⋅ 4 ⋅ k ⋅ T 0
Re{ZI N P}

(3.11)

3.2.4. Additional Notes
The following are additional items to note when working with circuit noise.
In Time Domain simulations the VSS program adds noise directly to the samples as the noise is generated. While
simplifying the simulation, it presents several problems. One problem occurs when the sampling frequency band crosses
DC - noise folding occurs. This problem is discussed in detail in the Noise and Negative Frequency Folding section.
The second problem occurs when combining signals whose noise levels represent the ambient noise temperature.
Both these problems do not apply to RF Budget Analysis simulations.
Combining Signals with Ambient Noise
Because noise is directly added to the signal samples as the samples are generated, the noise cannot later be separated
from the signal. In most cases this is not an issue.
However, in the case of a passive lossy combiner this becomes a problem when the signals being combined have noise
near the ambient noise temperature. In a physical passive combiner, if the input signals all have noise levels at the ambient
noise temperature, the noise level at the output of the combiner is also at the ambient noise temperature.
Unfortunately in VSS Time Domain simulations, because the noise is incorporated directly into the signal samples, the
noise at the output of the combiner is effectively the sum of the noise at all the inputs. For a two-input combiner with
both inputs having a noise temperature of 290 K the output noise is at 580 K, or 3.01 dB too high.
The workaround is to only generate noise on one of the inputs to the combiner, preferably the primary input.

3.3. Channel Noise
Channel noise is primarily used when performing BER measurements on a system design. The additive white Gaussian
noise channel block AWGN models white Gaussian channel noise.
Note that when circuit noise samples are being generated in a Time Domain simulation, the circuit noise is automatically
included in the channel noise.

3.4. Phase Noise
The following blocks support the generation of phase noise:
Block

Description

Channels > Phase Noise > PHSNOISE_CH

Phase Noise Channel

RF Blocks > Freq. Multipliers > FMULT_B

Behavioral Frequency Multiplier
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Block

Description

RF Blocks > Freq. Multipliers > FMULT_B2

Behavioral Frequency Multiplier, 2nd Generation

RF Blocks > Sources > TONE

Tone(s) Source

RF Blocks > Sources > Simulation Based > OSC_S

Oscillator with Optional Phase Noise Effects

Sources > Noise > PHASENS

Phase Noise Source

With the exception of OSC_S, phase noise is specified as a phase noise mask in dBc/Hz at specific frequency values.
The mask can be entered either in a text data file or as a vector of frequency-dBc/Hz pairs of values. OSC_S obtains its
phase noise mask directly from the Microwave Office phase noise simulation.
The phase noise channel block PHSNOISE_CH is useful for modeling phase noise from an LO that would be added to
a narrowband signal by an ideal mixer (a mixer that only generates the 1,1 spurs) without incorporating a mixer in the
design. For example, a QAM signal generated by QAM_SRC with center frequency set to 1 GHz passing through a
PHSNOISE_CH block produces similar results to a QAM signal at baseband passing through an ideal mixer with a 1
GHz LO with a similar phase noise mask:
PWR_dBm=-10
QAM_SRC
ID=A1
MOD=16-QAM (Gray)
OUTLVL=PWR_dBm
OLVLTYP=Avg. Power (dBm)
CTRFRQ=1000 MHz

PHSNOISE_CH
ID=A2
PNMASK="Mask"

SPwr: -10 dBm

TP
ID=PHSNOISE_CH

SPwr: -10 dBm

MIXER_B
ID=A3
MODE=Upper sideband (up converter)
GCONV=0 dB
P1DB=100 dBm
TP
IP3=130 dBm
ID=Mixer
LO2OUT=-325 dB
IN2OUT=-320 dB

QAM_SRC
ID=A6
MOD=16-QAM (Gray)
OUTLVL=PWR_dBm-10*log10(4)
OLVLTYP=Avg. Power (dBm)
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SPwr: -16.0206 dBm
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Figure 3.2. Use of PHSNOISE_CH with a modulated signal to model baseband upconversion
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Note the adjustment to the OUTLVL parameter of the baseband QAM_SRC. This is to reflect the fact that OUTLVL
for QAM_SRC at baseband represents the average power of each channel, which are then combined by the upconversion
mixer.

3.4.1. Phase Noise in RF Budget Analysis
RF Budget Analysis simulations model phase noise at the frequency offsets specified in the phase noise sources. Phase
noise is modeled as dBc values at each frequency offset for each simulation frequency. The phase noise values for a
simulation frequency remain fixed until they reach a block that performs a frequency translation on the simulation
frequency, such as mixers or frequency multipliers, or they encounter another source of phase noise.
The simulator interpolates phase noise values between frequency offsets using linear interpolation with log-frequency
and dBc values. This interpolation is used when computing integrated phase noise, or when phase noise is to be added
to a signal already containing phase noise. Such a case occurs when both the input and LO to a mixer contain phase
noise.
The Cascaded Phase Noise measurement C_PHS_NOISE and the Cascaded Integrated Phase Noise measurement
C_IPHS_NOISE are used for RF Budget Analysis phase noise measurements.

3.4.2. Phase Noise in Time Domain Simulations
Modeling phase noise in Time Domain simulations can be tricky. One of the biggest problems is trying to model close-in
phase noise, that is, phase noise very close to the carrier. How well the phase noise is modeled depends on both how the
phase noise is generated and how the phase noise is measured.
Generating Phase Noise
The VSS program generates time domain phase noise by applying an FIR filter to a white Gaussian noise source. The
FIR filter is used to shape the noise to match the phase noise mask.
The phase noise generating blocks PHSNOISE_CH, PHASENS, TONE and OSC_S then add the phase noise samples
to the phase of a complex signal to apply the phase noise to the signal.
The number of taps used for the FIR filter ultimately determines the minimum frequency offset of the modeled phase
noise. The number of taps is specified by the PNNFLT parameter of the block. Note that minimum offset modeled is
larger than the sampling frequency divided by PNNFLT due to the windowing used to design the FIR filter.
Generally, the number of taps to use for the FIR filter is:

PNNFLT =

2fs
DesiredMinimumFrequencyOffset

(3.12)

The factor of 2 is to account for any windowing effects and may depend upon the close-in phase noise shape. The best
approach is to configure a TONE block with the desired sampling frequency and to adjust the PNNFLT until you obtain
the desired minimum frequency offset. Note that you may need to adjust the PHS_NOISE measurement to display the
desired minimum frequency offset.
A windowed FIR frequency sampling design algorithm is used to design the FIR filter in order to reduce the sidelobes
inherent in the FIR frequency sampling design technique. The Windowed FIR Filters section of the RF Modeling in VSS
chapter further discusses windowed FIR frequency sampling design.
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The amount of phase noise that can be successfully modeled is inversely proportional to the sampling frequency. This
is due to the random phase samples wrapping around ±π. As the amount of phase noise to be generated increases, more
of the noise wraps around ±π, effectively aliasing the noise.
In general, as the average phase noise of the FIR filter bins approaches the inverse of the sampling frequency, the ability
to generate phase noise near the desired dBc/Hz level diminishes. The average phase noise of the FIR filter bins can be
computed from:

[]

PNdBc,Bin n = PNdBc,Lower +

(freq[n] − F Lower) · (PNdBc,Lower − PNdBc,Lower)
F Upper − F Lower

N /2−1

PNAvg = Σ 10

PNdBc,Bin[n]/10

n=0

(3.13)
(3.14)

where freq[n] is the frequency of the n'th bin, and FLower, FUpper, PNdBc, Lower and PNdBc, Upper are the points from the
phase noise mask bounding freq[n]. freq[n] is computed from:

freq[n] =

fs·n
2N

(3.15)

The average phase noise level to be generated also affects how well the phase noise can be modeled. If the level is too
high, the modeling is poor. To see why, look at phase noise for what it is in a time domain simulation: noise added to
the phase of a sample. The noise added to each sample is a function of the average phase noise level and the sampling
frequency At some average phase noise level, the noise added to the sample exceeds +/- 2 PI. At this point the phase of
the sample plus the noise is indistinguishable from the phase of the original sample plus noise that is -/+ 2 PI from the
original noise added, and this wrapped around noise level is one that would be generated by a much lower phase noise
level.
For example, suppose an average phase noise level of -80 dB generated noise to be added to the phase of a sample that
is around +/- 2.1 PI. For the time domain simulation, this is equivalent to adding noise to the phase that is +/- 0.1 PI
(from 2.1 PI - 2 PI). This noise of +/- 0.1 PI could be generated with an average phase noise level of -100 dB (this value
is an example to demonstrate that there is an average phase noise level that would also generate this same amount of
noise). In effect this is an aliasing of phase noise, and is similar to how a signal outside of the sampling frequency band
aliases back into the sampling frequency band.
Measuring Phase Noise
There are two VSS software measurements for working with phase noise in Time Domain simulations: Swept Integrated
Phase Noise INTG_PHS_NOISE and Phase Noise (dBc/Hz, log frequency) PHS_NOISE. Both measurements are found
in the System > Noise measurement category.
INTG_PHS_NOISE measures phase noise within a frequency band. It can present the phase noise as phase jitter, time
jitter, or dBc. The frequency band is specified relative to a carrier frequency.
PHS_NOISE displays phase noise in dBc/Hz versus frequency. The frequency axis should normally be set to a log scale.
Both measurements operate by performing a power spectrum measurement, converting the measured spectrum to dBc/Hz.
By default they utilize a large number of FFT bins along with windowing and cumulative averaging.
Measuring phase noise can be tricky, particularly when measuring close to the carrier. There are two main reasons for
this. First is the issue of resolution bandwidth. The closer to the carrier the frequency of interest, the smaller the resolution
bandwidth must be, and the larger the number of FFT bins required to perform the spectrum measurement. The order of
the filter used to shape the phase noise must also be taken into account, as a larger filter order may be needed.
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The second problem is due to the phase noise making the signal non-periodic. When an FFT is performed to obtain the
power spectrum, the signal is truncated. This effectively spreads the power of the signal over the bins of the FFT. The
solution to this is to apply a window function to the signal prior to the FFT. The window essentially smooths the edges
of the time domain signal, reducing the effects of truncation and thereby reducing the spreading of the power. The
drawback is that the application of the window function spreads the carrier due to the wide main lobe. The net result is
a more accurate spectrum in the majority of the sampling frequency band, but a less accurate spectrum near the carrier.
Figure 3.3 compares a PHS_NOISE measurement with windowing set to the default Blackman-Harris 4 term window
function, a PHS_NOISE measurement with no windowing applied, and the phase noise mask used to generate the signal.
With windowing, the carrier has been spread to about 3.6 kHz as can be seen by the wide bump ending at 3.6 kHz.
Beyond 3.6 kHz, however, the windowed curve follows the phase noise mask closely.
Without windowing, the carrier has been spread to about 1 kHz, allowing a measurement of the phase noise starting from
that point. However, the curve does deviate from the phase noise mask until approximately 200 kHz.

Phase Noise
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Figure 3.3. Comparison of phase noise measurements with and without windowing
In the PHS_NOISE measurement, the range of frequencies measured is limited by default to ignore the main lobe spectral
spreading due to the windowing and to ignore the frequencies near the edges of the sampling frequency band. The
frequencies near the edges of the sampling frequency band are generally not meaningful when performing RF simulations,
as they contain artifacts such as resampling filter transition bands used by nonlinear and circuit filter models, or the
wrap-around nature of digital filters.
The online help for PHS_NOISE and INTG_PHS_NOISE contains more information on using these measurements.

3.5. SNR, Eb/N0 and Es/N0
The VSS program supports the three noise ratios SNR (signal-to-noise ratio), Eb/N0 (bit energy to noise PSD ratio) and
Es/N0 (symbol energy to noise PSD ratio) in several different ways.
All three ratios base the signal power component on the static signal power property. This is a signal property that
represents the average signal power as the signal progresses through the link. The property is static because it is determined
at the start of each simulation sweep and does not vary during the sweep.
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The signal source blocks are generally blocks that have a power level parameter. These include the RF tone source block
TONE and the various transmitters such as QAM_TX or QAM_SRC. The signal power property is updated by blocks
along the signal path that change the signal power level, such as amplifiers, filters and mixers.
While used to convey the signal power portion of the noise ratios, the signal power property's primary use is for automatic
gain control in receivers. The receiver blocks use the signal power property to determine an appropriate scaling for
demodulation and detection of the received signal.
The static signal power property at each output port can be displayed using the SIGPWR annotation as well as the static
signal power properties measurement PWR_PROP, found under the System > Tools category.
Eb/N0, Es/N0 and one form of SNR also use the static channel noise PSD property to determine their noise component.
The channel noise PSD is an estimate of the power spectral density of channel noise generated as it passes through the
link. The channel noise PSD property can be displayed using the NOISEPSD annotation with output type set to "Generated
Noise PSD". It can also be displayed using the NOISE_PROP measurement in the System > Tools category.
The channel noise PSD property is adjusted differently depending on the block it passes through. For filters, the property
is adjusted by applying the average voltage gain over the signal bandwidth, centered at the center frequency. The signal
bandwidth is the sampling frequency divided by the oversampling rate or samples per symbol associated with the signal.
For nonlinear blocks such as the RF amplifiers and mixers, the property is adjusted by creating a set of samples with
average power equal to the noise power over the sampling frequency, passing those samples through the nonlinearity,
then converting the average power of the modified samples back to noise PSD over the sampling frequency.

3.5.1. SNR
The VSS software supports two forms of signal-to-noise ratio measurements. The first form normally represents the
frequency dependent circuit SNR and is available only in RF Budget Analysis through the cascaded signal to noise ratio
measurement C_SNR found in the System > RF Budget Analysis category. This SNR uses for its noise component the
frequency dependent node noise temperature property. It can also optionally include channel noise. More information
on RF Budget Analysis noise measurements can be found in
Section 3.8.
The second form of SNR is similar to Eb/N0 and Es/N0. It is normally used when performing BER measurements in
Time Domain simulations and is only available in Time Domain simulations. This form of SNR is frequency independent
and uses the static channel noise PSD property for its noise component. The noise power is computed over the signal
bandwidth, which is the sampling frequency divided by the signal's oversampling rate. Equation 3.16 illustrates this
computation:

SIGPWR
SNRBER = NOISEPSD
· f s / OVRSMP

(3.16)

The second form of SNR can be displayed using the EsN0_PROP measurement found in the System > Tools category.

3.5.2. Eb/N0 and Es/N0
Eb/N0 and Es/N0 are normally used when working with modulated signals, particularly when performing bit error rate
measurements in the time domain. They are only available in Time Domain simulations. Eb/N0 and Es/N0 can be
displayed using the EsN0 annotation or the EsN0_PROP measurement found in the System > Tools category.
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One of the features of the VSS program is the ability to automatically determine Eb/N0 and Es/N0 at a BER meter based
on the signal and noise characteristics of the received signal. This can, of course, be overridden at the BER meter by
specifying explicit values for the SWPVAR parameter.
Note that when you use a transmitter and AWGN channel, Eb/N0 or Es/N0 at the BER meter includes the effects of all
the blocks between the transmitter and receiver. Therefore, the Eb/N0 and Es/N0 values displayed in a BER may not
match the ratio of the transmitter's power to the AWGN's channel, particularly if the signal encounters compression.
Eb/N0 and Es/N0 use the static channel noise PSD property for their noise component.Equation 3.17 and Equation 3.18
illustrate the computations.
SIGPWR
( OVRSMP
· BITSYM )

Eb / N 0 = NOISEPSDF · Scale

( SIGPWR )

OVRSMP
Es / N 0 = NOISEPSD
· Scale

Scale = 1 for complex signals
Scale = 2 for real signals

Scale = 1 for complex signals
Scale = 2 for real signals

(3.17)

(3.18)

3.6. Measurement Noise Floor
The VSS software simulators model noise as noise delivered to the input port of a block. While in most cases this is
satisfactory, it may result in situations where the measured noise is below the ambient noise temperature. One scenario
is if a noisy RF linear block is connected to a mismatched load, and a significant portion of the noise is not delivered to
the load due to the impedance mismatch.
To remedy this discrepancy with real-world measurements, a noise floor may be specified for the RF Budget Analysis
measurements, and also for the spectrum based Time Domain simulation measurements. You specify and enable the
noise floor via the System Options dialog box RF Options tab Measurement Noise Floor Temperature, RFB Thermal Noise
Floor Use, and TD Spectrum Noise Floor Use settings.
For RF Budget thermal noise-based measurements, the noise floor is applied to the noise voltages from the simulation
prior to any additional computations performed by the measurement. The noise floor, which is specified as noise
temperature, is converted to voltage as needed using the characteristic impedance of the node where the measurement
is being performed.
For Time Domain simulations, the noise floor is only supported by the spectrum-based measurements. The noise floor
is applied to the output of the periodogram used to generate the spectrum, after applying any averaging, windowing, and
frequency folding. The noise floor value is varied slightly between each frequency point of the spectrum by about 0.2
dB to give some indication that the output value represents noise. An actual noise-like signal is not generated.

3.7. Noise and Negative Frequency Folding
Negative frequency folding occurs when working with complex envelope signals whose center frequency is less than
1/2 the sampling frequency. When that occurs, part of the sampling frequency band contains negative frequencies.
Conceptually, negative frequency content is equivalent to the complex conjugate of the corresponding positive frequency
content. When the center frequency is greater than 0, the default behavior of VSS software spectrum measurements is
to automatically convert negative frequency content to the equivalent positive frequency content, or to "fold" the negative
frequency content into the positive frequencies.
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No Frequency Folding
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Figure 3.4. Noise and negative frequency folding
However, when working with noise, frequency folding results in a doubling of noise PSD where the frequencies have
been folded. The noise is no longer white but has a 3 dB step. To avoid this scenario when modeling noise, the center
frequency should either be 0 or greater than 1/2 the sampling frequency to avoid negative frequency folding.
The Negative Complex Envelope Frequencies section of the Simulation Basics chapter explores negative frequencies in
detail.

3.8. RF Budget Analysis Noise Notes
The RF Budget Analysis noise measurements can be classified as either a spot noise measurement, where the measurement
is concerned with noise at only the simulation signal frequency, or as a frequency range noise measurement, where the
measurement looks at additional frequencies that are offset from the simulation signal frequency.
The spot noise measurements include the Cascaded Noise Factor/Figure measurement C_NF, the Node Noise PSD
measurement N0_node, and the Node Noise Temperature measurement T_node, among other measurements.
The frequency range noise measurements are the Cascaded Signal To Noise Ratio measurement C_SNR, the Cascaded
Phase Noise measurement C_PHS_NOISE, and the RF Spurious Free Dynamic Range measurement SFDR_RFB.

3.8.1. Operating Point and Noise Simulations
The operating point at which RF Budget Analysis measurements are performed depends on the measurement category.
For spot noise measurements the operating point is straightforward, it is the simulation signal at the signal frequency,
just as it is with most non-noise related RF Budget Analysis measurements.
For frequency range noise measurements, the desired operating point is still the simulation signal at the signal frequency.
However, unlike spot noise, at the noise frequencies offset from the simulation signal frequency the noise simulations
require the RF devices operate at the simulation signal's operating point.
For many cases the noise at frequencies offset from the signal frequency will yield results similar to a spot noise simulation
at that same frequency. One scenario where the operating point does make a difference is if an amplifier is operating in
compression at the signal frequency, but would not be in compression if the signal were at one of the noise offset
frequencies. This could occur if an amplifier operating in compression were preceded by a bandpass filter.
In this case at the signal frequency of interest, the amplifier is undergoing compression and the gain would be reduced.
At the noise offset frequencies the noise would also undergo the reduced gain due to the main signal's compression.
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However, if a spot noise simulation were performed at that noise offset frequency, and that frequency were in the stopband
of the filter preceding the mixer, the simulation signal would be attenuated and the amplifier may no longer be operating
in compression. In this case the gain of the amplifier would be higher, with the incoming noise undergoing the increased
gain.

3.8.2. Spot Noise Simulations
All RF Budget Analysis simulations perform a spot noise simulation, where the primary noise simulation is performed
at the simulation signal frequency. When mixers are involved, additional noise simulations are required at the image,
LO, and RF frequencies contributing to the output IF, RF feedthrough, and LO feedthrough frequencies. For cascaded
mixers noise simulations are performed at the appropriate frequencies needed for the downstream mixers.

3.8.3. Noise Frequency Ranges
The C_SNR and SFDR_RFB measurements both estimate total noise power within a frequency band centered around
the simulation signal frequency.
The C_PHS_NOISE measurement when set to display a thermal noise floor interpolates the noise at different frequencies.
Both sets of measurements are capable of utilizing noise simulation results performed at frequencies other than the
simulation signal frequency. There are several ways of managing the set of noise simulation frequencies used by the
measurements.
Utilizing Spot Noise Simulations
For simulations where the noise can be presumed to be fairly flat across the frequency band simple spot noise simulations
may be used.
When mixers are present, the additional frequencies due to the mixers are also available to the frequency range noise
measurements.
When multiple frequency offsets are specified in the RF Frequencies tab of the System Simulator Options dialog boxes,
implicit frequency sweeps of the simulation signal are performed. Spot noise simulations are performed for each of these
frequencies along with any additional required frequencies such as from mixers.
The frequency range noise measurements have access to the noise results at each swept simulation signal frequency.
They also have access to the noise results at any additional frequencies simulated due to mixer requirements. However,
there is one limitation to be aware of. If multiple swept simulation signal frequencies require the same additional
frequencies, only the results of the last noise simulation performed at that simulation will be available.
This affects only measurements that may use the noise results at the additional frequencies, such as C_SNR and
SFDR_RFB, and does not affect the spot noise measurements. This is often not an issue as the additional frequencies
tend to be out of the measured noise frequency band.
This issue can be avoided by using only one offset frequency in the RF Frequencies tab. If a frequency sweep is desired
the frequency sweeps should be specified either through the Sweep Variable Control block SWPVAR or the Vector
Network Analyzer block VNA.
Sweeping frequencies using SWPVAR or VNA yields full simulation results for each swept simulation. Only the results
applicable to a sweep are presented to the measurement at a given sweep.
Note that C_PHS_NOISE does not support multiple offset frequencies in the RF Frequencies tab when it is configured
to include a thermal noise floor.
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Specifying Frequency Offsets
If more control over the frequency offsets is desired, the RF Budget Thermal Noise Simulation Control block RFBTNSCTL
may be used to specify additional frequency offsets. The block requires only a single offset frequency be set in the RF
Frequencies tab in order to avoid any frequency conflicts.
RFBTNSCTL closely supports the C_PHS_NOISE measurement. It can generate additional frequency offsets at the
same frequency offsets as the phase noise simulations. It can also evenly space frequency offsets between those phase
noise offsets in the log-frequency space so the results when displayed in a typical log-frequency phase noise graph are
clear.
RFBTNSCTL may also be used to specify arbitrary frequency offsets.
Noise Sample Points
The set of frequency offsets may also be controlled via the RFB/RFI Noise Sample Points setting found under the RFI/RFB
Settings tab of the System Simulation Options dialog box.
With this setting, the maximum noise bandwidth required by any noise power band measurements is determined. Frequency
offsets are then spaced such that there is a total of RFB/RFI Noise Sample Points frequency offsets evenly spaced across
the band, with one frequency offset corresponding to the lower end of the band and another frequency offset corresponding
to the upper end of the frequency band.
Noise sample point based frequency offsets are only generated if a noise power band measurement such as C_SNR or
SFDR_RFB is present. However, any frequency offsets generate are also available to C_PHS_NOISE.
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Chapter 4. VSS Modeling Hints and Tips
This chapter presents various hints and tips on using Cadence® Visual System Simulator™ (VSS) communications and
radar systems design software.

4.1. RF Budget Analysis Simulations
RF Budget Analysis (RFB) simulations can be grouped into four categories. These are:
• Signal - These simulations are based on signal voltage and currents, and are utilized by the majority of the RFB
measurements.
• Block - These simulations are used for available gain and P1dB related measurements.
• Phase Noise
• Thermal Noise
Each of these categories utilizes a different simulation algorithm and each therefore has different strengths and weaknesses.

4.1.1. Signal Simulations
Signal simulations compute voltage, current and impedance at each RF node for each simulated frequency. The Node
Voltage measurement V_node, Node Current measurement I_node, and Node Impedance measurement Z_node can be
used to display these node values.
For linear RF blocks, Signal simulations are performed using the Y matrices of the individual blocks, which are combined
and used to solve for node voltages using conventional linear circuit solution techniques.
For nonlinear RF blocks, an iterative algorithm must be used. Nonlinear blocks determine their output by applying their
nonlinear transfer function to the voltage at their input. The transfer function used depends on the type of signal being
simulated, such as a one-tone fundamental, a two-tone fundamental, or IM3 value.
Some of the important things to remember about Signal simulations are:
• RF Links composed entirely of linear RF blocks are well supported. In general any topology that can be simulated
with the Cadence Microwave Office® linear simulator is supported. This includes links with combiners, splitters, RF
switches, quadrature hybrids and feedback loops.
• When impedance mismatch modeling is enabled, linear RF blocks model reflected signals and other mismatch effects
well.
• Nonlinear RF blocks work best when they are not in feedback loops due to their iterative nature.
• Nonlinear RF blocks do not model reverse isolation in Signal simulations.
• When computing IM2 and IM3, the nonlinear RF blocks only take into consideration the two-tone signal and the
incoming IM2 or IM3 value. Only the IM2 and IM3 values are computed. Other harmonics and IM products are
ignored. In a cascade of nonlinear amplifiers, these other harmonics and IM products may intermodulate with the
two-tone signal, contributing to the IM2 or IM3. These effects are not modeled in RFB simulations. RF Inspector
simulations can generate the additional harmonics and IM products and model their effects.
• Similar restrictions apply to when an amplifier is operating near saturation. The output fundamental is generated from
the clipped waveform, but the additional harmonics generated by the clipping are not passed on, and the power in
those harmonics is not seen by downstream blocks.
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• The variable gain amplifiers VGA_F and VGA_L do not use the control signal input in RFB simulations. VGA_F
uses the value of its ICTLVAL parameter while VGA_L uses the value of its GAIN parameter.
• The PLL blocks do not support RFB simulations.
• The RF mixer blocks MIXER_B, MIXER_F and MIXER_S use the center frequency of their LO signal when computing
their output frequencies. Multiple tone LO signals are not modeled.
• RF_START blocks are not necessary after a TONE block. RF_END blocks are not necessary before a LOAD block.
• The modeling of S12 in nonlinear blocks requires the impedances at the input port of the nonlinear block to be matched,
otherwise the results may not be correct. This is due to how nonlinear blocks must synthesize the S12 voltage
contribution.
• The power based gain measurements such as C_GA, C_GP, and C_GT always use rms power in their measurements
to facilitate working with ZIF downconverters (prior to V13 they used peak power if the frequency was 0 Hz and the
signal was not IQ channel based).
See RF Budget Analysis in this guide for more information on RF Budget Analysis simulations.

4.1.2. Block Simulations
The Cascaded Available Gain measurement C_GA, the Cascaded P1dB measurement C_P1DB, and the Cascaded
Headroom measurement C_HDRM are all use results from block simulations.
In a block simulation information such as the available gain or the P1dB point of a block is obtained from each RF block.
The simulator then combines the information appropriately to obtain the simulation results.
Block simulations work well for 'straight-line' RF links, where the signal of interest follows a single path through the
link. Block simulations do not work well for signals that are split and then recombined, nor with feedback loops.

4.1.3. Phase Noise Simulations
The main limitation to phase noise simulations is that the phase noise is only modeled for the main signal being simulated.
The effects of phase noise appearing on multiple tones and interferers is not modeled.

4.1.4. Thermal Noise Simulations
Thermal noise simulations are used by the thermal noise measurements such as Cascaded Noise Factor/Figure measurement
C_NF, the Cascaded Equivalent Noise Temperature measurements C_TE and C_TN and the Node Noise Temperature
measurement T_node. Note that C_NF also requires computing either cascaded transducer gain (C_GT) or cascaded
available gain (C_GA) so it also relies upon Signal and Block simulations.
Items to be aware of when working with thermal noise simulations include:
• Thermal noise is only recorded coming out of output nodes. Noise coming out of an input node is not modeled. As an
example, take the Circulator (2-Input 1-Output) block CIRC_21. If port 1 is connected to a 2000 K noise source and
port 2 is connected to a 10000 K noise source. If the circulator has 0 dB loss and 30 dB isolation, the T_node
measurement will report noise at port 1 of 2000 K, noise at port 2 of 10000 K, and noise at port 3, the output port, of
2006.3 K. It does not show the 10000 K noise from port 2 at port 1.
• The behavior of noise generated in the common RF nonlinear amplifier blocks such as AMP_B and NL_S may not
be what is expected when the block is in compression. The amount of noise added by the block is determined from
the noise figure or Vn/In parameters, which presume operation in the linear region. If the noise is presumed generated
before the gain, then when in compression the noise generated by the block will typically be lower than when not in
compression. If the noise is presumed generated after the gain, then the noise generated will typically be closer to what
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is generated when operating in the linear region. The NOISEPORT parameter is used to set whether the added noise
is generated before or after the gain.
• The RFB measurements that incorporate SNR or noise figure, such as C_SNR, C_NF, and SFDR_RFB, treat the noise
bandwidth specially when the signal frequency is at 0 Hz and the signal is not IQ channel based (IQ channel based
signals include IQ modulated signals such as QAM and OFDM). When the signal frequency is at 0 Hz and the signal
is not IQ channel based only half the noise bandwidth is used, the half of the noise band that now falls on negative
frequencies is discarded. The net effect is that with ZIF mixers the noise figure is approximately 3 dB less than a
similar mixer operating as LIF.

4.1.5. RF Budget Analysis Paths
When a simulation contains multiple branches, such as when it has switches, combiners, or splitters, there may be more
than one path connecting the start and end test points of an RF Budget Analysis measurement. The simulator chooses
the path using a cost-based algorithm.
Each possible path (paths may go in the reverse direction, from output port to input port) is assigned a cost, with the
lowest cost path chosen. The cost is based upon a number of factors, including:
• The number of blocks along the path. Each block by default is assigned a basic cost, the more blocks along a path the
higher the cost.
• The 'on' position of a switch. The 'on' branch of a switch has a low cost, while the 'off branches have a high cost.
• The primary input of a combiner. The primary input - output branch of the combiner has a low cost, while all other
branches have a high cost.
• Isolators have a higher cost along the isolated direction.
There are situations where this algorithm does not end up choosing the desired path. For example, if your RF link has
switches among different branches, and the desired branch has many blocks, and is selected by the 'on' path of the
switches, while the other branches have few blocks (for example if the 'off' path is a bypass). If there are enough blocks
in the desired branch, the cost may exceed that of the path through the 'off' path, and the off path is chosen.
If this occurs, you can use the RF Budget Path Cost block RFBPATH to assign additional costs to a path to make the
path expensive enough for the algorithm so the simulator does not choose that particular path. RFBPATH by default has
a very high reverse path cost and a very low forward path cost.

4.2. RF Inspector Simulations
RF Inspector (RFI) simulations work well with CW signals. Like RFB simulations, RFI simulations with linear RF blocks
utilize Y matrices to compute voltage and current responses at each RF node. Similar design topologies are supported.
The nonlinear portion of RFI simulations also uses iterative techniques like RFB nonlinear simulations, but at a more
comprehensive level.
Some important items to keep in mind when working with RF Inspector simulators include:
• By default only frequency content that falls between DC and the 2nd harmonic band and that has a power level greater
than 10 dB above the ambient noise level is generated. These are the default settings in the RFI/RFB Settings tab of
the System Simulator Options dialog box.
• One of the biggest factors influencing the performance of RFI simulations is the number of frequency components
generated by each nonlinearity. This is particularly true when several nonlinear amplifiers or mixers are cascaded.
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• The nonlinear amplifiers and mixers include an RFIFRQ parameter that can be used to limit the frequency components
generated by the block. Global settings are also available in the RFI/RFB Settings tab of the System Simulator Options
dialog box.
• Reverse isolation in nonlinear blocks is modeled in RFI simulations with one limitation - if there is impedance mismatch
at the input port, then S12 may not be modeled correctly.
• Saturation modeling in RFI simulations is significantly different than in RF Budget Analysis and Time Domain
simulations. This typically only applies above the P1dB point. RFI simulations scale the input signal to model the
saturation. For RF Budget Analysis and Time Domain simulations, the input signal is clipped (after converting to a
sinusoid in RFB) then passed through the polynomial. The output then has much more frequency content due to the
clipping and then the intermodulation of the extra harmonics generated by the clipping. RFI simulations on the other
hand do not generate any extra frequency content from the clipping.
• Feedback loops have limitations similar to RF Budget Analysis simulations. Purely linear RF block based feedback
loops are well modeled, other feedback loops are not. The variable gain amplifiers VGA_F and VGA_L obtain their
control value from their parameters and not the control input. PLL blocks are not supported.
• When using modulated signals in RFI simulations remember that the spectrum power levels are rough approximations.
Modulated signal support is focused towards representing the location of the main lobe of the modulated signal.
Sidelobes are not modeled.
• Mixer LO and amplifier harmonics greater than the 2nd harmonic are typically not generated at the output with the
default settings. By default, only frequency content that falls between DC and the 2nd harmonic of the main signal is
generated. To generate higher-order harmonics, either change the settings on the System Simulator Options dialog
box RFI/RFB Settings tab or specify a frequency range for a particular mixer or amplifier using the RFIFRQ parameter.
See RF Inspector in this guide for more information on RF Inspector simulations.

4.3. Differences Between RF Budget Analysis and RF Inspector Simulations
For linear blocks, the RF Budget Analysis and RF Inspector simulators use the same underlying mechanisms, and the
results are identical. However, when working with nonlinear RF blocks, particularly when multiple nonlinear blocks are
involved, the results may differ significantly, especially when nonlinear frequency components have been generated.
The main differences are:
• Saturation modeling above the P1dB point differs, as described in the "RF Inspector Simulations" section.
• IM3 modeling differs. RF Budget Analysis utilizes a simplified and idealized IM3 model. The IM3 is computed from
an infinitely close 2-tone signal and therefore offers no frequency-dependent modeling based upon the tone spacing.
It also does not model intermodulation interactions between the IM3s and the fundamentals from the input signal.
RF Inspector performs a simulation utilizing the frequency components available. In order to generate IM3, the input
signal must be a 2-tone signal. Intermodulation interactions are modeled to the extent supported by the harmonic and
frequency limits imposed by the RF Inspector settings in the System Simulator Options dialog box.

4.4. Time Domain Simulations
Items to be aware of when performing Time Domain simulations include:
• One of the best ways to debug power based measurements in a time domain simulation is to view the power spectrum
using the Power Spectrum measurement PWR_SPEC. For example, when working with CW signals the spectrum can
quickly tell you if the RBW setting is adequate.
• Feedback loops incorporate a minimum of one sample delay in the feedback path. The actual sample delay may be
higher than specified in the delay block depending upon the other blocks in the feedback loop. This is particularly true
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when there is a block that incorporates a filter, which includes any block that is frequency dependent. This also includes
blocks that perform internal resampling, such as the nonlinear amplifiers and mixers.
• An oversampling rate of at least 4 is highly recommended, especially when working with blocks that perform any
resampling, including the RF nonlinear amplifiers and mixers. The reasons for this is the resampling process requires
the application of a filter to reduce aliasing, and the passband of the filter is slightly narrower than the sampling
frequency band.
• High oversampling rates (over 40) should be avoided when working with any of the RF linear circuit filter based
blocks, including LIN_S. When the oversampling rate is very high, it becomes difficult for the simulator to design an
adequate IIR or FIR filter for the desired frequency response.
• When performing measurements that compare a signal against a reference signal, such as EVM measurements, use
an Align Signal (ALIGN) block just before the receiver to obtain the best gain and phase compensation. If there was
also a filter in the link, add a Signal Delay Compensator (DLYCMP) block before the ALIGN block. The DLYCMP
block adjusts any propagated signal delay such that the delay is aligned on a sample boundary. This helps the ALIGN
block.
• Be careful when working with center frequencies that are less than 1/2 the sampling frequency, particularly with noise.
Any time domain noise with negative frequencies gets added to the corresponding positive frequency. Because the
negative noise is in general not the complex conjugate of the corresponding positive frequency noise, the noise adds,
resulting in the noise in the positive frequency being 3 dB too high. This does not apply when the center frequency is
0.
• Time domain noise at a given frequency at the output of a mixer will only include the image noise contribution if the
image frequency falls within the sampling frequency band of the input signal.
• Reverse isolation is only accounted for when impedance mismatch modeling is enabled. It is used when computing
the mismatch correction at the output port. However, signals flowing in the reverse direction are not modeled in Time
Domain simulations.
• If you are combining several CW signals with a COMBINER, and the time domain spectrum of the signal after it has
been combined appears smeared, try setting the CTRFRQ parameter of the all tone TONE sources to the same value.
This problem is most likely to occur if the signal from the combiner passes through one or more nonlinear amplifiers
or mixers. When the inputs to the combiner have different center frequencies, the combiner must shift the input signals
to the output center frequency. Because this shifting involves multiplying by sines and cosines, a small amount of
error is introduced. That error may be enough to adversely affect the signal as it passes through the nonlinear blocks.
• When working with frequency-dependent nonlinear amplifiers and modulated signals, you should check the spectrum
at the output of the amplifier to ensure that it is reasonable. With modulated signals and frequency-dependent nonlinear
amplifiers, IIR filters are by default used to implement the frequency dependency. However, IIR filters will sometimes
result in a frequency response that is not reasonably close to the desired frequency response. If this occurs, use the
FLTRIMPL parameter of the amplifier block to select the FIR filter implementation and compare the output spectrum
with that of the IIR filter implementation.

4.5. Phased Arrays and MIMO Arrays
This section describes tips useful for working with phased array and MIMO antenna arrays. Many of these tips apply to
both phased arrays and MIMO antenna arrays except where noted.
There are two main approaches to modeling an antenna array. You can either build the array block by block, or, if your
array design is supported by the block, use the Phased Array Antenna block PHARRAY_ANT or the Phased Array
Assembly, Data-file based block PHARRAY_F.
In terms of simulation speed performance, a PHARRAY_ANT block performs the fastest, followed by the PHARRAY_F
block, while an antenna array constructed from constituent blocks performs the slowest.
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The tradeoff for the improvements in simulation speed is that the supported array configurations are most limited in the
PHARRAY_ANT block, less so in the PHARRAY_F block, and only limited by the available blocks when constructing
from constituent blocks.

4.5.1. PHARRAY_ANT and PHARRAY_F
The PHARRAY_ANT and PHARRAY_F blocks are behavioral models of antenna arrays. PHARRAY_ANT is a purely
linear block. PHARRAY_F supports nonlinear behavior in the RF links of the elements. It is text data file based, which
offers more configuration flexibility, but is more difficult to configure.
Both blocks offer a MIMO mode and a phased array mode. These modes are:
• MIMO - each array element keeps its circuit-side signal separate from the other array elements. When transmitting,
the signal input is a multiplexed signal which is demultiplexed internally and passed to each array element. The radiated
signal out of the block is the sum of the output samples of each element. Interference between signals is not modeled
by the block. When receiving, the signal input is the radiated signal. Each sample from the signal is passed to the
antenna input of each array element. The signal out of the circuit-side of each array element is then multiplexed to
form the output signal.
• Phased Array - a normal phased array assembly, the circuit side of all the array elements are connected by a feed
network. The feed network is a linear splitter/combiner.
PHARRAY_F also supports buses for MIMO mode. On the circuit side each wire of the bus is connected to an individual
array element. On the radiated side, each wire of the bus is connected to an individual antenna element. The use of buses
is recommended over the use of multiplexed signals, as the bus allows for more comprehensive RF modeling, particularly
when modeling impedance mismatch. See Buses in the Cadence AWR Design Environment User Guide for information
on using buses.
The recommended method for creating a text data file for use with the PHARRAY_F block is to use the Phased Array
Generator Wizard. After using the wizard to design your array, choose Generate > Generator PHARRAY_F Data File from
the main window.

4.5.2. Building from Blocks
The recommended method for getting started with an array constructed from blocks is to use the Phased Array Generator
Wizard. After using the wizard to create a preliminary array design, choose Generate > Generate System Diagrams from
the main window. The wizard generates a number of system diagrams representing the various components of the array.
It also generates a text data file containing the element coordinates and gain and phase tapers.
The generated system diagrams use subcircuits to share common components. For example, the antenna implementations
used by the array elements are in a subcircuit for each particular antenna configuration. The same applies for the RF link
portion and the phase shifter/gain-phase adjustment portion, so you can easily change the RF link implementation for
all the array elements that share an RF link subcircuit.
The following are tips for working with arrays constructed from blocks:
• If you are incorporating mixers in the RF link, simulation performance is best when the mixers share the same LO
source.
• When working with many elements, you can use the Named Connector NCONN block to avoid cluttering the system
diagram with wires. The system diagrams generated by the Phased Array Generator Wizard use named connectors
when there are more than a handful of array elements.
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• If you have a design with many identical array elements, but cannot use either PHARRAY_ANT or PHARRAY_F,
consider using buses. Buses are a means of automatically creating duplicate block instances internally so you do not
have to create the instances individually. For more information, see Buses in the User Guide.
The VSS program includes the BUS_SPLITTER block, which lets you split a bus signal into its constituent signals,
or combine multiple signals into a single bus signal.
• The Phased Array Element Phase Shifter block PHARRAY_SHFTR is available for performing the appropriate phase
shift given the desired steering angles, signal frequency, and element coordinates. This block supports buses if the
element coordinates are specified as arrays. In this case the block instances within the bus select appropriate element
coordinates for the block instance.
• When working with a receive configuration, you should use the Phased Array Signal Splitter block PHARRAY_RXSIG
to distribute the radiated signal amongst the element antennas. PHARRAY_RXSIG offers the following features:
• Allows RF Budget Analysis measurements to report their measurements on a 'per element' basis even after the feed
network.
• Allows the generation of non-correlated noise at the input to each element antenna.
• A bus version of the block, PHARRAY_RXSIG_BUS, is available for use with buses.

4.5.3. Additional Phased Array/MIMO Antenna Array Tips
When working with phased arrays and MIMO antenna arrays, unless the radiated signal has the same impedance as the
circuit side signal, impedance mismatch modeling should be enabled via the Simulator Options dialog box RF Options
tab.

4.6. Miscellaneous
The following are VSS software tips:
• When working with MIXER_B and MIXER_F, keep in mind that the PLO and PIN parameters define the reference
LO and input power levels for the mixer's spurs. If the LO power level does not match PLO or the input power level
does not match PIN, then the generated spurs may differ from the expected reference spurs.
• The nonlinear behavioral amplifier and mixer blocks include a MEASREF parameter that specifies either the input or
output power of one fundamental used when measuring the block's nonlinear parameters such as gain, P1dB or noise
figure. This parameter adjusts the nonlinear model in a way such that the nonlinear parameters measured when the
fundamental power is the same as the MEASREF value match the values specified in the block's parameters.
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Index
A
Aliasing, 1–15, 2–51
Allpass IIR filter; windowed FIR+, 2–45
Alphabet size property, 1–9
Amplifier
VSS, 2–5
Analog signals, 1–9
Analysis, frequency, 2–7, 2–13
Array
MIMO antenna, 4–5
phased, 4–5
Automatic VSS configuration, 1–19
Averaging; spectrum, 1–20, 1–21

B
Bandwidth expansion; nonlinear modeling, 2–51
Baseband
I/Q channel signal, 1–12
signals, 1–10
baseband IQ signals, 1–12
BER
design parameters, 1–4
BER_EXT
design parameters, 1–4
Bi-directional RF blocks, 2–29
Bit energy-to-noise PSD ratio, 3–8
Budget analysis, 2–7

C
Center frequency, 1–10
signals, 1–14
Channel noise, 3–1, 3–4
PSD property, 3–9
Channel power; measuring, 1–25
Circuit
noise; VSS, 3–1
Circuit filters, 2–41
FRQALIGN, 2–49
IMPL, 2–50
implementation selection algorithm, 2–50
MAXNPOLE, 2–47
NFREQ, 2–50
NFREQFIR, 2–50
number of frequencies, 2–50
UPRATE, 2–47
Combiners; noise in VSS, 3–4
Complex envelope, 1–10
benefits and limitations, 1–13

RF Budget Analysis simulations, 1–14
working with, 1–11
zero center frequency, 1–12
Configuration; automatic, 1–19
Controlling sweeps, 1–6

D
Data
paths; primary, 1–19
rate, 1–9, 1–14
signals, 1–9
Design parameters; sweeps, 1–4
DFT, 1–20
Digital
signals, 1–9
symbol, 1–9
DIS icon; RF Inspector, 2–19
Discrete Fourier transform, 1–20

E
Eb/N0, 3–8, 3–9
Es/N0, 3–8, 3–9
Estimation; VSS power spectrum, 1–21

F
Feedback loops; RF Inspector, 2–27
FER_EXT
design parameters, 1–4
Filters
considerations; VSS time domain, 2–41
FIR, 2–42
FRQALIGN, 2–49
IIR, 2–46
IMPL, 2–50
implementation selection algorithm, 2–50
linear RF, 2–2
MAXNPOLE, 2–47
NFREQ, 2–50
NFREQFIR, 2–50
number of frequencies, 2–50
RF modeling; VSS time domain, 2–41
UPRATE, 2–47
VSS circuit; time domain, 2–41
windowed FIR, 2–44
windowed FIR+allpass IIR, 2–45
Finite Impulse Response (FIR) filter, 2–41, 2–42
FIR filters, 2–41, 2–45
frequency sampling, 2–43
windowed, 2–44
Fixed-point
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signals, 1–18
Floor
measurement, 3–10
Folding; negative frequency, 3–10
Fourier transforms, 1–20
Frequencies
negative complex envelope, 1–23
RF Budget Analysis, 2–7
Frequency
analysis, 2–7, 2–13
resolution, 1–23
Frequency expansion; nonlinear modeling, 2–51
Frequency sampling; FIR filters, 2–43
FRQALIGN; circuit filters, 2–49

G
Gaussian noise, 3–1
Generic signals, 1–18

I
I/Q channel signal, 1–12
IIR circuit filters
FRQALIGN, 2–49
MAXNPOLE, 2–47
UPRATE, 2–47
IIR filters, 2–41, 2–45
Impedance
determining in VSS, 2–34
source and load; VSS, 2–36
Impedance mismatch modeling, 2–32
interfacing to non-RF blocks, 2–37
Time Domain modeling, 2–34
voltage corrections, 2–36
IMPL; circuit filters, 2–50
Infinite Impulse Response (IIR) filter, 2–41, 2–46
Input node; primary, 1–19
INT icon; RF Inspector, 2–19
IQ Baseband signals, 1–12

L
Leaking; spectral, 1–20
LIN_F, 2–4
LIN_F2, 2–4
LIN_S, 2–4
Linear RF filters, 2–2
LO icon; RF Inspector, 2–19
Load impedance; VSS, 2–36

M
Main signal, 1–19
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Master VNA, 1–5
MAXNPOLE; circuit filters, 2–47
Measurements
swept; VSS, 1–6
Measuring
channel power, 1–25
MIMO, 4–5
Mixers
RF Inspector, 2–28
thermal noise in RF Budget Analysis, 2–12
VSS, 2–5
Modeling
impedance mismatch, 2–34
nonlinear in VSS, 2–51
Modulated signals
impedance mismatch modeling, 2–37
RF Inspector, 2–20

N
National Instruments System Blocks
measurement data, 2–55
Negative
complex envelope frequencies, 1–23
frequency folding, 3–10
NFREQ; circuit filters, 2–50
NFREQFIR; circuit filters, 2–50
Nodes
VSS, 1–2
Noise, 3–10, 3–10, 3–11
amplifiers; VSS, 3–2
channel, 3–1, 3–4
circuit; VSS, 3–1
combiners, 3–4
Gaussian, 3–1
linear RF blocks; VSS, 3–2
mixers; VSS, 3–4
phase, 3–1
phase; VSS, 3–4
RF Budget Analysis Noise, 3–11
thermal
VSS, 3–1
white, 3–1
Non-RF blocks, 2–37
Nonlinear
amplifiers
VSS, 2–5
Nonlinear modeling
aliasing, 2–51
frequency expansion, 2–51
RF Budget Analysis, 2–10
saturation effects; VSS Time Domain simulations, 2–54

Time Domain issues in VSS, 2–51

O
Oversampling, 1–10, 1–14
rate, 1–9

P
P1dB; RF Inspector, 2–28
Parameter
passing Microwave Office into VSS, 1–26
Passband signal, 1–10
Passing
Microwave Office circuit parameters, 1–26
Microwave Office Circuit Swept Parameters to VSS, 1–27
Periodogram, 1–21
Phase noise, 3–1
generating, 3–6
measuring, 3–7
modeling; VSS, 3–4
RF Budget Analysis, 3–6
time domain simulations, 3–6
Phased Array, 4–5
Plot active sweep; VSS, 1–8
Plot all traces; VSS, 1–8
Ports
VSS, 1–2
Power spectrum
estimation; VSS, 1–21
Welch method, 1–21
Primary
data path, 1–19
input node, 1–19
Properties; signal, 1–18

R
RBW, 1–23
Real passband signal, 1–10
Real signal, 1–10
Resolution
bandwidth, 1–23
frequency, 1–23
RF blocks, 2–1
RF Budget Analysis, 2–7
complex envelopes and, 1–14
computed values, 2–9
nonlinear modeling, 2–10
phase noise, 3–6
simulation frequencies, 2–7
simulation solution, 2–7
thermal noise modeling, 2–12

RF Inspector, 2–13
Context menu, 2–20
copying, 2–20
Details section, 2–15
dialog box, 2–14
Heritage window, 2–16
modulated signals, 2–20
settings, 2–25
Signal heritage, 2–16
RF_START, 2–37
RF_START_NS, 2–37

S
S12
RF Budget Analysis, 2–12
RF Inspector, 2–29
Samples per symbol, 1–9, 1–14
Sampling
frequency band, 1–15
theory, 1–15
Sampling frequency, 1–3
selecting, 1–16
signals, 1–14
Saturation
RF Budget Analysis, 2–12
RF Inspector, 2–28
VSS Time Domain simulations, 2–54
Select with tuner; VSS, 1–8
SER
design parameters, 1–4
SER_EXT
design parameters, 1–4
SIG icon; RF Inspector, 2–19
Signal
aliasing, 1–15
analog, 1–9
bandwidth, 1–14, 1–17
center frequencies, 1–14
data, 1–9
data rate, 1–14
digital, 1–9
fixed-point, 1–18
generic, 1–18
main, 1–19
oversampling, 1–14
samples per symbol, 1–14
sampling frequencies, 1–14
selecting sampling frequency, 1–16
Signal classification; RF Inspector, 2–19
Signal power property, 3–8
Signal properties, 1–18
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static, 1–19
Signal-to-noise ratio, 3–8
Simulation
basics, 1–1
RF Budget Analysis, 1–3
sweeping, 1–4
Time Domain, 1–3, 1–20
SNR, 3–8
Source impedance; VSS, 2–36
Spectral
analysis, 1–20
leakage, 1–20
Spectrum
power in VSS, 1–21
VSS, 1–20
Welch method, 1–21
Static channel noise PSD property, 3–9
Static properties
channel noise PSD, 3–9
signal power, 3–8
Static signal
power property, 3–8
properties, 1–19
Sweeping
Microwave Office parameters into VSS, 1–26
simulations, 1–4
Sweeps
controlling, 1–6
design parameters, 1–4
VSS, 1–4
Swept
measurements; VSS, 1–6
Swept variables
VSS, 1–4
SWPVAR
design parameters, 1–4
Symbol energy-to-noise PSD ratio, 3–8
Symbol period, 1–9
System Simulator Options dialog box
RF Inspector Tab, 2–25

T
TDMS
file format, 2–55
Temperature dependence
frequency dependence, 2–40
interpolation, 2–39
RF modeling, 2–37
Thermal noise modeling; RF Budget Analysis, 2–12
Thermal noise; VSS, 3–1
Time Domain simulations, 1–3, 1–20
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Time step, 1–3
Transforms; Fourier, 1–20

U
UPRATE; circuit filters, 2–47

V
Variables
swept; VSS, 1–4
VBW, 1–23
Video bandwidth, 1–23
VNA
design parameters, 1–4
master, 1–5
Voltage corrections; VSS, 2–36
VSA
design parameters, 1–4
VSS
basic concepts, 1–2
VSWR parameters
Impedance mismatch modeling, 2–33

W
Welch method, 1–21
White noise; VSS, 3–1
Windowed
+allpass IIR filter, 2–45
FIR filters, 2–44
FIR+allpass IIR filter, 2–45
Windowing
spectrum, 1–21
VSS, 1–20

